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Chapter 1 ‒ Welcome to Axient and Wireless Workbench

Welcome to the Axient™ Wireless Management Network and Wireless Workbench® 6 – a dramatic new threshold of 
control, convenience and confidence in RF transmission, reception, and spectrum management for mission-critical 
audio applications. Axient features new technologies for a range of innovative wireless system capabilities. Individually 
compelling, these features collectively represent forward-thinking innovation by Shure, and realize the most complete 
vision yet for the integration of RF management and control solutions in a single wireless platform.

Use this guide as both a technical reference as well as an application guide for setting up an Axient system in your venue. 
Topics include an introduction to concepts that are new to Axient, set up and configuration guidance, Wireless Workbench 
6, and in-depth technical discussions of features and technologies used in the Axient products.

Below is a quick overview of sections included in the guide:

Part 1 – Introduction

Part 2 – System Set up and Configuration

Part 3 – System Operation

Part 4 – Troubleshooting

Part 5 – Upgrading Wireless Workbench 6 Software and Axient Firmware

Part 6 – Care and Maintenance

Part 7 – Reference Chapters

Part 8 – Axient Accessories

Part 9 – Glossary
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Shure has created an online source for all things Axient at www.axient.net. You will find information on the Axient 
products, features, introductory and tutorial videos, Wireless Workbench 6, and software downloads. Also available is a 
searchable library of product and application content including this Axient System Guide.

Chapter 2 ‒ About Axient Online
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Chapter 3 ‒ Axient System Features

Audio Quality and Digital Signal Processing
Axient delivers the cleanest, quietest, and most transparent wireless audio quality to date. With signal-to-noise ratios exceeding 113 
dB, Axient is the only choice for applications with dozens of microphones open simultaneously. Audio is provided in both transformer-
balanced analog and AES3 digital formats. Dual digital signal processors (DSP) maintain precise audio tracking between transmitter 
and receiver over the whole audio dynamic range, resulting in superior linearity and transparency in the presence of audio transients 
and sibilance.

Spectrum Management
Until now, quickly finding clean, ready-to-use frequencies could involve a variety of calculation and scanning tools, along with careful 
analysis and manual programming. The AXT600 Spectrum Manager uses wizards to provide guided and automated RF coordination 
tools to find the greatest number of available frequencies.

The Spectrum Manager offers precision wideband scanning and on-board compatible frequency calculation, as well as backup frequen-
cy monitoring, ranking and deployment – all on demand. The Spectrum Manager not only captures a detailed scan of your venue and 
displays it graphically, it can also listen in on a particular signal or store the data from a site survey for later use.

Together with Shure Wireless Workbench 6 software, Spectrum Management tools open up a rich graphical interface for viewing the 
RF world and choosing the optimal frequencies for all wireless channels on a production.

Interference Detection and Avoidance
Interference can come from anywhere - other wireless microphones, intercoms, digital devices – wreaking havoc with the frequencies 
selected to make the show happen. Receivers are equipped with sensitive interference detection circuitry that alerts users when a sig-
nal is compromised.

In the event of signal degradation, Interference Avoidance technology enables engineers to move to a clean, compatible frequency - 
manually or automatically. Respond to an alert by manually selecting a new frequency, or allow the Spectrum Manager to automatically 
deploy a backup frequency the instant interference is detected.

Interference Detection and Avoidance delivers the confidence of knowing that no matter what happens, interference will not ruin the 
show.

Frequency Diversity
Frequency Diversity enables audio transmission from a single source on two independent radio frequencies, providing the best possible 
protection against interference for the most important performances. With Frequency Diversity mode enabled, the receiver continuously 
analyzes signal quality and uses both frequencies to provide optimized audio on a single channel.

With two independent RF signals transmitting the same audio, the presence of direct RF interference on one frequency causes zero 
interruption. Instead of producing annoying dropouts or audio artifacts, the receiver seamlessly and automatically switches to the other 
frequency, delivering clean, uninterrupted audio.

Transmitter Remote Control
ShowLink™ Remote Control enables real-time remote adjustments of all transmitter parameters using a wireless network connection 
between linked transmitters and receivers. Whether performers are on stage in the middle of a show, or off stage waiting for their cue, 
ShowLink lets engineers make crucial changes to their transmitter settings - without ever leaving the control booth.

Remote frequency changes, gain adjustments, RF mute enabling, RF output power adjustments, and more are all possible over the 
ShowLink network. Simply add a ShowLink Access Point to any network and instantaneous wireless transmitter control is realized over 
a wide coverage area for up to 16 transmitters. Additional Access Points can be used to extend coverage area and increase the num-
ber of supported channels. Real-time wireless remote control is now possible with ShowLink.

RF Linearity and Selectivity
Ultra-linear transmitter RF design and custom-made receiver filtering combine to deliver superior RF performance. The Axient transmit-
ters are designed with highly-linearized, custom RF power amplifiers to enable the industry’s first frequency diversity transmitter that 
can deliver an interference-free show while minimizing the loss of valuable spectrum caused by typical intermodulation distortion (IMD).

Axient receivers are designed with custom, matched IF filters at both IF frequencies, that are only as wide as the transmitter signal, 
and no wider. State-of-the-art semiconductor technology is the foundation of the amplifiers in the receiver which has an unprecedented 
compression point and signal handling capability. This receiver design delivers microphone channel spacing down to 250 kHz to maxi-
mize the number of microphones on the air while rejecting strong adjacent TV stations, unwanted interference, and other wireless sig-
nals at high antenna power levels.
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Power Management
Power management provides a comprehensive suite of smart, high performance batteries and chargers, with detailed visibility of critical 
battery parameters.

• View remaining battery life accurate to within 15 minutes on transmitters, receivers and Wireless Workbench® 6
• Monitor percentage of capacity and time to full charge, visible on the Rack Mount Charging Station and WWB6
• Track battery health using charging cycle count and percentage of original capacity

Axient batteries seamlessly and securely lock into the transmitter body. Advanced battery chemistry provides up to 9 hours of run-time 
with zero-memory effect. Batteries charge to 50% capacity in one hour and to full capacity in three hours.

Charging options start with the Rack Mount Charging Station, which offers touring-ready battery storage and charging solutions with 
comprehensive status display. Configurable for up to 8 bodypack or handheld batteries, it provides easy metering of all battery status 
parameters on the front panel display, and is fully networkable for monitoring of all charging status parameters via WWB6. Portable 
chargers are a compact alternative that allow for convenient charging anytime, anywhere.

Wireless Workbench® 6
Shure Wireless Workbench 6 (WWB6) is the most comprehensive wireless system control available. It provides a rich interface to man-
age every facet of a performance over the network, from pre-show planning to live performance monitoring.

Before the show, Wireless Workbench 6 utilizes saved scan files to provide detail about the RF environment and also includes a data-
base of TV channels based on location to help with the planning process. When connected to the Axient Spectrum Manager, Wireless 
Workbench performs live RF scans and analysis, with detailed graphic overlays and device markers on a high-resolution frequency plot.

Comprehensive frequency coordination uses the scan data, TV channel database, and advanced compatibility algorithms to create and 
assign a list of clean, viable frequencies for any number of channels in a system, plus backup frequency management.

During the show, Wireless Workbench 6 enables live remote adjustments to networked hardware for instant changes to frequency, 
gain, RF output power, and more. Customize controls in a familiar channel strip interface to show audio and RF meters, battery life, and 
volume control for each channel of a wireless system. User alerts provide quick response options through the software to solve interfer-
ence issues when detected, or for battery life and RF signal strength conditions.

External Control Systems
The AXT400 receiver and AXT900 battery charger can be controlled and monitored via a control system such as AMX, Crestron, or 
Extron. Use only one controller per system to avoid messaging conflicts.

The following parameters can be controlled or monitored:

• Receiver Audio Output level
• Channel Names and Device IDs
• Set and View Frequency
• Adjust Gain

• Battery Runtime Information
• Battery Charge Information
• Interference Detection
• Mute Audio

• Lock/Unlock
• Audio Meter
• RF Meters

Connection: Ethernet (TCP/IP; select "Client" in the AMX/Crestron program )

Port: 2202

For a comprehensive list of Axient command strings, visit: http://shure.custhelp.com/app/answers/detail/a_id/5047 
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Chapter 4 ‒ Axient and Wireless Workbench 6 Concepts

Before exploring the advanced features of the Axient system and Wireless Workbench 6, please take time to read this 
chapter and familiarize yourself with the following core concepts. Understanding each concept will allow you to configure 
the advanced features and functions of the system when they are referenced in later chapters.

Device ID
Device IDs are a unique name (e.g. [BP1], [HH1], [Mic10]) 
assigned to each component for easy identification in net-
worked systems and in Wireless Workbench. The default 
ID for each Axient component is the model number (e.g. 
[AXT100], [AXT400], etc...). Use the LCD interface or 
Wireless Workbench to create a device ID.
The Device ID assigned to a networked component 
can be remotely viewed and identified from the WWB6 
Inventory tab.

Hardware Identify Feature
The Hardware Identify feature is useful for identifying 
hardware components within larger systems in connected 
control software, like WWB6.
Hardware Identify can be triggered from supported hard-
ware devices running supporting firmware.
When Hardware Identify is triggered from a device, the 
corresponding representation of that device is flashed in 
the control software.

Device Linking
Device linking enables real-time ShowLink control of 
transmitter parameters by establishing a communication 
path between an Axient receiver and transmitter. A link 
can only be formed by using the IR Sync function in the 
receiver to configure a transmitter. The Link Status icon 
appears next to the channel name on the receiver LCD to 
indicate that a link has been formed.
When a linked transmitter is within range of an AXT610 
ShowLink access point, the ShowLink icon will appear on 
the displays of both the transmitter and the receiver to in-
dicate that ShowLink control is possible.

Channel Name
The Channel Name identifies the audio channel formed 
between a linked transmitter and a receiver. The factory 
default channel name on all receivers is set to Shure. The 
factory default channel name on all transmitters is set to 
<unlinked>. The channel name is editable via the prod-
uct LCD interface or via Wireless Workbench to assign 
unique names such as LeadVOX or Sax. A transmitter 
and receiver share the same channel name when they 
are linked using the IR Sync function.

Tx Profile
The Axient receiver (AXT400) is compatible with both 
Axient and UHF-R transmitters. To optimize frequency 
calculations, select (Radio > Options > Tx Profile) and 
specify which type of transmitter will be used with the 
receiver. When creating a compatible frequency list, the 
AXT600 Spectrum Manager and Wireless Workbench use 
the Tx Profile as part of the frequency calculation. 

Online/Offline
Devices in Wireless Workbench are either online or offline. 
Although both are displayed in the Inventory view, Wireless 
Workbench will automatically discover any Shure net-
worked devices on a properly configured network and dis-
play them as online devices. Wireless Workbench can also 
control online devices. They are displayed in the Inventory 
list with black text and a dark icon. Offline devices can be 
added manually, or imported from a file. They are displayed 
in the Inventory list with gray text and a grayed out icon.
Note: The Online/Offline concept replaces Design Mode/Live Mode in 
WWB 5.

Firmware Versioning
As Axient is a set of networkable products, it is important 
to maintain compatible firmware versions on all products to 
ensure proper operation. The firmware of all Axient devices 
(with the exception of the AXT620 Ethernet Switch) has the 
form of MAJOR.MINOR.PATCH (e.g., 1.6.2).
At a minimum, all Axient devices on the network (including 
transmitters), must have the same MAJOR and MINOR 
firmware version numbers (e.g., 1.6.x).
Important: Install the same MAJOR and MINOR firmware versions on 
Axient devices within a system whenever possible.
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ShowLink™ Network
The ShowLink network carries the wireless signals that 
enable remote control of Axient transmitters. The AXT610 
ShowLink Access Point uses an independent 2.4 GHz wire-
less link to relay control signals to and from the ShowLink 
transceiver inside of each Axient transmitter. A single 
AXT610 can control up to 16 Axient transmitters. Use ad-
ditional access points to increase capacity or to expand 
the coverage area of the network. Network traffic and 
transmitter handoffs between multiple access points are 
self-managed and occur automatically. Since the ShowLink 
operates independently in the 2.4 GHz spectrum, handoffs 
between access points do not interrupt the audio signal.
It is important to note that the transmitter/receiver audio 
signal does not require you to have a ShowLink network 
set up and active. Additionally, any loss of ShowLink con-
trol will not affect the audio signal in any way.

Compatible Frequency List (CFL)
The AXT600 Spectrum Manager or Wireless Workbench 
can generate a compatible frequency list (CFL) for deploy-
ment to devices on the network. The CFL also contains 
the calculated ‘backup’ frequencies that are continuously 
monitored for quality by the Spectrum Manager. Backup 
frequencies are deployed to Axient receivers in the case of 
interference or in response to a request for a new compat-
ible frequency.

Frequency Coordination and Zones
Frequency coordination assigns clear frequencies within 
the UHF spectrum to devices for wireless audio channels. 
The RF configuration tools included in Wireless Workbench 
6 simplify frequency coordination. Use pre-configured 
equipment profiles to quickly build a system or create your 
own types and include them in the Wireless Workbench de-
vice inventory. Additional features in Wireless Workbench 
allow you to plan and avoid television stations and to define 
exclusion ranges which the frequency calculation will avoid.
To maximize the number of frequencies available for larger 
venues such as corporate campuses, festival venues, and 
theaters, you may be able to divide the environment into 
zones. Creating zones in Wireless Workbench tells the 
frequency compatibility calculator to assume that systems 
in one zone will not create intermodulation distortion with 
systems in another zone. The key is to place the devices in 
different zones and provide enough RF separation between 
each zone to prevent intermodulation distortion (IMD). 
Factors that must be considered when creating zones are 
the physical distance between zones, obstruction by build-
ing materials, the volume of surrounding RF traffic, trans-
mitter output power, antenna selection and placement, and 
overall quality of the wireless system.

Backup Frequency Monitoring
The AXT600 Spectrum Manager performs backup fre-
quency monitoring of unallocated frequencies maintained 
in the compatible frequency list (CFL) to ensure that they 
are available for use. The energy level of each frequency 
is continuously sampled and compared against the exclu-
sion threshold setting of the Spectrum Manager. If the 
energy on any frequency exceeds the exclusion threshold 
for more than one sample, that frequency is marked as 
Degraded and quarantined from use by receivers. The 
Spectrum Manager will continue to monitor Degraded fre-
quencies and restore them to Ready status if the sampled 
noise level is below the exclusion threshold for more than 
30 continuous seconds.

Interference Detection and Avoidance
Axient provides real-time interference detection and 
avoidance on each individual receiver channel. Digital 
signal processors (DSP) within the Axient receiver con-
tinuously monitor the received signal for interference from 
other wireless devices. If the DSP detects interference, 
an alert is sent to the receiver display and to Wireless 
Workbench. 
Adding an AXT600 Spectrum Manager and AXT610 
Access Point to a receiver enables the system to auto-
matically deploy a clear backup frequency to the receiver 
when interference strikes. The access point sends the 
new frequency from the receiver to a linked transmit-
ter to complete a quick frequency change away from 
interference.
The interference detection sensitivity level and the inter-
ference avoidance mode can be configured and controlled 
from the front panel of each receiver channel indepen-
dently, or from Wireless Workbench.

Frequency Diversity
Frequency Diversity provides additional protection from 
interference for critical performances by transmitting the 
audio from a single source over two independent fre-
quencies. When configured for Frequency Diversity, the 
AXT400 receiver continuously monitors and processes 
the audio quality of both signals to produce a single chan-
nel of optimized audio. If one of the frequencies experi-
ences interference, the receiver automatically adjusts the 
signals to preserve the quality of the audio output.
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Axient Icons
Device Status Icons
The following icons appear on the LCD displays to indicate the status or state of Axient features:

WWB6 Device Icons
The following icons represent components in WWB6 inventory:

AXT100 Bodypack Transmitter

AXT200 Handheld Transmitter

AXT400 Dual Channel Receiver

AXT600 Spectrum Manager

AXT610 ShowLink Access Point

UR4S Single Channel Receiver

UR4D Dual Channel Receiver

PSM1000 Dual Wireless Transmitter

UR5 Portable Receiver

ULXD Single Receiver

ULXD4Q Quad Receiver

Network
Indicates connectivity with other devices on the network. IP Address 
must be valid to enable networked control.

ShowLink
Indicates ShowLink control active between the receiver and the Linked 
transmitter.

Lock
Indicates transmitter controls locked.

Link Status
Displayed when the receiver channel is Linked to a transmitter.

Frequency Diversity Bodypack Mode
Frequency Diversity configured for use with bodypack transmitters.

Active Bodypack Indicator
Indicates the audio source bodypack transmitter for bodypack diversity 
applications

Frequency Diversity Handheld Mode
Frequency Diversity configured for use with handheld 
diversity transmitters.

Asterisk
Appears next to the tuned frequency if it is not included 
in the compatible frequency list (CFL) of the Spectrum 
Manager.

From:
References the source of the currently tuned frequency. 
For example, a Group and Channel or the Device ID of a 
Spectrum Manager currently controlling the receiver.

OUT:
Displays the current level of the audio output (0 to -30 dB 
or Mute)

TV:
Displays the TV channel that contains the tuned 
frequency. 

AXT630, AXT631, AXT632 Antenna 
Distribution System

AXT900 Rackmount Charging Station

ULXD4D Dual Receiver
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Features 
• Ultra-linear RF performance places more channels on-air 
• IR Sync function automatically tunes transmitter to the receiver frequency 
• Comprehensive real-time remote control of all transmitter parameters when a Linked transmitter is within range of a 

ShowLink Access Point
• Shure lithium-ion rechargeable battery delivers up to 8 hours of runtime from a single charge 
• Advanced control menu to adjust frequency and audio settings from the transmitter 
• 50 dB of adjustable gain for optimal audio quality
• Lockable user interface prevents accidental or inadvertent changes to controls once settings are made 
• Compatible with all Shure wireless microphones that have a TA4F connector 
• LEMO connector version (AXT100LEMO3) available for use with LEMO connector microphones

Chapter 5 ‒ Axient Components

AXT100 Bodypack Transmitter 
The AXT100 transmitter delivers superior audio performance in a compact, lightweight package. Efficient, ultra-linear RF 
performance maximizes the number of channels on-air and superb audio quality. Advanced power management provides 
extended, rechargeable battery life and highly accurate status metering. ShowLink™ Remote Control enables compre-
hensive real-time remote control of all transmitter parameters, including real-time frequency adjustments. 
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AXT200 Handheld Transmitter 

Features 
• Frequency Diversity enables simultaneous transmission on two independent frequencies to ensure seamless, 

uninterrupted audio for mission-critical transmitters. Single carrier mode is available if Frequency Diversity is not 
required.

• Ultra-linear RF performance enables more channels on-air 
• IR Sync function automatically tunes transmitter to the receiver frequency 
• Comprehensive real-time remote control of all transmitter parameters when a Linked transmitter is within range of a 

ShowLink Access Point
• Shure lithium-ion rechargeable battery delivers up to 9 hours of runtime from a single charge 
• Advanced control menu to adjust frequency and audio settings from the transmitter 
• 42 dB of adjustable gain for optimal audio quality
• Lockable user interface prevents accidental or inadvertent changes to controls once settings are made 

The AXT200 Handheld Frequency Diversity Transmitter is a rechargeable, remotely controllable handheld transmitter 
with Frequency Diversity for seamless, uninterrupted audio in even the most challenging RF environments. In addition to 
Frequency Diversity, the AXT200 delivers ultra-linear RF performance for more channels on-air and superb audio quality. 
Advanced power management supports extended battery life and highly accurate status metering. ShowLink™ Remote 
Control enables comprehensive real-time remote control of all transmitter parameters, including real-time frequency 
adjustments. 
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AXT400 Dual Channel Receiver

ShowLink™ Remote Control
The AXT400 offers comprehensive real-time remote control of a 
linked transmitter when used with the AXT610 ShowLink Access 
Point. Axient transmitters can be Linked to each receiver channel 
using the IR Sync feature. The ShowLink Access Point maintains 
a 2.4 GHz wireless network communication with the transmitters 
and connects to the receiver over Ethernet. All functions of the 
Linked transmitter including gain adjustments and synchronized 
frequency changes can be controlled from the front panel menu of 
the AXT400 in real-time.

Interference Detection and Avoidance
During operation, the AXT400 receiver can detect the presence 
of an interfering RF signals. When a potential interference source 
is detected, a warning message is displayed along with options 
for changing frequency. When used with the AXT600 Spectrum 
Manager, the receiver can switch to a ‘backup’ frequency de-
ployed by the Spectrum Manager, either manually or automati-
cally. The Spectrum Manager constantly monitors a compatible 
frequency list to ensure the best available frequencies are used. 
With ShowLink™ Remote Control, the receiver and transmitter 
can execute a synchronized switch to a clear frequency, resolving 
the interference.

Frequency Diversity
Frequency Diversity provides seamless audio in environments 
where there is a risk of dropouts or interference by using trans-
mission from a single audio source on two independent radio 
frequencies. In Frequency Diversity mode, the AXT400 Receiver 
continuously analyzes signal quality and uses both signals to 
provide optimized audio on a single channel. In the case of RF 
interference on one frequency the receiver automatically uses the 
other frequency, delivering clean, uninterrupted audio.

Networking
The AXT400 Receiver shares information with other system com-
ponents via Ethernet, enabling advanced features such as remote 
control of transmitters and management using WWB6. The receiv-
er has two RJ45 Ethernet ports capable of 10/100 Mbps network 
speeds. The Ethernet ports provide Power over Ethernet (PoE), 
which can be used to supply power to a ShowLink Access Point. 
To verify proper network configuration, the Find All function (avail-
able in the Network menu) creates a list of Axient devices and 
P10T receivers connected to the network. Find All is also avail-
able in the AXT600 Spectrum Manager with extended functionality 
to find UR4 receivers on the network.

Groups and Channels
The receiver includes a wide selection of pre-programmed fre-
quency Groups which allow easy access to compatible Channels 
for multiple receivers. Channel Scan finds an open frequency 
within the current Group. Group Scan finds the open Channels in 
all Groups and allows easy programming of compatible frequen-
cies to other AXT400 receivers over the network.

RF Cascade Ports
The cascade ports share RF signals with up to 5 receivers within 
the same frequency band. RF cascade allows antenna signal to 
be conveniently distributed for up to 10 channels without using 
splitters or distribution amplifiers.

Compatible Transmitters
Compatible with the following Shure transmitters:

• AXT100 Bodypack Transmitter

• AXT200 Frequency Diversity Handheld Transmitter

• UR1 Bodypack Transmitter

• UR1H Bodypack Transmitter

• UR1M Micro-Bodypack Transmitter

• UR2 Handheld Transmitter

• MW2 Handheld Transmitter

• MW3 Bodypack Transmitter

Features

The AXT400 Dual Channel Receiver combines advanced analog and digital technology to deliver exceptional RF and 
audio performance. The receiver features a ShowLink™ user interface for real-time transmitter adjustments, Frequency 
Diversity mode for seamless dual-frequency operation, and Interference Detection & Avoidance. It offers up to 228 MHz of 
tuning wideband and supports Axient and UHF-R series transmitters. Connectivity options include transformer balanced 
audio outputs, AES3 digital audio output, RF Cascade ports and dual Ethernet ports for networked control and monitoring 
via Shure Wireless Workbench 6.
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AXT600 Spectrum Manager

Features
Wideband Scanning
The Spectrum Manager captures scan data for the entire UHF frequency range available for wireless audio. The scan is 
compiled using two antenna inputs, with sensitivity and resolution that match the AXT400 receiver.

Compatible Frequency List
The Compatible Frequency List (CFL) is a list of available frequencies calculated, viewed, and edited from either the 
Spectrum Manager or Wireless Workbench® 6. The frequency calculator can be adjusted to avoid specific TV channels, 
frequency ranges, or RF signals above a specified threshold. Clear frequencies are deployed from the compatible fre-
quency list to initially set up a wireless system or to replace frequencies degraded by interference.

Event Log
The event log records actions of the Spectrum Manager during operation. Actions include changes to frequencies and 
equipment controlled by the Spectrum Manager.

Backup Frequency Monitoring
The data screen tracks the status of all frequencies available for Axient systems. The number of frequencies is displayed 
for each band, including real-time status of in-use and backup frequencies.

RF Scanning
The scanning feature of the Spectrum Manager graphically plots the measured RF signal across the full frequency range. 
Cursor, Zoom, and Peak tools allow detailed inspection of the data.

Listen
Use the Listen feature to tune to a frequency and monitor FM demodulated signal using headphones. The data screen 
displays the signal strength for the selected frequency.

Networking
Networking enables many of the advanced features of the Axient system, including monitoring and control of remote de-
vices. Rack components have two RJ45 Ethernet ports capable of 10/100 Mbps network speeds. The Ethernet ports are 
power over Ethernet (PoE) enabled to supply power to the ShowLink™ access point or other class 1 Ethernet devices.

RF Cascade Ports
The cascade ports allow sharing of RF signals with up to 5 components without antenna splitters or distribution amplifiers.

The Axient Spectrum Manager is a powerful tool for calculating, analyzing and assigning compatible frequencies to wire-
less components. The Spectrum Manager scans the RF environment and uses this data to calculate compatible frequen-
cies for all wireless channels found on the network. Networked wireless systems can be programmed from the Compatible 
Frequency List, while backup frequencies are continuously monitored and ranked according to quality. During operation, 
the Spectrum Manager deploys clear frequencies to receivers when interference occurs. Built-in spectrum monitoring 
tools provide visual and audio tracking of RF activity.
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AXT610 ShowLink Access Point

Features
• Real-time wireless remote control of up to 16 

transmitters per ShowLink access point
• Automated channel selection - Independently scans 

2.4 GHz frequency range and determines best channel 
for use

• Can be powered by a Power over Ethernet (PoE) 
network connection or from an external power supply

• Easy transmitter authentication - Recognizes linked 
transmitters upon IR sync

• Provides coverage area approximately the same as the 
transmitter’s UHF range (depending on the RF squelch 
setting of the receiver) 

• Automatic hand-offs between multiple access points 
extend coverage range

• Versatile mounting options - Fits readily available 
microphone stand adapters and features built-in 
threading for permanent installation

• Wireless Workbench 6 system supports networked 
control of all device functions and provides a ShowLink 
plot for viewing 2.4 GHz signal levels

The AXT610 ShowLink™ access point enables real-time remote control of the Axient™ transmitters. The access point al-
lows comprehensive management of transmitter parameters from the receiver or Wireless Workbench® 6 using 2.4 GHz 
wireless network communication. All parameter changes occur without interruption to the performer.

Multiple access points can extend the operational range or increase the number of transmitters supported on the 
ShowLink network.
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AXT620 Ethernet Switch 

Features 
• Rugged 1RU construction 
• Internal power supply 

• Front panel port 
• 8 rear panel ports, 4 of which have 

Power over Ethernet (PoE) 

• On-board DHCP server 
• Easy system integration 

• Selectable input filtering provides system-wide 
protection against strong out-of-band signals

• Wideband filtering option covers multiple bands
• Up to 15 dB of selectable RF attenuation for signal-to-

noise optimization
• Wideband RF cascade ports for connection of 

wideband devices

• Front panel interface and Wireless Workbench 6 
control provide easy set up and control of filtering, 
antenna power, and attenuation

• BNC outputs: 4 antenna output pairs
• Ethernet Networking: 2 PoE enabled Ethernet ports
• Compatible with Shure ULX-D and UHF-R receivers

Axient Antenna Distribution Systems

Features

The AXT620 Ethernet Switch is a rugged, rack-mountable 9-port switch that simplifies the networking of Shure systems 
and minimizes network configuration set up. It is equipped with Power over Ethernet (PoE) ports for enabled devices and 
a DHCP server to automatically assign IP addresses to components. 

Antenna Distribution Systems send the RF signal from a single pair of antennas to multiple receivers. Ultra-linear ampli-
fication and adjustable attenuation optimize performance in difficult RF environments. Selectable input filters match the 
available frequency bands of transmitters, providing extra protection from strong out-of-band signals. BNC antenna output 
pairs distribute band-filtered signals to up to 4 receivers. A pair of wideband cascade ports supply wideband RF signals to 
Spectrum Managers or additional antenna distribution amplifiers. Networking allows Wireless Workbench to control filtering 
ranges and attenuation. For added flexibility, Axient Antenna Distribution Systems are compatible with Shure ULX-D and 
UHF-R receivers.

To maximize use of the RF spectrum, Antenna Distribution Systems are available in the following frequency ranges:

• AXT630 (470-698 MHz) 
• AXT631 (606-814 MHz)
• AXT632 (470-510 MHz and 630-787 MHz)

Note: Instructions in this system guide apply all models of Axient Antenna Distributions Systems.
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• Touring-ready battery charging and storage solution 
with comprehensive status display

• Configurable bays for mixing and matching 8 bodypack 
and handheld transmitter batteries

• Fully networkable for monitoring of all charging status 
parameters in Wireless Workbench 6

• Storage mode for charging or discharging batteries to 
optimal storage voltage

• Tracks battery health using charging cycle count and 
percentage of original capacity as metrics

• Charges batteries to 50% capacity within 1 hour
• Charges batteries to full capacity in 3 hours
• Simple 3-button interface control

Features

AXT903 and AXT904 Portable Battery Chargers

• Charges two transmitter batteries
• Charges batteries to 50% capacity within 1 hour
• Charges batteries to full capacity in 3 hours

• Modules can be re-used in AXT900 rackmount 
charging station

• Power supply included

AXT903
(charges bodypack batteries)

AXT904
(charges handheld batteries)

AXT900 Rack Mount Charging Station

Features

The AXT900 charges up to 8 Shure rechargeable batteries in a single, compact rackmount housing. Interchangeable 
charging modules accommodate any combination of handheld and bodyback transmitter batteries. The front panel display 
provides easy metering of all battery parameters, including charge status, time to full, battery health, and battery tempera-
ture. When connected to a network, parameters can be monitored remotely using Wireless Workbench.

The AXT903 and AXT904 charging stations charge 2 transmitter batteries in a convenient and compact desktop unit.
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Chapter 6 ‒ Axient System Examples

Single Receiver Example

Tips
• Use antennas that match the band of the receiver
• Charge transmitter batteries with a portable charging station (AXT903 for bodypack batteries or AXT904 for 

handheld batteries)
• Use the RF cascade ports to share the RF signal between the AXT600 Spectrum Manager and the AXT400 

receiver
• Use the Ethernet ports to set up the network
• Connect the AXT610 ShowLink access point to a Power over Ethernet (PoE) enabled Ethernet port or external 

power supply
• Remote control of transmitters is possible from WWB6 or from the front panel of the receiver

Note: For this example, since a DHCP server is not used, all the networked devices will fall back to a 169.254.x.x private IP address at power up and 
form a valid network. If you’re using a laptop with the Windows operating system, Windows will take at least 60 seconds to search for a DHCP server 
at power up or when the network cable is unplugged from the computer. After the 60 second period, the laptop will fall back to a 169.254.x.x private IP 
address. If you’re using a laptop with the MacOS operating system, the MacOS will fall back in a few seconds.

The modular design of Axient allows for a large degree of flexibility when configuring a wireless audio system.

An AXT400 receiver can be configured as two separate audio channels or as a frequency diversity audio channel. Using 
these components, you can quickly set up an audio channel and take advantage of the major features of an Axient 
system.

Ethernet Network

RF Signal

RF Antenna B

Spectrum Manager

Receiver

RF Antenna A

ShowLink 
Access Point

Portable Battery 
Charger
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4 Receiver Example

Tips
• Use antennas that match the bands of the receivers
• Use the RF cascade ports to share the RF signal between the AXT600 Spectrum Manager and the AXT400 

receivers
• Use an AXT620 Ethernet Switch for network connections. Set the DHCP switch to ON before applying power.
• Connect each component to a port on the AXT620 Ethernet switch
• Connect the AXT610 ShowLink access point to a Power over Ethernet (PoE) enabled Ethernet port or external 

power supply
• Remote control of transmitters is possible from WWB6 or from the front panel of the receiver

This example uses four AXT400 receivers to provide four Frequency Diversity audio channels or eight single audio 
channels.

• The AXT620 is added to the system and configured as the DHCP server for the network
• All receivers are tuned to the same band and share the antenna signal using the RF cascade ports
• The AXT900 adds charging capacity for 8 transmitter batteries. Charging status can be monitored over the network 

using WWB 6.

Ethernet Network

RF Signal

Ethernet Switch

ShowLink 
Access Point

RF Antenna B RF Antenna A

Spectrum Manager

Receiver

Receiver

Receiver

Receiver

Rackmount 
Battery Charger

26 Part 1: Introduction

AXT610
Axient W

ireless
Showlink Acces Point

AXT900

B A

AXT600

B A

line

mic

lift

GND

in

word
clock

thru

Term 75Ω

line

mic

lift

GND

Class 1 PoE

AXT400

B A

line

mic

lift

GND

in

word
clock

thru

Term 75Ω

line

mic

lift

GND

Class 1 PoE

AXT400

B A

line

mic

lift

GND

in

word
clock

thru

Term 75Ω

line

mic

lift

GND

Class 1 PoE

AXT400

B A

line

mic

lift

GND

in

word
clock

thru

Term 75Ω

line

mic

lift

GND

Class 1 PoE

AXT400

AXT620

WWB6 AXT610



16 Receiver Example

Tips
• Use 1 AXT610 ShowLink access point for every 16 transmitters
• Use the RF cascade ports to share the RF signal between the receivers set to the same band
• Only one AXT620 Ethernet Switch can have the DHCP switch to ON. Set all other DHCP switches to OFF before 

powering the devices on.
• Connect each component to a port on the AXT620 Ethernet switch
• Connect the AXT610 ShowLink access points to a Power over Ethernet (PoE) enabled Ethernet ports
• Remote control of transmitters is possible from WWB6 or from the Tx menu of the receiver

This example uses 16 AXT400 receivers to provide 16 frequency diversity audio channels or 32 single audio channels.

• The receivers are divided into groups of 4, with each group set to a different band
• The AXT630 Antenna Distribution Amplifier supplies RF signal to each group of receivers. The RF cascade ports 

provide additional levels of RF distribution within each receiver group.
• Multiple AXT610 Access Points support more than 16 transmitters and extend the coverage of the ShowLink network
• Multiple AXT620 Ethernet switches are used to extend the network

Ethernet Network

RF Signal

RF Antenna B RF Antenna A

Connect Computer 
to front-panel port 
on AXT620

Set DHCP switch to ON

Set input filter to 
Wideband, connect 
AXT630 output 
to RF input of 
receivers

Connect the ports of the 
AXT600 to the RF cascade 
ports of the AXT630

Spectrum 
Manager

ShowLink 
Access Points

Networked AXT900 
Rackmount Chargers

Set DHCP switch to 
OFF

Set DHCP switch to 
OFF

Set DHCP switch to 
OFF

Set DHCP switch to 
OFF

To AXT630 RF out To AXT630 RF out To AXT630 RF out To AXT630 RF out

Band 1 Band 2 Band 3 Band 4
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Inventory Tab

① Inventory List
The system will discover devices that are live on the network and display them on the Inventory list (colored black). 
The system also displays offline devices here (colored gray).

② Sorting
Sort devices by the following: type of device (Type), column headers (Header), or zone (Zone).

③ Parameters and Settings
Edit device settings in the Inventory list by double-clicking in the columns. The system immediately applies changes to 
Axient, UHF-R, and PSM1000 for online devices.

④ Tagging
In the Tags column, set a tag (name, number, etc...) to use for filtering. Double-click in the Tags column and add the 
tag. The tag becomes available on the Inventory sidebar.

⑤ Filter
Devices displayed in the The Inventory tab can be filtered by placing checkmarks in the boxes for Tags, Type, Manu-
facturer, and Zone.

Wireless Workbench 6 is the next generation in pre-show planning, wireless frequency coordination, device control, and 
spectrum analysis tools available from Shure. Wireless Workbench 6 is available for both Windows and Mac operating 
systems.

Visit the Wireless Workbench 6 Forum at http://wirelessworkbench6beta.forumflash.com/ for news, tips, FAQs, and dis-
cussions with other Wireless Workbench users.

The Inventory tab displays all devices that are live on the network and any offline devices that have been added to inven-
tory. Wireless Workbench includes a database of devices (both Shure and other manufacturers), allowing for the creation 
of custom device profiles.

Chapter 7 ‒ Wireless Workbench® 6

Tip: Typing into the Search box will filter the inventory display to show devices that match the text.
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Frequency Coordination Tab
The Frequency Coordination Manager calculates compatible frequencies for the devices in the inventory.

① Frequency Coordination Plot
The Frequency Coordination Plot displays 
scan data taken from either the Spectrum 
Manager or receivers. If a scan has not 
been performed, or if a scan file has not 
been loaded, the plot only displays device 
markers for device frequencies in the inven-
tory list.

② Recent Scans
Scans for the show from the Scan Data 
window are listed here. Select which ones to 
display on the plot. Right-click and use the 
shortcut menu to save the scan as a file or 
to select display options for the scan data.

③ Scan Data
Loaded scan files for the show from the 
Scan Data window are listed here. Select 
which ones to display on the plot. Right-click 
and use the shortcut menu to save the scan 
as a file or to select display options for the 
scan data.

④ Scan Summaries
Use the Peak Hold feature to compare 
scans and scan files.

⑤ Wideband Navigation Strip
Use the wideband navigation strip to adjust 
the area of the spectrum the plot displays.

⑥ Coordination Buttons
• Manage Channels - opens the Channel Summary window, 

for specifying which channels will receive frequencies during 
frequency coordination

• Change Scan Data - opens the Scan Data window, for defining 
what scan data to use for calculating compatible frequencies

• Change TV Channels - opens the TV Management window, for 
defining TV channels to avoid

• Change Exclusions - opens the Exclusions window, for defining 
any other frequencies to avoid

• Change Inclusions - opens the Inclusions window, for defining 
and selecting User Groups and Inclusions Lists, which specify the 
allowed spectrum on a global or per-channel basis

• Analyze Current Frequencies - analyzes the compatibility of 
devices in inventory as a part of the coordination, and reports any 
conflicts found

• Calculate New Frequencies - calculates a compatible frequency 
list for devices and deploys the assigned frequencies to the 
hardware

⑦ Add Marker
Add markers to the plot to identify key areas.

⑧ Plot Parameter Fields
Use the plot parameter fields to adjust the area of the spectrum 
the plot displays.
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Monitoring Tab

① Channel Strips
Channel strips display a configurable subset of parameters for each channel. Adjust parameters such as frequency or 
gain and have them update immediately on the hardware.

② Channel List
The Device Chooser area lists microphone channels and other networked devices. Selecting a channel adds a chan-
nel strip to the tab, and selecting a device such as a charger or Spectrum Manager displays the Properties window for 
that device.

③ Shortcut Menu
Right-click on a channel strip to open the Properties window and view all parameters for the channel, or select Chan-
nel Strip Settings to customize which parameters the channel strip displays.

④ Channel Groups
Create a new channel group to organize channels by clicking the Add button under the Channel Groups section. 
Drag and drop channels from the Channel List to add them to a group. To view the channels in a group, select the 
group from the Channel Groups area.

The channel strips on the Monitor tab let you monitor and make remote adjustments to hardware. Select a channel from 
the Channel List area to add a channel strip.
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Toolbar

• Add new device - Opens the Add New Device window, for adding offline devices to the Inventory list

• ShowLink Plot - Opens a blank ShowLink™ plot, for monitoring the 2.4 GHz spectrum and managing your ShowLink 
Access Points (AXT610)

• Frequency Plot - Opens a blank frequency plot, for continuously monitoring the RF environment or for viewing a 
saved scan file

• RF History Plot - Opens a blank RF history plot, for monitoring the RF activity on up to 20 channels

• Frequency List - Opens the Frequency List window, for viewing the frequency lists that have been deployed to all 
zones

• Alerts - Opens the Alerts window, for viewing a log of alerts and system events

The Toolbar provides links to important tools.
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Zones

Zones and Intermodulation Products
When multiple zones are present, Wireless Workbench calculates a multi-zone compatible frequency list. Creating mul-
tiple zones indicates to the system that the equipment is far enough apart to avoid intermodulation products with no chan-
nel-to-channel conflicts.

Assigning Equipment to Zones
A device cannot be in multiple zones, meaning that both channels of a dual-channel receiver must be within the same 
zone. Additionally, any linked transmitter and receiver pairs must be within the same zone.

Zones and Spectrum Managers
Wireless Workbench calculates a compatible frequency list for each zone created within a system. The frequency lists are 
deployed to devices from the Spectrum Manager designated for each zone in Wireless Workbench, or deployed directly to 
the equipment assigned to the zone if a Spectrum Manager has not been specified.

Saving Zones Across Sessions
The zone parameter is not stored on devices. To save the zones in Wireless Workbench, you must save your show file. 
Otherwise, when the equipment goes offline and then comes back live on the network, all equipment will be shown in the 
same zone.

To maximize the number of frequencies available for larger venues such as corporate campuses, festival venues, and 
theaters, you may be able to divide the environment into zones. Creating zones in Wireless Workbench tells the frequen-
cy compatibility calculator to assume that systems in one zone will not create intermodulation distortion with systems in 
another zone.

The key is to place the devices in different zones and provide enough RF separation between each zone to prevent in-
termodulation distortion (IMD). Factors that must be considered when creating zones are the physical distance between 
zones, occlusion by building materials, the volume of surrounding RF traffic, transmitter output power, antenna selection 
and placement, and overall quality of the wireless system

Room 1 Room 2

Room 3
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Chapter 8 ‒ Wireless Workbench Configuration Example

Step 1: Setting up a show file
Set up the show properties by clicking File > New Show. Enter the details of the show, venue, and contact information 
that can be saved as a show file (.shw) in Wireless Workbench.

This chapter covers the steps of pre-show planning using tools in Wireless Workbench.
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Step 2: Adding devices to inventory and setting up zones
Click Add new device on the toolbar to choose devices for the show. From the list of manufacturers, models, and bands, 
select the device type and pre-configure the frequency to allow the system to find the best available, or manually enter the 
frequency. If using zones, it's convenient to set up zones for the show while in the inventory chooser.

Tip: All device and channel settings can be set from the inventory view.
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Step 3: Naming devices
Once the devices are entered into the inventory, assign individual names to the device ID and channel name. For the ex-
ample below, the device IDs are RX1, RX2, RX3, and the channel names are Vocal1, Vocal2, Vocal3, Vocal4, Guitar1, 
Guitar2.
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Step 4: Entering television station information
Enter the television station information that Wireless Workbench will take into account when performing the frequency 
coordination. Select the Frequency Coordination tab, and then Change TV Channels… under the ‘Coordination’ tab. 
Specify the location of the venue by entering the city and postal code, or entering the latitude and longitude by selecting 
geo data in the location setup box. After entering the venue location information, select ‘Search’ and Wireless Workbench 
will look up the location in its database and display the television station information for that area. Use import and export 
options to bring other station information into Wireless Workbench as well as block individual television stations from the 
frequency coordination.
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Step 5: Selecting channels to coordinate
Use this step to select the channels that will receive new frequencies from the calculation. Unselected channels will retain 
their frequency and not be altered by the frequency coordination and calculation process in Wireless Workbench. During 
the frequency calculation for selected channels, unselected channels will be analyzed as part of the overall solution.
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Step 6: Entering frequency scan data
If scan data for a venue is available, import the scan file (.sca) into Wireless Workbench. Saved scan data can also be im-
ported from the AXT600 Spectrum Manager if it is connected to Wireless Workbench. If scan data is not available during 
the pre-show planning, live scan data from the venue can be included later.
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Step 7: Entering Exclusion ranges
Enter additional individual frequencies or frequency ranges to exclude from the frequency coordination process.

If you have the Automatically calculate exclusions from scan data preference checked in the Coordination tab of prefer-
ences, exclusions will be generated by the scan data in the Coordination plot and the exclusion threshold level. If this pref-
erence is not checked, but you want a one-time calculation of exclusions based on the scan data in the Coordination plot 
and the exclusion threshold, select Check Scan Data.
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Step 8: Save Show File
At this point, the pre-show planning for this venue is complete. Save the inventory, scan data, television station, and ex-
clusion information into one file and recall it at the venue.

Select the File > Save menu option to save the show.

Tip: Use the following keyboard shortcuts to save a show:

• Mac: Command+S

• Windows: Control+S 
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Step 9: Matching inventory to live devices (including merging devices)
At the venue with the live devices set up and configured, load the show file and configure the devices. Open the show file 
from the File > Open Show menu.

Wireless Workbench will present a 
merge dialog if the Frequency param-
eters or Settings parameters between 
the Live device (hardware) and the of-
fline device (WWB6) do not match. 

Tip: If you have a large number of devices to merge, turn OFF all live devices, load the show file, and then power on each live device one at a time to 
easily identify which live device to merge with the offline device.

Tip: Refer to the Wireless Workbench 6 help 
system chapter "Frequency and Settings 
Parameters per Model" for more information.

Note: An online device can only be merged 
with an offline device and all devices must of 
the same manufacturer, model, and band.

To resolve differences between all Live and Offline devices, use the buttons next to the All Devices label.

To resolve the frequency and settings for individual devices, use the buttons next to the Individual Devices label.

Click on either the Frequency parameters or Settings parameters buttons to choose the parameters of the Live device or 
of the offline device. When finished, click apply.

If the devices in the show file have 
never been matched to the actual 
live devices, WWB adds the offline 
devices to the inventory. Drag each 
offline device onto its corresponding 
live device to merge them into a single 
device in the inventory.
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Step 10: Frequency coordination and deploying frequencies to live devices
If a prior frequency scan data from Step 6 is not available, select the Frequency Coordination tab at the top of the appli-
cation, then select Change Scan Data....

From the Scan Data window select Settings.
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Once the scan is completed, select Calculate New Frequencies from the Coordination panel. WWB will calculate a new 
compatible frequency list (CFL) using the device list, TV channel information, exclusion threshold, and scan data. WWB 
will then display a new window with the frequency calculation results.

Select Deploy to Inventory to send frequencies to devices.

Choose which device to use for the scan (either a receiver or a Spectrum Manager) and enter the frequency range to 
scan. Click Start to perform the scan.

Tip: Selecting Export > Coordination Report generates a report of the frequency calculation results to save and print.
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Step 11: Setting up and using monitor views
To monitor live devices in real time, select the Monitor tab. From the Device Chooser, select the channels to monitor. 
Drag the individual channel strips around to place them in any order. 

Select which parameters to show 
and how many channels per 
row to display by right-clicking 
Channel Strip Settings anywhere in 
the monitor area.

Set up channel groups by selecting the Channel Group heading, clicking 
Add Group, and then naming the channel group. Next, drag individual 
channels from the Channels list on the right sidebar into the channel 
group. Once channels have been selected and placed, save these settings 
to the show file for future use.
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Step 12: Viewing the frequency list from the Spectrum Manager
Selecting Frequency List from the tool bar displays real-time analysis of frequency list monitored by the Spectrum 
Manager. The Spectrum Manager continuously measures and ranks the frequencies based on noise and interference.
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Step 13: Using the ShowLink, Frequency, and RF History Plots
Wireless Workbench provides plots to show activity in the ShowLink 2.4 GHz spectrum and the RF Spectrum. 
Additionally, an RF History plot is available to record transmitter signal strength over time.

ShowLink Plot
A dedicated 2.4GHz scanning radio inside the ShowLink Access Point (that is separate from the ShowLink radio) continu-
ously scans the 2.4GHz spectrum to generate the ShowLink plot. The ShowLink plot contains a live 2.4GHz measure-
ment, as well as a 10- second moving average and maximum value over the scan duration. Run the ShowLink plot from 
any Access Point without any effect on the real-time ShowLink network. Save the scans to files for future use or playback 
the data at any point in the time history of the record. By selecting an Access Point to perform the scan, you can see the 
2.4 GHz spectrum density seen at that Access Point over time.
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Frequency Plot
Use a receiver or Spectrum Manager to perform real-time, wideband frequency scans that can be overlaid and saved to a 
file. Select the Scanner Setup… button in the Frequency Plot window to choose which device to use to perform the scan 
and set the start and stop frequencies. If using a Spectrum Manager, choose the resolution bandwidth (RBW) and step 
size of the scan.

Note: If you’re using a Spectrum Manager to perform a frequency plot, the Spectrum Manager will suspend all backup frequency monitoring and rank-
ing processes during the scan.
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RF History Plot
The RF History Plot measures and records the signal strength of a transmitter as measured by a receiver over time. The 
RF History Plot is also referred to as a ‘walk-around’ plot since WWB can be set to record the transmitter signal as you 
walk the venue to ensure proper antenna placement and coverage. Select the Add Channel… button in the RF History 
Plot window to select which receiver channel to record. Up to 20 receivers and channels can be selected to record at one 
time.
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Antenna Placement

Antenna Power

Antenna Faults

Antenna ports A and B of the Axient Antenna Distribution Systems, AXT400, and AXT600 provide a DC bias output of 12-
15 V DC to power active antennas. Set the DC power to off when using passive (non-powered) antennas.

The antenna input status LED flashes red to indicate a short at an antenna port.

To isolate the fault, navigate to the Antenna Power menu. The menu displays 
which antenna port (A, B, or A+B) is the source of the fault. Check the antenna 
connections to remove the fault condition.

To set the antenna voltage, navigate to the Antenna Power menu and use the 
arrow keys to select one of the following options:

• On: Antenna Power = 12-15 V DC

• Off: Antenna Power = 0 V DC

The following sections cover routing the RF antenna signal to receivers, Spectrum Managers, and antenna distribution 
systems.  

Proper antenna placement has an enormous impact on RF system performance. In general, receiver antennas should be 
at least six feet above ground level and at least six feet away from other antennas. Maintain a clear line-of-sight between 
transmitters and receiver antennas. Avoid placing antennas near walls or other reflective surfaces.

Options for antenna placement include the following:

• Front-mounted on a rack component

• Remote mounted above crowd level

• Shared antenna signal from an antenna distribution system

Chapter 9 ‒ RF Connectivity and Antennas
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The RF cascade ports provide a connection point allowing additional receivers, Spectrum Managers, or Antenna 
Distribution Systems to share the RF signal. The following components have RF cascade ports: 

• AXT600 Spectrum Manager

• AXT400 Receiver

• Axient Antenna Distribution Systems 
The following table lists the characteristics of the cascade ports for each component.

Component Cascade Output 
Filtering

Signal Loss Recommended Devices

AXT400 Receiver Output matches selected 
tuning band

0 dB Up to 5 receivers tuned to the same 
band

AXT600 Spectrum 
Manager

Wideband 4 to 5 dB Receivers, Axient Antenna Distribution 
Systems

Axient Antenna 
Distribution System

Wideband 4 to 5 dB AXT600 Spectrum Manager, receiv-
ers, Axient Antenna Distribution 
Systems

RF Cascade Ports
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Gain and Attenuation
Use the RF Gain menu to maintain consistent signal levels sent to connected devices. The available adjustment range is 
-12 to +3 dB when the Cascade ports are off and -15 to 0 dB when the cascade ports are active.

Connecting Devices to the RF Outputs
Connect an A and B pair of RF outputs from the Antenna 
Distribution System to the A and B inputs of the device.

Input Band Filtering
Input band filters improve linearity of the system by rejecting out-of-band signals. Select the band filter that most closely 
matches the tuning range of connected devices to optimize performance.

The Wideband setting passes 470-698 MHz (AXT630), 606-814 MHz (AXT631), or 470-787 MHz (AXT632).

RF Output Distribution

Signal Flow

The RF distribution ports of an Antenna Distribution System send the signal from a pair of antennas to up to 4 receivers or 
additional antenna distribution systems. Port-to-port isolation reduces interference, making the distribution ports the best 
option for distributing signal to additional devices.

Note: The input band filters act on the RF distribution ports but do not affect the RF cascade ports.

Adding an AXT600 Spectrum Manager to an 
Antenna System
Connect the AXT600 Spectrum Manager to the RF 
Cascade ports of the Antenna Distribution System.
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For large configurations, multiple Axient Antenna Distributions systems (AXT630 in this example) can be layered to sup-
port up to 3 levels of signal distribution:

Level 1
Axient Antenna Distribution 
System set to Wideband

Connect the AXT600 Spectrum 
Manager to the RF cascade 
ports of the level 1 Antenna 
Distribution System 

Level 2
Set Axient Antenna Distribution System band filter to 
match the frequency band of the connected receivers

Example 1

Example 2

Note: Only connect devices of the same 
frequency band to the cascade ports of 
the receivers.

Multiple Levels of Antenna Distribution

Note: For best RF performance, use all the RF outputs on one level before creating additional levels.

53Chapter 9 - RF Connectivity and Antennas

AXT630 (Wideband) AXT600

AXT630 (H4 Filtered)AXT630 (G1 Filtered)

Receiver (G1)

Receiver (G1)

Receiver (G1)

Receiver (G1)

Receiver (H4)

Receiver (H4)

Receiver (H4)

Receiver (H4)

RF Outputs RF Outputs

Cascade Ports

AXT600

Receiver (G1)

Receiver (G1)

Receiver (L3)

Receiver (L3)

Receiver (J5)

Receiver (J5)Receiver (H4)

Receiver (H4)

AXT630 (Wideband)

RF OutputsRF Outputs RF Outputs

Cascade Ports

Cascade PortsCascade PortsCascade PortsCascade Ports



Chapter 10 ‒ Networking

• 10/100 Mbps network speed
• RJ45 Ethernet ports
• Compatible with networked UHF-R receivers

• Automatic (DHCP enabled) IP addressing
• Class 1 Power over Ethernet (PoE) ports, as labeled

Networking Best Practices

Connecting components using an Ethernet network enables advanced Axient features such as automatic frequency 
assignment, remote control and monitoring, and interference avoidance. Adding a computer to the network allows you to 
run Wireless Workbench® 6 (WWB6) to control and monitor devices on the network.

Axient components feature the following network specifications: 

Use the following best practices when setting up a network to ensure reliable communication:

• Always use a "star" network topology
• Use only 1 DHCP enabled server per network. Disable DHCP addressing on additional servers
• When using an AXT620 Ethernet Switch, turn on the switch first before turning on additional components connected 

to the network
• To expand the network, use multiple Ethernet switches in a star topology
• Connect each device directly to the port of an Ethernet switch. Avoid "daisy-chaining" Ethernet port connections 

between devices for larger networks.
• Do not loop network connections
• All networked devices must be set to the same subnet mask
• All devices must be at the same firmware revision level, with the exception of the AXT620 Ethernet Switch
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Configuring Network Settings with the AXT620 Ethernet Switch

Default Values 
Change your user name and password 
for increased security. 

IP Address: 192.168.1.1 

Subnet Mask: 255.255.255.0 

User Name: root 

Password: root 

System Login 
To configure the switch, you must log into the system via a web browser. 

1. Open a web browser. In the 
address bar, enter the IP 
address of the switch, and then 
press Enter. 

2. On the login window, enter your 
credentials. For the initial login, 
use the default user name and 
password. Select OK. 

Configuration Options

System Information
This option lets you assign the system name, description, 
physical location, and contact personnel. You can also look 
up your firmware and kernel version here, as well as the 
MAC address.

IP Configuration
The switch is a network device and needs to be assigned 
an IP address for identification on the network. When 
making changes to the menu configuration settings, you 
must click Apply to make the changes to the switch.  If you 
want to make the changes persist after a power cycle, you 
must click Save Configuration in the menu on the left side 
of the switch web page.

DHCP Server - System Configuration
When you are using multiple switches to manage 
numerous devices, you can designate one switch to act as 
the DHCP server. All other switches must be designated as 
clients with the DHCP server set to OFF.

Only the server can have the DHCP switch set to ON.

DHCP Server - Client Entries
When the DHCP server function is enabled, you can view 
DHCP client information here. 

TFTP Transaction
In this option, you can update the firmware of the switch. 
You will need to run a TFTP server on the computer 
connected to the switch, and then enter the IP address of 
the computer in the TFTP Server IP Address field. Then 
enter the name of the firmware file into the ‘Firmware File 
Name’ field and click Apply to start the upgrade process. 
Once the upgrade process is complete, you should click 
Factory Default on the left-hand side of the Main Page of 
the switch.

User Authentication
In this option, you can change the user name and 
password of the switch.

Power over Ethernet
In this option, you can manage your Power over Ethernet 
options. You also can view the system’s real-time total 
power consumption, output voltage for PoE ports, and the 
firmware version of the PoE chip.

The switch is managed from an embedded web server, which offers advanced configuration features and lets you access 
the switch from anywhere on the network through a standard web browser. The Web-Based Management supports 
Internet Explorer 6.0 or later versions. 

Note: Pressing the Reset button will restore 
the default values.
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Network Topologies

Multiple Ethernet Switch Setup #1
• Any AXT620 switch (but only one) can be set as the DHCP server
• Each networked device needs an individual connection to the switch
• Connect them via any port

AXT620 with front panel 
DHCP switch set to ON

Server 

Client Client 

AXT620 with front panel 
DHCP switch set to OFF AXT620 with front panel 

DHCP switch set to OFF

There are several ways to configure a network of devices. In general, you should always use a "star" network topology 
where each device uses one connection to an Ethernet switch port. If multiple switches are used, each switch is 
individually connected to one connection to the next level of Ethernet switch.

Below are three example configurations of large networks of devices.

AXT610 
ShowLink 

Access Point 
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Multiple Ethernet Switch Setup #2
Each networked device needs an individual connection to the switch.

AXT620 with front panel 
DHCP switch set to ON

Server 

Client 

Ethernet Switch 

AXT610 
ShowLink 

Access Point 
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Multiple Ethernet Switch (Wi-Fi) Setup #3
Each networked device needs an individual connection to the switch.

Wi-Fi Router 
(DHCP enabled) 

Server 

Client Client 

AXT620 with front 
panel DHCP switch 

set to OFF

AXT620 with front 
panel DHCP switch 

set to OFF

AXT610 
ShowLink 

Access 
Point 

58 Part 2: System Setup and Configuration

ON OFF
DHCP

ON OFF
DHCP

802.11 g / n

AXT610
Axient W

ireless
Showlink Acces Point



Assigning IP addresses to Networked Devices

Automatic IP addressing
1. Set the IP address mode to Automatic for all devices on the network.

Manual IP Addressing
1. Set the IP address mode to Manual for all devices on the network.

2. Connect the devices to an Ethernet switch.

3. Manually assign valid IP addresses to each device on the network.

Each device on the network must be assigned a unique IP address to ensure network communication. IP addresses can 
be assigned automatically by a DHCP enabled server such as the Shure AXT620 Ethernet switch, or manually assigned 
from a list of valid IP addresses.

Note: Selecting the reset option for a device will clear existing IP addresses and set the IP address mode to Automatic.

2. Connect the devices to a DHCP enabled server.

3. Upon connection, the server will automatically assign IP addresses to the devices.

Note: All IP addresses must be on the same subnet.

Tip: You can engage the Automatic IP mode on the AXT610 ShowLink Access Point by holding the reset button down until all LEDs blink while the 
device is powered on. The AXT610 will then reboot into the Automatic IP mode.

Note: If a DHCP server is not connected, the IP addresses for each device will automatically fall back to an address of 169.254.x.x. If a DHCP 
server is connected, IP addresses will automatically be assigned by the server. All Axient network devices will fall back to a private 169.254.x.x 
address within a few seconds of power on; however, the UHF‐R receivers will take up to 60 seconds to fall back to a 169.254.x.x.
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Connecting a Computer to the Network
Connecting a computer to the network allows you to run Wireless Workbench® 6 to control and monitor devices on the 
network. A computer can be connected to any Ethernet port in the system. The Shure AXT620 Ethernet switch offers a 
convenient front panel port for easy computer connection.

• Make sure that the computer subnet mask value is the same value as all devices on the network
• Login as an Administrator if using Windows Vista or Windows 7
• Multiple instances of Wireless Workbench 6 can be used on the same network. Avoid running Wireless Workbench 5 

and Wireless Workbench 6 on the same network.
• Set any firewall or anti‐virus software to allow Wireless Workbench and SLPD.EXE including:

wwb6.exe
slpd.exe
snetdameon.exe
shurefirmwareupgrader.exe
snetconfigexe.exe

Connecting to devices via USB is not supported in Wireless Workbench 6. An Ethernet connection is required for WWB6 control.

Configuring Firewalls for Mac or Windows Operating Systems

Mac OS Native Firewall
1. Open System Preferences.

2. Select Security, and then select the 
Firewall tab.

3. To enable editing, make sure 
the lock icon at the bottom of the 
window is unlocked before entering 
your password.

4. If the firewall is on, select 
Advanced. For each of the following 
applications, select "Allow Incoming 
Connections":

• Wireless Workbench 6.app
• slpd
• snetDameon
• acnproxy

Windows XP or Vista Firewall
1. From the Start menu, select Control 

Panel.

2. Select Windows Firewall.

3. In the Windows Firewall window, if 
the firewall is set to On, select the 
Exceptions tab and add the following 
applications to the exceptions list:

• WWB6.exe
• SLPD.exe
• SNETDAMEON.exe

Windows 7 Firewall
1. From the Start menu, select Control 

Panel.

2. Select Systems and Security.

3. Select Windows Firewall.

4. Select Allow a program or feature 
through Windows Firewall.

5. To view the list of applications, 
select Change Settings.

6. Select the following applications to 
allow them:

• WWB6.exe
• SLPD.exe
• SNETDAMEON.exe
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Configuring Wi-Fi for Wireless Networking
When using Wireless Workbench over Wi-Fi, it’s important to set up the wireless router properly for best performance. 
Wireless Workbench employs ‘multicast’ data protocols to communicate to the Axient and PSM1000 devices. Wi-Fi treats 
broadcast and multicast packets differently than general packets for backward compatibility reasons. In some cases, the 
Wi-Fi router will limit the multicast packet transmission rate to a value that is too slow for Wireless Workbench to properly 
operate.

By default, most Wi-Fi routers are configured to operate in ‘b/g-mode’, which tells the router to allow both 802.11g and 
older 802.11b devices to operate over the network. In this configuration, some routers will automatically limit the multicast 
data rates (or sometimes referred to as ‘basic rate’, or ‘management rate’) to 1-2Mbps. For small wireless microphone 
configurations of less than 20-30 channels, this Wi-Fi setting should not cause any problems with Wireless Workbench.

Tip: For larger wireless microphone configurations of greater than 30 channels, it’s recommended to configure the Wi-Fi router to operate in ‘g-mode’ 
only. Most routers will increase the multicast transmission rate to 6Mbps when operating in ‘g-mode’ thereby providing adequate bandwidth to 
Wireless Workbench.

Important: For best performance, use a Wi-Fi router that does not limit the multicast rate to 1-2 Mbps.

Shure recommends the following Wi-Fi router brands:

• Cisco

• Linksys

• Apple
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Chapter 11 ‒ Axient Rechargeable Battery System

Lithium-ion Charge Cycle Effects of Temperature on Battery 
Performance

Battery Safety Features

Storing Batteries

Battery Runtime

AXT100 Runtime

RF Power (mW) Runtime ShowLink Enabled (hours/minutes) Runtime Without ShowLink (hours/minutes)
10 7:30 8:00
100 5:35 6:05

AXT200 Runtime
RF Power (mW) Mode Runtime ShowLink Enabled 

(hours/minutes)
Runtime Without ShowLink 

(hours/minutes)
10 Single Carrier 9:05 10:00

Frequency Diversity 6:15 6:45
50 Single Carrier 6:45 7:15

Frequency Diversity 4:20 4:40

Axient lithium-ion rechargeable batteries use advanced chemistry that maximizes transmitter runtime with zero-memory 
effect. Axient power management provides detailed visibility to critical battery parameters such as health, charge status, 
temperature and cycle count. Batteries can be charged to 50% capacity in one hour and to full capacity in three hours. 
The AXT910 battery powers the AXT100 bodypack transmitter and the AXT920 battery powers the AXT200 handheld 
transmitter. 

The batteries charge in a logarithmic curve, resulting in 
quick initial charging, followed by gradual charging to 
maximize battery lifetime and health. A battery charge 
cycle consists of one charge and discharge.

Batteries have an operating range of 0°C to 60°C (32°F to 
140°F). The internal temperature of the battery has an effect 
on overall battery performance. Battery runtime will decrease 
when the battery is cold. At warmer temperatures, battery 
runtime increases with a negative effect on overall battery 
health.

Shure rechargeable batteries incorporate the following 
features to provide safety and protect battery health:

• Internal protection circuit stops charging and 
discharging when the battery is too hot

• Monitoring circuit limits negative health effects 
of over-voltage, over-current, and under-voltage 
conditions

• Recovery mode for deep discharged batteries 
terminates charge if voltage does not increase within 
30 minutes

• Internal timer stops charging if full capacity is not 
achieved within 4.5 hours

When batteries are not going to be used for longer periods 
of time, they should be stored at an ideal voltage of 3.8 volts 
to maintain optimal health. The AXT900 Rackmount Charger 
has a Storage Mode function that when activated, will charge 
or discharge a battery to 3.8 volts.

For long term storage (more than 8 days), remove the 
batteries from the charger, and place them in a temperature 
controlled storage area. To avoid degrading battery health, 
keep the storage temperate range between 10°C to 25°C 
(50°F to 77°F).

Battery runtime varies according to the transmitter's operating mode. High power settings will reduce battery runtime. 
Operating an AXT200 transmitter in frequency diversity mode reduces runtime. Remaining battery runtime is shown on 
the transmitter display in hours and minutes (accurate to within 15 minutes).

The times shown in the tables represent a battery with a minimum of 5 charge cycles, fully charged, at 100% health.
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Charging Batteries with the AXT900 Charger
Inserting Batteries into the Charging Bay
Slide the battery into the charging bay until it locks into place. The charge LED illuminates and the charge cycle begins.

• To remove handheld batteries: press the release button on the front of the charger module
• To remove bodypack batteries: press the release tabs on the sides and pull back

CALC calculating time to full
COLD Battery temperature = 0°C (32°F) or lower.
WARM Battery temperature = 45°C to 60°C (113°F to 140°F).
HOT Battery temperature = 60°C (140°F) or higher.
Recovery recovery mode active
Error error - press SET key for info

▲

▲

SET

4

3

2

1

8

7

6

5

Charge Status LED
Each charger bay has an LED to indicate the status of the battery.

Red battery charging
Green charging complete
Off battery inserted incorrectly, battery depleted below 3.0 volts, battery cold (< 0° C), battery hot (> 60° C)
Amber charging stopped at reduced capacity (not less than 75% capacity) because a battery is too warm. To 

reach 100% capacity, a battery must be cooled to below 45°C

Home Screen
When powered on, the charger displays the home screen. Icons indicate the charge level of each battery, and the display 
alternates to show approximate hours and minutes remaining until the battery is fully charged.

The numbers on the screen correspond to the charging bays 1 through 8 from left to right.

The following messages may be displayed next to the bay number to indicate battery status:

Troubleshooting
Charge status 
LED does not 
illuminate.

Battery is inserted incorrectly or battery cannot accept a charge. Check battery temperature.

Battery does not 
charge

Battery discharged below 3.0 volts. Try another battery.
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Time to Full
Displays the time remaining until the battery is fully charged.

Battery Health
Displays battery health as a percentage of the charge capacity of a new battery. Charge capacity (battery life when 
fully charged) will decline as a result of repeated charge cycles, age, and storage conditions. The percentage shown is 
normalized for typical use and conditions to ease comparisons between batteries.

Cycle Count
Displays the total number of times that the battery has undergone one full count of discharge and charge. Recharging 
after discharging half way counts as one half of a cycle. Recharging after discharging a quarter of the way counts as one 
quarter of a cycle.

Charge Status
Displays charge as a percentage of the total battery capacity. Also displays charge in milliampere-hours (mAh).

AXT900 Monitoring Menu
Use the monitoring menu to access detailed information about each battery.

1. From the home screen, use the arrow keys to highlight the number of the battery you want to monitor. The white LED 
next to the selected battery illuminates.

2. Press the SET key to access the monitoring menu.

3. Use the arrow keys to scroll through the menu screens.

Press SET key at any time to return to the home screen.

Batt. Temp. (Battery Temperature)
Displays the battery temperature (in Celsius and Fahrenheit).

Tip: If warm or hot, increase ventilation to the rack.

Note: In certain cases, factors such as recent usage and temperature conditions can cause the percentage of mAh shown to differ slightly.

IMPORTANT: Battery might not be charged to full capacity if any of the following status indicators appear:
Cold
Charging stopped because battery temperature is too cold. Charging will resume when battery temperature 
increases.
Warm
Battery will charge to a reduced capacity (not less than 75%) because of elevated temperature. The amber LED will 
illuminate when charging has stopped.
Hot
Charging stopped because battery temperature is too hot.
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AXT900 Storage Mode
Use Storage mode to charge or discharge the batteries to 
a level of 3.8 volts, which is ideal for long-term storage.

To enter Storage mode:

1. Enter the AXT900 utility menu by holding both arrow 
keys.

2. Navigate to the Storage menu and press the SET key.

3. Use the arrow keys to select On.

The charge status LEDs indicate the voltage state:

• Red flashing = battery charging or discharging to 3.8 
volts.

• Amber flashing = battery voltage at 3.8 volts.
4. Press both arrow keys to return to the Monitoring 

Menu.

The following indicators appear on the home screen next 
to each bay number:

Rdy battery at 3.8 V, ready for storage
Cold battery cold
Wrm battery warm
Hot battery hot
Err Error, press SET key for info
% percentage of charge

Charging or discharging may take several hours.  
The remaining time is displayed as Time to 3.8 V in  
the battery monitoring menu (instead of Time to Full).

To exit storage mode:

1. Enter the utility menu by holding both arrow keys.

2. Navigate to the Storage Mode menu and press the SET key.

3. Use the arrow keys to select Off.

4. Press the SET key to exit.

Recovering a Battery from Deep Discharge
A deeply discharged battery is one that has been discharged to less than 3.0 volts. When the charger detects a deeply 
discharged battery, it automatically enters recovery mode, which charges the battery using a reduced current. The 
Recovery icon is displayed next to the bay number on the home screen. If recovery is successful, the charger exits 
recovery mode and charges the battery to capacity.

If the battery cannot be recovered within 30 minutes, an error message is displayed and charging stops. Remove the 
battery from service and check with local vendor for proper disposal of used batteries.

When batteries are ready for storage, they should be removed from the charger and placed into a temperature controlled area. Recommended battery 
storage temperature is 0°C (32°F) to 25°C (77°F).
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Charging Batteries with a Portable Charging Station

Connecting DC Power
1. Connect the cable from the Shure PS50 power supply 

to the DC power supply input. 

2. The white LED will illuminate when the PS50 is 
connected to an AC power source.

Inserting and Removing Handheld Batteries
To Insert:

1. Slide the battery into the charging bay. 

2. Press the battery until it locks into place. 

To Remove:

1. Press the release button on the front of the charger 
module.

2. The release mechanism will eject the battery from the 
charger module.

Charge Status LED
Each charger bay has an LED to indicate the status of the battery.

Red battery charging
Green charging complete
Off battery inserted incorrectly, battery depleted below 3.0 volts, battery cold (< 0° C), battery hot (> 60° C)
Amber charging stopped at reduced capacity (not less than 75% capacity) because the battery is too warm. To 

reach 100% capacity, the battery must be cooled below 45°C

Inserting and Removing Bodypack Batteries
To Insert:

1. Align the battery with the charger bay.

2. Press the battery into the charging bay until it locks into 
place.

To Remove:

Press the release tabs on the sides of the battery and pull 
back.

Troubleshooting
Power LED off. DC power fault - check connection to power supply. Ensure PS50 power supply is connected to an 

AC power source.
Charge status 
LED does not 
illuminate.

Battery is not fully inserted.

Battery does not 
charge

Battery discharged below 3.0 volts. Try another battery.

The AXT903 and AXT904 Portable Charging Stations charge 2 transmitter batteries in a convenient and compact desktop 
unit. Use the AXT903 to charge bodypack transmitter batteries or the AXT904 to charge handheld transmitter batteries.
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Backup Options using Standard AA Batteries

Lithium-ion batteries require some additional documentation when transporting equipment, whether by air, boat, or 
ground. Although all lithium and lithium-ion cells and batteries are regulated as Class 9 "hazardous materials" or 
"dangerous goods" for shipping domestically and internationally, there are exceptions to "small" batteries based on the 
amount of lithium in these batteries. All of the rechargeable lithium-ion batteries Shure sells or uses in products are in the 
"small" classification.

If shipping is required, the batteries are classified as lithium-ion rechargeable battery packs. Based on the amount of 
lithium that they contain, they are not considered hazardous materials and are classified as "small" qualifying them for 
exemptions by the U.S. Hazardous Materials Regulations (HMR) and the International Air Transport Association (IATA).

Batteries can be transported in the charging bays of the chargers. When Shure lithium-ion rechargeable batteries are 
installed in Shure battery charger accessories, they comply with all shipping standards.

Requirements for Shipping
Use the following guidelines when transporting Shure lithium-ion batteries:

1. Lithium-ion handling labels.

• Identifies Lithium-ion battery including an emergency contact number.
• Lithium-ion CAUTION label

2. Material Safety Data Sheet (MSDS) from battery manufacturer.

To avoid delays when shipping, attach a safety label and Material Safety Data Sheet (MSDS) to the package.

The datasheet is available here: http://files.e2ma.net/21467/assets/docs/shure_material_safety_data_sheets-july2011.
pdf

3. Packaging requirements

• When Shure Lithium-ion rechargeable batteries are installed in Shure battery charger accessories, they comply with 
all shipping standards.

• Batteries not installed in equipment must be individually protected to prevent short circuits by placement in the original 
Shure packaging or by otherwise insulating terminals (tape over terminals, each battery in a separate plastic bag, 
etc...).

Shure encourages you to keep up-to-date on all transportation regulations for rechargeable batteries. Consult your Shure 
representative or the following agencies for current regulations:

• US Department of Transportation (U.S.DOT) http://SafeTravel.dot.gov/whats_new_batteries.html
• International Air Transport Association (IATA) http://www.iata.org
• Federal Aviation Administration (FAA) http://www.faa.gov 
• International Maritime Organization (IMO) http://www.imo.org

In the event that a Shure rechargeable battery is not available, optional battery sleds and carriers are available to allow 
the transmitter to use standard AA batteries as an emergency backup. Runtime using standard batteries will be less than 
a Shure rechargeable battery. 

The AXT913 3-AA battery sled holds 3 AA batteries and can be used to power the AXT100 bodypack transmitter.

The AXT921 1-AA battery carrier holds a single AA battery (lithium primary type required) and can be used to power the 
AXT200 handheld transmitter.

Caution: The AXT921 1-AA battery carrier does not support the power requirements necessary for 50 mW Frequency Diversity operation.

Transporting Batteries
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Chapter 12 ‒ ShowLink™ Network

ShowLink Basics

Within the 2.4 GHz spectrum, 16 channels are available for ShowLink communication. To ensure reliable communication, 
the access point contains an internal scanning radio that analyzes the 2.4 GHz spectrum hundreds of times per second. 
If interference is detected, the access point uses channel agility to automatically switch to a clear channel within the spec-
trum. All transmitters associated with the access point will continue to communicate uninterrupted on the new ShowLink 
channel. If ShowLink goes off-line for any reason, audio transmission will not be interrupted.

ShowLink remote control enables real-time remote adjustments of all transmitter parameters using a wireless network 
connection between linked Axient transmitters and receivers. Whether performers are on stage in the middle of a perfor-
mance, or off stage waiting for their cue, ShowLink lets you make crucial changes to transmitter settings without inter-
rupting the performers. Simply add an AXT610 ShowLink access point to any Axient network and instantaneous wireless 
transmitter control is realized over a wide coverage area for up to 16 transmitters. Additional access points can be added 
to extend the coverage area and to increase the number of supported transmitters. 

ShowLink Channels and 2.4 GHz Spectrum
ShowLink channels that enable remote control of Axient transmitters operate in the 2.40 to 2.484 GHz portion of the RF 
spectrum in accordance with the IEEE 802.15.4 protocol. Devices that share the 2.4 GHZ spectrum, including Wi-Fi, are 
manufactured to efficiently share the spectrum and cause minimal interference. Both ShowLink and Wi-Fi use "listen be-
fore talk" technology to transmit short message packets only when needed to conserve bandwidth. Available spectrum, 
low interference, and global availability make the 2.4 GHz spectrum an ideal choice for hosting ShowLink channels.
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Coverage Area
The coverage area of the access point is approximately the same as the transmitter’s UHF range (depending on the RF 
squelch setting of the receiver). Use the ShowLink Test feature in the receiver menu to map the boundaries of the cover-
age area. Multiple access points can be used to increase the coverage area or to expand coverage to multiple rooms.

Transmitter Capacity
A single access point supports up to 16 Axient transmitters. Any transmitter within range of an active access point with 
available capacity will be automatically controlled by that access point. When multiple access points are used to increase 
transmitter capacity or to increase coverage range, transmitter control is automatically divided between each access point. 
All changes in control between access points occur seamlessly and automatically, without requiring user intervention.

Transmitter Control
An access point with available capacity will automatically control linked transmitters that are within the coverage area. 
Multiple access points automatically self-manage to divide transmitter control and maintain coverage. Transitions between 
access point control do not affect the transmission of the audio channel.

2.4 GHz Channel Agility to Avoid Interference 
When interference is present from Wi-Fi or other devices sharing the spectrum, built-in channel agility automatically 
switches the access point and all controlled transmitters to a clear channel. Channel agility is able to avoid interference 
from the following devices that operate in the 2.4 GHz spectrum:

• Wi-Fi (802.11)
• Cordless phones
• Wireless video

Use the following steps to set up a ShowLink network:

1. Connect the Ethernet cable: Connect an Ethernet cable to a Class 1 Power over Ethernet (PoE) port located on the 
rear panel of Axient rack components. The PoE port supplies operating power and carries network communication for 
the access point.

2. Perform an IR Sync to Link the transmitter and receiver: A Linking relationship must be established to allow the 
transmitter to join the ShowLink network.

ShowLink Icon
The ShowLink icon appears on the home screens of a linked transmitter and receiver to indicate that the transmitter is 
within range of an access point making remote control possible. If the transmitter is beyond the range of the access point, 
or if the receiver is off-line, the icon will disappear, indicating a loss of ShowLink control.

Setting up a ShowLink Network

Note: If a PoE enabled Ethernet port is not available, connect a 15 V DC ∓10% (600 mA) power supply to the external power supply jack and connect 
a standard Cat. 5 Ethernet cable to the Ethernet port.
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Use the following guidelines when positioning the access point:

• Provide a clear line of site between the access point and transmitters
• Mount the access point on a microphone stand or wall to elevate above crowd level
• Position the antenna vertically for optimal performance. The swivel joint on the antenna allows a wide range of 

positioning to maintain a vertical alignment
• When installing multiple access points in the same location, maintain a minimum of six feet of separation between the 

access point antennas

Microphone Stand Mount Horizontal Mount Wall Mount

Recommended Installation Methods

Avoid These Installation Methods

Do not orient the antenna as shown. Do not orient the antenna horizontally.

Positioning the Access Point

Do not locate the access point and antenna 
behind glass.Glass walls may be laminated 
together for structural purposes and can also 
be coated with reflective materials for energy 
efficiency which can significantly attenuate the 
ShowLink signal.
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LEDs on the side of the access point housing indicate the flow of data traffic and the status of the access point.

ShowLink LED (blue) 
• ON Steady: ShowLink OK, 

no data transmission.
• Flashing: Data being 

transmitted - rate of 
flashing indicates level of 
activity.

Power LED (green or 
amber)

• Steady Green: Power ON; 
power source = PoE

• Steady Amber: Power ON; 
power source = external 
power supply

• OFF = No Power
• Red Flashing = response to 

remote ID flash command

Ethernet LED 
(green) 

• ON Steady: Ethernet 
connected, no traffic

• ON Flashing: 
Ethernet connected, 
flashing corresponds 
to volume of data 
traffic.

Using multiple access points extends the network and supports more transmitters over a larger area.

• Each access point added to the network adds up to 16 channels of transmitter control
• Positioning access points throughout a venue, such as backstage or near dressing rooms, provide transmitter control 

for the entire performance – before, during, and after the talent takes the stage. The access points will automatically 
manage the handoff of transmitters from one access point to another, extending the range of the ShowLink network. 
Access points can be connected anywhere on the network as long as they are all on the same physical network and 
IP subnet mask.

• The access points automatically maintain ShowLink communication, providing uninterrupted communication as the 
transmitters move from one access point to another

This section discusses the ShowLink handoff protocol and its affect on the remote control functions during the handoff.

Each ShowLink access point on the network contains a list of transmitters known as a permissions table. The permis-
sions table is formed when the access point queries networked receivers for valid linking relationships. When a linked 
transmitter is powered on, it searches for an access point on the ShowLink network to associate with to enable remote 
control. Transmitters with valid linking relationships are granted permission to associate with the access point and join the 
network. Once the transmitter has joined the network, the ShowLink icon will appear on the displays of the transmitter and 
receiver indicating remote control of the transmitter is possible.

When using multiple AXT610 Access Points, a transmitter may change association between several access points based 
on capacity or location within the venue. If a transmitter loses association with an access point, it will automatically search 
for the next access point within range. Handoffs between access points usually occur in a few seconds resulting in a mo-
mentary loss of remote control, but leave the audio signal uninterrupted.

Status LEDs

Extending the ShowLink Network with Multiple Access Points

ShowLink Handoff Protocol
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ShowLink s igna l  qua l i ty for

AXT100-1

StartTx ShowLink Test

1 :  [AXT100-1]     

2 :  [AXT100-2]     

Menu acts  on  h igh l i ghted  dev ice .

  ShowLink Test  

  

  ‘SET’ to exit
|

  ShowLink Test  

  

  ‘SET’ to begin
|

Measuring Coverage Area with the ShowLink Test
The ShowLink Test in the AXT400 receiver finds the boundaries of the ShowLink coverage area. When the ShowLink 
test is activated, a five-bar display indicating level of the signal quality appears on the screens of the transmitter and the 
receiver. As the transmitter moves away from the access point, the number of bars will decrease. ShowLink control will be 
maintained as long as 1 bar is displayed. If the transmitter is beyond the coverage range remote control will not be pos-
sible; however, the audio signal will not be affected or interrupted. To improve coverage, adjust the location of the access 
point or place additional access points to extend coverage.

The ShowLink test can be activated from the receiver menu or from the transmitter menu:

1. From the receiver menu: Util > More > 
ShowLink Test

2. Use the control wheel to highlight a transmitter to test.

3. Press Start and walk the transmitter around the cover-
age area. Monitor the number of bars displayed and 
note the areas where 0 bars are displayed.

1. From the transmitter menu: Use the arrow buttons to 
navigate to the ShowLink test menu screen.

4. Press Exit to end the ShowLink test. 3. Press the SET button to exit the ShowLink test.

2. Press the SET button to start the test and walk the 
transmitter around the coverage area. Monitor the 
number of bars displayed and note the areas where 0 
bars are displayed.

Directional antennas such as the Shure AXT644 Directional 
2.4 GHz Patch Antenna offer extended range and reduce 
multi-path effects in crowded 2.4 GHz environments. 

When using a 2.4 GHz directional antenna, be sure to elevate 
and aim the antenna at the targeted coverage area.

To maximize the range of the AXT644 when used with 
bodypack transmitters, it is important to match the angle of the 
antenna with the transmitter position on the performer. Angle 
the antenna as shown (noting the orientation of the Shure 
logo).

Directional Antenna Options

set

Always check local regulations regarding the use of 2.4 GHz antennas.
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Coverage with Diagonal Antenna Orientation

Coverage with Facing Antenna Orientation

Very large venues such as stadiums have several unique characteristics that require particular considerations when set-
ting up and operating the ShowLink system.

Stadium characteristics:

• Very long distances from transmitters to Access Points (up to 500 feet at 2.4GHz over a very wide area)
• Transmitter obstruction or shadowing due to users running and huddling within the stadium
• Outdoor locations
• Very large number of people on the field and in seats
• Lack of reflecting surfaces
• Field made of grass/sod/turf

If the transmitter is obstructed or shadowed from the Access Point in any way, stadium venues look somewhat like ‘free 
space’ to ShowLink signals in that they lack mechanisms such as ground scattering or reflections from other nearby ob-
jects that can get the transmitter energy to the Access Point over these long distances.

Recommended practices for Access Point placement to ensure best ShowLink performance 
in stadiums

• Locate ShowLink Access Points (AP) well above ground level ( > 20 feet, or 6 meters)
• Use multiple Access Points positioned on opposite sides of the venue and located at the closest point to the center of 

the field
• Use remote antennas aimed at the coverage area with vertical polarization/orientation
• Keep RF cable very short (< 2 feet, or 0.6 meters) between Access Points and remote antennas

Below is an example of the recommended locations of ShowLink access points for a typical stadium.

Tip: To maximize coverage, locate additional Access Points within the stadium interior for coverage when the transmitter is off the field.

Considerations for Operating ShowLink in Stadium Applications
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Remote Control of Axient Transmitters using Wireless Workbench 6
When an AXT610 ShowLink access point is part of the system, real-time remote control and monitoring of linked Axient 
transmitters is possible using WWB6.

1. From the Inventory or Monitor 
view, open the properties window 
by right clicking on the receiver and 
select Properties.

2. Expand the Settings area and click 
on theTx tab to view the  param-
eters for all transmitters linked to the 
receiver.

Adjustable Parameters
• Gain
• Transmitter (Tx) power
• RF Mute
• Lock
• Unlink
• Device ID
• Channel Name

Monitor
• Battery life
• Channel name
• Transmitter type
• Firmware version

Adjusting the Transmitter Frequency
There are two ways to change the transmitter frequency from the receiver by using the ShowLink network:

Method 1: Changing the receiver frequency manually
Enter a new frequency by using the AXT400 receiver Tx menu or by using Wireless Workbench. Once the frequency is 
entered, the Showlink network will automatically update the frequency of a linked transmitter.

Note: If you’re using a Spectrum Manager that has a valid compatible frequency list (CFL) and the new frequency you entered is not in the CFL, a 
star (*) icon will appear next to the frequency on the receiver to indicate that frequency is not in the CFL.

Method 2: Select a new frequency from the receiver menu: Radio > NewFreq
To get a new frequency from the CFL, go to the Radio menu of the receiver and press NewFreq.

The Spectrum Manager will deploy a new frequency to the receiver and place the previous frequency back in the CFL to 
be monitored for quality and use as a backup. The transmitter frequency will be updated via the ShowLink network.
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Control and Configure the Access Point with Wireless Workbench 6
Wireless Workbench 6 adds the following configuration and networking options for the access point:

• Edit Device ID
• View connected transmitters 
• View transmitter capacity

• Disable channel agility for 
troubleshooting

• Set IP Address Mode: DHCP or 
Manual

• Set IP Address: Edit in Manual 
Address Mode

• View and set subnet mask
• View MAC address

Tip: The text color of the Device ID for each trans-
mitter in the Connected list indicates Link Quality:

• Green = Excellent
• Yellow = Good
• Red = Marginal

Hovering the cursor over the Device ID 
displays Link Quality ranked from 5 to 1.
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Viewing 2.4 GHz Spectrum Activity using Wireless Workbench 6
The 2.4 GHz plot accessed by clicking on the ShowLink Plot toolbar option, allows you to see activity across all ShowLink 
channels. The plot shows activity by other devices on each of the 16 channels and the location of other access points 
within the spectrum. The ShowLink plot contains a live 2.4GHz measurement, as well as a 10-second moving average 
and maximum value over the scan duration. Run the ShowLink plot from any Access Point without any effect on the real-
time ShowLink network. Save the scans to files for future use or playback the data at any point in the time history of the 
record. By selecting an Access Point to perform the scan, you can see the 2.4 GHz spectrum density seen at that Access 
Point over time.

Reset Option
Pressing the reset button located on the bottom of the AXT610 housing restores the access point to the following settings:

• IP Address Mode = DHCP
• Channel Agility = Enabled
• Device ID = [AXT610]
• Device Association Tables will be cleared and re‐established with the receivers automatically
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Chapter 13 ‒ Audio Channels

Analog Audio Outputs
The XLR and 1/4" analog audio outputs are located on the 
rear panel of the AXT400 receiver. Refer to the AXT400 
user guide for specifications.
① Transformer balanced XLR audio output

For channel 1 and channel 2
Impedance: < 150 Ω

② Transformer balanced 1/4"  (TRS) audio output
For channel 1 and channel 2
Impedance: < 50 Ω

③ Line/Mic switch
The Mic setting is 30 dB less than the Line setting (XLR outputs only)

④ Ground lift switch
Lifts the ground from pin 1 of the XLR output and the sleeve of the 
1/4" output

Note: In Frequency Diversity mode, the combined audio from receiv-
ers 1 and 2 is routed to each of the analog output connectors.

The table below offers a comparison of the output gain at the XLR output for AXT400 and UR4 receivers for each Shure 
transmitter model. Use the information in the table to achieve consistent gain levels when using systems comprised of 
both Axient series and UR series components.

Transmitter AXT100 
Bodypack

AXT200 
Handheld

UR1 Bodypack UR1M Bodypack UR2 Handheld

gain = 0 dB gain = 0 dB gain = 0 dB gain = 0 dB gain = 0 dB
sens = 0 dB sens = 0 dB

Receiver AXT400 +10 dB gain +15 dB gain +15 dB gain +15 dB gain +15 dB gain
audio output 
level = 0 dB

UR4 N/A N/A +18 dB gain +18 dB gain +18 dB gain

System gain from transmitter input to receiver XLR output (line) when transmitter gain = 0 dB

The AXT400 receiver offers both analog and digital audio outputs. For analog output, each receiver channel has XLR and 
1/4" output connectors. An AES3 connector carries 24-bit digital audio for channels 1 and 2. Connection ports are avail-
able to sync the receiver with external word clock sources. Highly-linear frequency response and digital companding en-
sure the accuracy of the audio output signals.

System Gain
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AXT100 Bodypack Transmitter Audio Input Signal Flow

Transmitter Gain (dB) Preamp Gain (dB) VCA Gain (dB) Maximum Input (dBu)
-10 0 -10 +12.5
-9 -9
.. ..
-1 -1
0 0
+1 +1
.. ..
+9 +9
+10 +10 0 +2.5
+11 +1
.. ..
+19 +9
+20 +20 0 -7.5
+21 +1
.. ..
+29 +9
+30 +10
+31 +11
.. ..
+39 +19
+40 +20

Bodypack Transmitter Gain = Preamp Gain + VCA Gain 
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VCA

20 dB

10 dB

0 dB

Electronic Gain

To PLL
Preamp

High-Pass
FilterTransmitter

Input
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Filter

± 1 dB Adjustable  Gain
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Pre-emphasis



AXT200 Handheld Transmitter Audio Input Signal Flow

Transmitter Gain (dB) Preamp Gain (dB) VCA Gain (dB)
-10 0 -10
-9 -9
.. ..
-1 -1
0 0
+1 +1
.. ..
+11 +11
+12 +12 0
+13 +1
.. ..
+16 +4
+17 +5
+18 +6
.. ..
+31 +19
+32 +20

Handheld Transmitter Gain = Preamp Gain + VCA Gain 
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Perform an IR Sync to automatically tune and link the transmitter to a the receiver channel.

1. Select Tx from the receiver menu.

2. Align the transmitter and receiver IR ports. The red IR sync LED on the receiver IR port illuminates to indicate correct 
alignment. Press Sync.

3. The receiver display indicates if the IR sync is successful. Check 
transmitter alignment and select Retry if a failure occurs. The 
receiver passes an audio signal if successful.

If the transmitter is ShowLink ready, you will also briefly see a 
Devices Linked message on the display.

4. To link a second transmitter to the same receiver channel:

• RF Mute the second transmitter before linking to prevent 
interference

• Select Tx from the receiver menu
• Use the scroll wheel, highlight the 2: position under linked 

devices
• Align the second transmitter to the IR port and select Sync

Note: If you IR sync over a linked transmitter, the transmitter will be unlinked from the receiver and removed from the ShowLink network.

Setting up an Audio Channel using IR Sync
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Transmitter Overload Indicator
If the audio input of a transmitter experiences an overload, a warning message appears on the transmitter display and on 
the display of a linked receiver within range of an active ShowLink Access Point. Reduce transmitter gain and monitor the 
displays to ensure that the overload condition has been corrected.

Adjusting Transmitter Gain
When performing a soundcheck, adjust the transmitter gain so that the loudest sound from a microphone or instrument 
connected to the transmitter causes receiver audio meter LEDs to turn red at the peaks, indicating the best signal‐to‐noise 
ratio.

While speaking into the microphone or playing the instrument, use one of the following methods to adjust the transmitter 
gain:

• From the receiver Tx menu with ShowLink remote control
• From WWB6 with ShowLink remote control
• From the transmitter gain menu

Tip: See the Audio chapter for additional information about setting gain.

Audio Mute Concealment is a receiver feature that masks small gaps in audio that occur during frequency changes. The 
default setting for AMC is On.

From the receiver menu: Audio > AMC

1. Use the control wheel to set AMC to On or Off.

2. Press Enter to save changes.

Audio Mute Concealment (AMC)

   Vocal 1

634.225 MHz
             

Radio
Audio

Util
Tx

 From: G:  8  Ch:  40
  

Tx Overload!!
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Audio Overload Hold
The Audio Overload Hold feature captures and reports transient instances of audio overload to the re-
ceiver and to WWB6, without the need for constant monitoring of the audio meters.

If a channel experiences an overload, the red LED on the audio meter will remain illuminated until 
cleared. This feature is particularly useful in multiple channel systems to pinpoint a transmitter that 
needs gain reduced.

To enable the Audio Overload Hold:

1. Select the Audio menu option on the receiver.

2. Use the control wheel to set the Audio Overload Hold to On.

3. Press Enter to save.

To clear the hold indicator:

Press and hold the receiver enter button, and then press the Audio menu button for the affected 
channel. If using WWB6, left click on the audio meter in the properties panel or channel strip of the af-
fected channel.

audio
I I IIIIIII

I I

I I

Note: In Frequency Diversity mode, the hold function can be set from either channel of receiver and applies to both channels.

The AXT400 receiver analog outputs are adjustable from 
0 to -30 dB to match the required input levels of consoles 
and amplifiers.

From the receiver menu: Audio > Output

1. Use to the control wheel to set the audio level.

2. Press Enter to save changes.
Note: Mute the RF output by turning the control 
wheel past the -30 dB setting.

Adjusting Receiver Output
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Analog Output

Level: -3 dB (Line)

GND Lift: Grounded

Digital



Use the monitor jack located on the front panel of the receiver to monitor the audio output. The signal can be monitored 
at two points in the receiver audio chain. Use the Analog Output for normal listening or use Pre-Tonekey Squelch for 
troubleshooting. Use the monitor knob to adjust the level.

Monitoring Audio Output

Squelch
Squelch mutes the receiver output when transmitter signal is absent to prevent RF noise from entering the audio sig-
nal. Axient receivers use both "noise squelch" and tonekey squelch to ensure that only the correct transmitter signal is 
passed. Additional tonekey squelch options allow for the receiver to only pass signals from Axient transmitters or UR 
transmitters. 

Noise Squelch
Noise squelch uses an adjustable threshold 
to detect the transmitter RF signal. If the 
transmitter signal falls below the threshold, 
the receiver output will be muted.

The noise squelch setting can be used in 
noisy RF environments to prevent unwant-
ed signals from entering the audio signal.

To set the noise squelch from the receiver 
menu: Radio > Squelch

1. Use the control wheel to select and adjust 
the squelch level.

2. Press Enter to save changes.

Tonekey Squelch
Tonekey squelch uses a supra-audible tone generated by the transmitter 
and sent with the audio signal to control the squelch function. The receiver 
will mute the audio output if it does not detect the tonekey signal sent by 
the transmitter. The default tonekey squelch setting is Auto, which allows 
the receiver to pass signals from both Axient and UR transmitters.

Two additional tonekey settings can be applied to configure the receiver to 
only accept signals from Axient transmitters or UR transmitters. Applying 
these settings block stray transmitter signals from entering the audio 
stream.

• AXT Only: The receiver will only pass signals from Axient transmitters
• UR Only: The receiver will only pass signals from UR transmitters.

Note: Within the Squelch menu there is an option to turn off tonekey squelch detec-
tion. Use this option to troubleshoot stray signals in the RF environment. Be sure to 
turn the Tonekey Squelch On when finished troubleshooting.

Analog Output
The headphone source is the analog output of the receiver. If the receiver is set 
to Frequency Diversity, the output signal will consist of the combined audio from 
channel 1 and channel 2.

Pre-Tonekey Squelch
The headphone source is taken from a point in the signal path before processing 
by Squelch or Frequency Diversity. This mode is useful for isolating noise or in-
terference that may be occurring on one of the channels.

To select the headphone source from the receiver menu: Audio > Phones

1. Use the control wheel to select Analog Output or Pre-Tonekey Squelch

2. Press Enter to save changes.

3. Press the monitor volume knob to select the audio from channel 1 or channel 2.
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Tonekey: On (default)

           Headphone Source:

       Analog Output

           Headphone Source:

 Pre Tonekey Squelch



Note: In Frequency Diversity mode, the combined audio from receivers 1 and 2 is available at AES3 connector.

The AES3 digital audio output connector located on the rear panel of the AXT400 receiver supplies two channels of 24-bit 
digital audio.

 The digital connections offer the following features:

• Internal word clock with selectable sample rates of 48 kHz or 96 kHz (48 kHz default)
• Word clock connections for sync to external clock sources
• Compatible with standard shielded XLR cables (100 ohm, twisted pair)

① Word Clock Input
Connect to resolve the digital output to an external word clock source.

② Word Clock Thru Output
Passes word clock signal to additional components.

③ Word Clock Termination Switch
Set to thru when passing clock signal to additional components. Set to 75Ω when thru connec-
tion is not used.

④ AES3 Digital Audio Output
24-bit digital audio output for channels 1 and 2.

Digital Audio Output

85Chapter 13 - Audio Channels

1

2 3

AES3 output
in

word
clock

thru

Term 75Ω

4



When the using the receiver with other digital components, a word clock synchronizes the digital signals. The receiver's in-
ternal word clock syncs to other digital components at the Thru port on the rear panel. External word clock sources can be 
connected to the In port. The digital sample rate can be set to 48 kHz or 96 kHz. If the receiver is connected to an external 
clock, the sample rate will automatically match the source clock rate.

To manually set the sample rate: Audio > Output > Digital

1. Use the control wheel to set the sample rate to 48 kHz or 
96 kHz.

2. Press Enter to save.

Connecting an External Word Clock
Use the In port and Thru port to share the word clock signal with multiple components. Set the port switches as shown.

Example of multiple receivers sharing an external word clock signal:

To external word clock

Set Term switch to Thru

Word Clock 

Set Term switch to Thru

Set Term switch to 75Ω
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AXT400 Receiver Audio Wiring Diagrams
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AXT400 Receiver Audio Outputs
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Chapter 14 ‒ RF Range and Selectivity

Using the proper antenna type and placement can dramatically impact the usable range of any wireless microphone sys-
tem. For an overview of general antenna selection and placement, see the “Antenna Setup” (http://www.shure.com/idc/
groups/public/documents/webcontent/us_pro_antenna_setup_ea.pdf) educational publication on www.shure.com.

The following antennas are compatible with the Axient Wireless System.

1/2 Wave Antennas
470-530 MHz UA820G
518-578 MHz UA820H4
578-638 MHz UA820J
600-666 MHz UA820K
638-698 MHz UA820L3
694-758 MHz UA820M
740-814 MHz UA820Q
710-790 MHz UA820P8

Antennas
Passive Omnidirectional 
Antenna (470-1100 MHz)

UA860SWB

Passive Directional 
Antenna (470-952 MHz)

PA805SWB

PWS Helical Antenna 
(480-900 MHz)

HA-8089

Model Part Number Cap Color Frequency 
Range (MHz)

Bandwidth 
(MHz)

Center 
Frequency 
(MHz)

Length (mm/
in.)

AXT642-G 95A12544 Yellow 470-530 60 500 108/4.3
AXT642-H 95B12544 Gray 518-578 60 548 94/3.7
AXT642-J 95C12544 Black 578-698 120 638 75/3.0
AXT642-M 95D12544 Green 666-790 124 728 61/2.4
AXT642-Q 95E12544 Blue 740-865 125 803 50/2.0
AXT642-X 95F12544 Red 830-952 122 891 42/1.7

Antenna Type and Placement

AXT100 Bodypack Transmitter Antennas

In-Line RF Amplifiers
470-900 MHz UA830WB
470-698 MHz UA830USTV

Active Directional Antennas
470-698 MHz UA874US
470-790 MHz UA874E
470-900 MHz UA874WB
925-952 MHz UA874X

2.4 GHz Antennas
Omni-directional 2.4 
GHz Antenna

AXT643

Directional 2.4 GHz 
Patch Antenna

AXT644

Antenna Distribution Systems
Antenna Distribution 
System (470-698 MHz)

AXT630

Antenna Distribution 
System (606-814 MHz)

AXT631

Antenna Distribution 
System (470-787 MHz)

AXT632
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Axient Antenna Distribution Systems have an adjustable RF gain setting that ranges between ‐15 dB to +3 dB active on all 
antenna output ports and both channels equally. After selecting the antenna type, placement, and RF cable used to route 
the antennas to the Antenna Distribution System, it’s important to optimize the RF signal level going into the receivers for 
best signal‐to‐noise ratio.

In a small channel count setup, maximize the gain level at the antenna distribution system, but do not allow the receiver 
RF OL LEDs turn on when the transmitters are closest to the receiver antennas during operation. In a larger channel‐count 
setup, use multiple levels of antenna distribution systems to allow adjustment of the RF gain across groups of receivers 
as needed. Use the RF History Plot tool in Wireless Workbench for increased control and accuracy of RF gain adjustment 
and to refine antenna placement across the venue.

Antenna Distribution Gain Adjustment

RF Cables

For large venues and installations, selecting a low‐loss RF cable is important to the range performance of the Axient sys-
tem. Better quality RF cables have lower loss per foot; examples are RG8/X and RG213/U as indicated in the table below.

Type of Cable Loss @ 400 MHz (100 
ft.)

Loss @ 800 MHz (100 
ft.)

RG58A/U (Belden 8240) 8.4 dB 12.7 dB
RG58C/U (Belden 8262) 11.5 dB 18.5 dB
RG8X (Belden 9258) 6.6 dB 9.9 dB
RG8/U (Belden 8214) 3.9 dB 6.1 dB
RG213/U (Belden 8267) 4.1 dB 7.1 dB
Premium RG213 
(Belden 9913)

2.6 dB 3.9 dB

Shure offers several types of quality RF cables for long antenna runs as indicated in the table below:

Coaxial Cable RG8/X, 25-foot UA825
Coaxial Cable RG8/X, 50-foot UA850
Antenna Extension Cable 
RG213/U, 100-foot

UA8100
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Use RF History Plot tool to map the signal level received from the transmitter at any point in the venue and over time. 
Open the RF History Plot tool from Wireless Workbench, select the receiver channels you want to plot from the interface, 
and click start. Use this tool to see the signal level at each antenna as you walk the venue floor or perimeter and then use 
this information to adjust the RF gain and antenna placement if needed. Use the RF History Plot tool with the transmitter 
Off to see a time history of the channel background noise level.

RF History Plot
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The AXT400 Receiver has been specifically designed to provide superior RF channel spacing down to 250kHz while re-
jecting adjacent high‐power RF signals. In the receiver filter response plot below, the shape factor and selectivity of the 
receiver provides the ability to place more wireless microphones on the air in less spectrum.

Channel Spacing
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Chapter 15 ‒ Interference Detection and Avoidance 

The AXT400 receiver can detect narrowband and wideband interference from both analog and digital devices. 

Examples of devices that cause interference:
• Analog and Digital wireless 

microphones
• "White Spaces" devices 

• Intercom Systems
• In-ear Monitoring Systems
• Wideband FM modulation

• Digital TV signals (DTV)
• Analog TV signals

Dual Digital Signal Processors (DSP) in the receiver analyze the RF signal for signs of interference that can degrade 
the audio signal. When interference is present, the receiver screen turns red and displays one of the following warning 
messages:

Interference Alert
Displayed on the home screen when low-level interference is detected. 
Interference at this level may not be audible or may only cause a slight disruption 
to the audio signal. All receiver controls can still be accessed, and If the interfer-
ence is not audible, a frequency change may not be necessary.

If Interference Avoidance is set to Auto mode, a frequency change will not oc-
cur unless the strength of the interference increases to trigger an Interference 
Detected message.

Interference Detected
Displayed when high-level interference likely to disrupt the audio signal is detected. 
The menu screen displays on-screen options for changing to a clear frequency or 
if Interference Avoidance mode is set to Auto, the channel will automatically switch 
to a clear frequency deployed by the Spectrum Manager.

If the Interference clears without being addressed or if a frequency change is made 
by the Spectrum Manager, the LCD screen will return to its normal color. The de-
tection message indicating time elapsed since the interference occurred will remain 
on the screen for up to 60 minutes or until dismissed.

   Vocal 1

634.225 MHz
 Interference Alert

Radio
Audio

Util
Tx

From: G:  8  Ch:  40
TV:  41  OUT:  Mute

FDhh

 Vocal 1
           INTERFERENCE
           677.025 MHz

Manual

Ignore

Switch

!

In crowded RF environments, interference can come from anywhere. Other wireless microphones, intercoms, and a grow-
ing number of digital devices all have the potential to interfere with wireless audio channels. Interference from these de-
vices can strike without notice, compromising the audio signal and creating dropouts. 

To counter the threat of interference, Axient receivers are equipped with sensitive interference detection circuitry that give 
advance warning when interference is present. Adding a ShowLink™ Access Point and Spectrum Manager enable the fol-
lowing options for avoiding interference by switching to a clear frequency:

• Receiver, ShowLink Access Point, and Spectrum Manager: The Spectrum Manager automatically deploys a clear 
frequency to the transmitter and receiver. Interference Avoidance can be automatic, or manual for situations requiring 
precise timing.

• Receiver and ShowLink Access Point: Manual synchronized frequency changes between the transmitter and 
receiver.

• Receiver: manually switch both the transmitter and the receiver to a clear frequency

Types of Interference

Interference Detection
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The Avoidance mode determines how the receiver detects interference and which options are available to move to a clear 
frequency when interference occurs.

INTERFERENCE DETECTION

Avoidance: Detect Only

Sensitivity: Normal
Exclusion
Threshold > -85 dBm (default)

Tx Profile
Diversity

Detect Tx

The sensitivity setting allow you to vary the timing of warning messages to match the RF conditions and the need to avoid 
interference.

Normal
• Generates a message in response 

to low levels of interference well 
below the audibility threshold

• Provides more time to react to 
messages

• Interference Detection is 
suppressed when received signal 
strength is below the Exclusion 
threshold

More Sensitive
• Generates a message in response 

to moderate levels of interference 
below the audibility threshold

• Provides more time to react to 
messages

• Interference Detection can trigger 
at low received signal levels, 
regardless of the Exclusion 
threshold setting

Less Sensitive
• Detects interference at a level just 

below the audibility threshold
• Fewer detection messages
• Less time to react to messages
• Interference Detection is 

suppressed when received signal 
strength is below the Exclusion 
threshold

On-Screen Frequency Change Options
When Avoidance mode is set to Prompt, the following on-screen options are available when interference is detected:

• Switch: Deploys a clear backup frequency from the Spectrum Manager when selected
• Manual: Accesses the frequency menu to make a frequency change using the control wheel
• Ignore: Suppresses the interference warning message

Detection Sensitivity

Interference Avoidance Modes

Off
The receiver will not detect interference or dis-
play warning messages. Protection from inter-
ference will not be available.

Detect Only
The receiver will detect interference and display 
warning messages, but options for frequency 
change will not be presented.

Prompt
The receiver will detect interference and display warning mes-
sages. Options for deploying a frequency from the Spectrum 
Manager, setting the frequency manually, or ignoring the inter-
ference are available.

Auto
A clear frequency will automatically be deployed from the 
Spectrum Manager when interference is detected.

Configuring Avoidance Mode and Sensitivity
Configure Avoidance mode and Sensitivity to match the RF conditions and the 
need to avoid interference.

1. From the receiver menu: Radio > Options

2. Use the control wheel to set values for Avoidance and Sensitivity.

3. Press Enter to save changes.

Important: You must set the Interference Avoidance Mode and Sensitivity for EACH receiver 
channel independently!
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The options available for moving to a clear frequency depend on the components in the system.

The following options are available for each group of components:

AXT400 Receiver, AXT600 Spectrum Manager, AXT610 ShowLink Access Point
• Auto: The receiver will automatically switch to a clear frequency deployed by the Spectrum Manager
• Prompt: Selecting the Prompt option from the menu deploys a frequency from the Spectrum Manager
• Detect Only: Select Detect Only to enter a new frequency using the control wheel
• Off: Interference will not be detected

AXT400 Receiver and AXT610 ShowLink Access Point
• Detect Only: Synchronized frequency changes can be made from the transmitter menu or the receiver menu
• Off: Interference will not be detected

AXT400 Receiver
• Detect Only: Frequency changes must be made manually for the receiver and the transmitter
• Off: Interference will not be detected

LeadVox
          Unexpected Transmitter

          677.025 MHz
       Signal received from AXT100-1 Ignore

!

Interference Avoidance

Preventing Interference from Unexpected Transmitters

Interference will occur if two transmitters are active on the same frequency. To 
prevent interference, the receiver has a transmitter detection feature to ensure 
that the received signal matches the device ID of the linked transmitter. If the 
Device ID of the received signal does not match the ID of the linked transmitter, 
an Unexpected Transmitter alert is displayed.

An alert will be issued if unexpected signals are detected from the following transmitter types:

• Axient transmitters (unlinked)
• Axient transmitters (linked to a different receiver)
• Shure UR series transmitters
• Shure MW series transmitters

The alert displays the following information about the unexpected transmitter signal:

• Channel Name
• Frequency
• Device ID (for Axient transmitters) or transmitter type ( for UR or MW transmitters)

To enable Transmitter Detection: 

1. From the receiver menu: Radio > Options > Detect Tx

2. Use the control wheel to select Yes to detect transmitter or select No to disable detection.
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Frequencies used by in-ear monitoring devices (IEMs) can present an additional source of interference. If an IEM signal is 
detected, the receiver will display one of the following warnings:

Note: If the receiver Avoidance mode is set to Auto, the receiver will automatically switch to a clear frequency if IEM interference is detected.

Detecting Interference from In-Ear Monitoring Devices

IEM Signal Detected (Detect Only Mode)
Displayed if the receiver Avoidance mode is set to 
Detect Only.

IEM Signal Detected (Prompt Mode)
Displayed if the receiver Avoidance mode is set to Prompt.

   Vocal 1
634.225 MHz

 IEM Signal Detected

Radio
Audio

Util
Tx

From: G:  8  Ch:  40
TV:  41  OUT:  Mute

FDhh  Vocal 1
           IEM Signal Detected
           at 677.025 MHz

Manual

Ignore

Switch

!

Manually switch to a clear frequency. Choose the Switch or Manual menu options to 
select a clear frequency or choose Ignore to dis-
miss the warning.
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Chapter 16 ‒ Frequency Diversity

The following transmitter configurations can be used for Frequency Diversity:

Two AXT100 Bodypack 
Transmitters with Lavalier 
Microphones
Use two lavalier microphones for 
Frequency Diversity.

Two AXT100 Bodypack 
Transmitters with AXT652 
Y-Cable
Use the Shure AXT652 Y-cable ac-
cessory to split the signal from instru-
ments, microphones, or headsets to 
2 AXT100 bodypack transmitters for 
Frequency Diversity.

AXT200 Handheld Transmitter
The AXT200 Handheld Transmitter 
provides two independent signals for 
Frequency Diversity.

Use the following tips to maximize the performance of Frequency Diversity:

• Use a minimum of 300 KHz spacing between 
frequencies 

• Use the same make and model of lavalier microphones
• Place two lavalier mics next to each other, as close as 

possible.

• Use the bodypack calibration function in the AXT400 
receiver to equalize the audio levels between 
microphones when using two bodypacks

Frequency Diversity enables seamless, uninterrupted audio for mission-critical applications. Frequency Diversity works by 
transmitting the audio on two independent frequencies from an AXT200 Frequency Diversity handheld transmitter or from 
two AXT100 bodypack transmitters.

When operated in Frequency Diversity mode, the AXT400 receiver uses the best combination of the two frequencies to 
provide a single channel of audio. If one frequency experiences interference, the audio from the other frequency is used 
to prevent dropouts or interruption of the audio. 

Using Frequency Diversity in conjunction with Interference Detection and Avoidance provides an additional layer of pro-
tection for the audio signal. 

Transmitter Options for Frequency Diversity

Best Practices for Frequency Diversity
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From the receiver menu: Radio > Options > Diversity

1. Use the control wheel to select FD-Handheld mode.

2. Press Enter to save.

From the receiver menu: Radio > Options > Diversity

1. Use the control wheel to select FD-Bodypack mode.

2. Press Enter to save.

FD-Bodypack Mode
Configures the receiver for Frequency Diversity operation 
with two AXT100 bodypack transmitters.

The AXT400 receiver has selectable Handheld and Bodypack modes to optimize Frequency Diversity performance when 
using each transmitter type. 

FD-Handheld Mode
Configures the receiver for Frequency Diversity operation 
with an AXT200 handheld transmitter.

Receiver Audio Output
When in frequency diversity mode, the receiver automatically routes the good audio signal to BOTH channels of the re-
ceiver outputs. The receiver will also make both channel names to be the same when in frequency diversity mode.

Setting Frequency Diversity Mode

Note: Set Diversity mode to Off to use the receiver for two separate audio channels.

Note: The handheld mode icon appears on the receiver 
screen to indicate the mode setting.

Note: The bodypack mode icon appears on the receiver 
screen to indicate the mode setting. The Active Bodypack 
Indicator appears below the icon of the channel supplying 
the audio source. On
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FD-Bodypack

Optimized for use with 2 bodypacks

Frequency Diversity:
FD-Handheld

Optimized for use with Frequency Diversity Handheld
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XLR

TRS

XLR

TRS

Digital
Audio Frequency 1

Audio Frequency 2

DSP

AXT400 
Receiver

Receiver 1

Receiver 2
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Linking a Diversity Handheld Transmitter
Link the transmitter and the receiver to set up a Frequency Diversity 
audio channel.

1. Set the receiver to FD-Handheld mode: Radio > Options > 
Diversity

2. From the receiver menu select: Tx

3. Align the transmitter with the IR port on the front panel. The red IR 
sync LED on the receiver IR port will illuminate to indicate correct 
alignment. Press Sync.

4. The display indicates if the IR sync is successful. Check transmitter 
alignment and select Retry if a failure occurs. The receiver passes 
an audio signal if successful.

Note: For ShowLink remote control of an AXT200 handheld transmitter, use the Tx menu for either receiver channel.

When the AXT200 handheld transmitter is linked to a receiver in Frequency Diversity mode, the handheld transmitter 
will emit two RF carriers simultaneously which transmit the same audio signal over both carriers.

The handheld transmitter has been designed to have extremely low RF intermodulation while transmitting two carriers at 
once.

An example showing the conducted spectrum of a 
handheld transmitter in frequency diversity mode.
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Link a bodypack transmitter to each channel of the receiver to set up a Frequency Diversity audio channel.

To Link transmitter 1
1. Set the receiver to FD-Bodypack mode: Radio > 

Options > Diversity

2. From the receiver menu for Channel 1: Tx

To Link Transmitter 2
1. From the receiver menu for Channel 2: Tx

2. Align transmitter 2 with the IR port on the front panel. The 
red IR sync LED on the receiver IR port will illuminate to 
indicate correct alignment. Press Sync.

3. Align transmitter 1 with the IR port on the front panel. The 
red IR sync LED on the receiver IR port will illuminate to 
indicate correct alignment. Press Sync.

4. The display indicates if the IR sync is successful. Check 
transmitter alignment and select Retry if a failure occurs. 
The receiver passes an audio signal if successful.

3. The display indicates if the IR sync is successful. Check 
transmitter alignment and select Retry if a failure occurs. 
The receiver passes an audio signal if successful.

Channel 2 menu

Transmitter 2

Note: For ShowLink remote control, use the Tx menu for the receiver 
channel linked to the transmitter.

Channel 1 menu

Linking Two Bodypack Transmitters

For optimal performance, the audio levels between 2 AXT100 bodypack transmitters must be set within 1 dB when used 
for Frequency Diversity. The AXT400 receiver has a bodypack calibration mode that graphically compares the audio levels 
between the bodypacks, allowing for precise calibration.

If the bodypacks are enabled with ShowLink remote control, real-time adjustments can be made from the calibration 
screen. Otherwise, make adjustments using the bodypack controls.

Note: An uninterrupted audio source (voice, instrument, or tone generator) is necessary for calibration. The arrow indicator appears on the display 
when a sufficient level of audio signal is present.

1. When the calibration screen appears, use the menu buttons to select Tx1 or 
Tx2. An arrow will appear on the screen to indicate the relative audio level dif-
ference between the two transmitters.

2. Use the control wheel to adjust the gain of the selected transmitter to move 
the arrow indicator towards the 0 dB level. Gain information for the transmitter 
appears below the gain scale.

3. When the gain adjustment has moved the arrow within 1 dB, the screen mes-
sage will indicate Levels Calibrated.

4. Press the Exit button to end the calibration function.

To access the calibration function from the receiver menu: Radio > Options > Diversity > Calibrate

Bodypack Frequency Diversity Calibration

Transmitter 1
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Frequency Diversity and Interference Detection and Avoidance
You can combine Frequency Diversity and Interference Detection and Avoidance together for further mitigation of interfer-
ence. As described in the prior chapter, turn on and adjust the Interference Detection and Avoidance mode and sensitivity 
before configuring the receiver for Frequency Diversity operation.

From the receiver front panel, press and hold the Enter button, and then press Radio menu button to select the audio 
from the unaffected channel. To indicate that the channel has been selected, the color of the FD-Bodypack mode icon 
will invert.

To return to Frequency Diversity mode, press and hold the Enter button, and then press the Radio menu button for the 
selected channel.

An option is available to selectively lock the Frequency Diversity audio source to a single transmitter in the event of a 
problem developing with one of the bodypack transmitters. When locked, the audio from the selected transmitter will be 
routed to both outputs of the receiver.

Locking the Diversity Source a Single Bodypack Channel

Tip: Use the Active Bodypack Indicator on the receiver display screen to determine which channel is supplying the diversity audio signal.

WWB6 Option for Locking the Diversity Source
If using WWB6, the Diversity source can be locked to a single bodypack transmitter from receiver Monitor tab. 

Note: The green dot indicates the transmitter that is the current audio source.

1. Open the Monitor tab in WWB and select the receiver channel. 

2. Click on Properties to show all receiver settings.

3. Under FD Audio Source, click on "Lock to" to select an Rx channel for the 
audio source. 

To restore Frequency Diversity Switching, click on the Auto Switch option.
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Chapter 17 ‒ Frequency Coordination and Spectrum Management

RF coordination and spectrum management finds the best parts of the spectrum for setting up a wireless audio system. 
The AXT600 Spectrum Manager offers on-board scanning of the UHF spectrum to find all clear and compatible frequen-
cies for wireless audio channels.

The Spectrum Manager analyzes and compiles all frequencies into a compatible frequency list (CFL) for deployment over 
the network to components. Additional backup frequencies are maintained by the Spectrum Manager for deployment to 
receivers in the event of interference. Backup frequencies are constantly monitored and ranked by the Spectrum Manager 
to assess their quality.

Additional tools are available within the Spectrum Manager to monitor the RF spectrum: 

• The scan function displays the RF activity within the spectrum
• Zoom and Cursor functions provide detailed information for individual frequencies
• The Listen feature offers FM demodulated audio for a selected frequency
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The AXT600 Spectrum Manager is a unique, 8-band, parallel-processed receiver with three selectable detector bandwidths 
and an FM-demodulated audio headphone output for quick monitoring.

Functions
The Spectrum Manager is capable of executing one of four distinct, but independent functions at any time:

It is very important to remember that the functions of the Spectrum Manager operate independently of each other and only 
one function can be operated at a time. For example, if you are using the Spectrum Manager as a continuous scanning 
receiver with Wireless Workbench, the backup frequency monitoring process is not operating. Similarly, if you’re using the 
audio listen monitoring, the backup frequency monitoring process is not operating.
Frequency Scanning and Display
The frequency scanning and display function gathers frequency data as input to the frequency calculator inside the 
Spectrum Manager. After the scan is completed, you can view the RF frequency data from the front panel LCD interface 
and use the control wheel to zoom into areas of interest. You can also save the scan data into internal memory for later 
recall from Wireless Workbench. This function can also be accessed from WWB6, offering additional options for setting 
scanning range, step size, and bandwidth resolution.
Frequency Calculation and Deployment
The Spectrum Manager uses the scanned frequency data to calculate a compatible frequency list (CFL). Using its on-
board calculation engine, the Spectrum Manager runs several thousand iterations to find the maximum and optimal set of 
frequencies, including backup frequencies. The calculator will run until the number of new frequencies found per second 
goes below a preset threshold. User-defined exclusions prevent restricted frequencies from being included in the CFL. 
Once the CFL calculation is complete, the frequencies are deployed to devices on the network.
Backup Frequency Monitoring
After frequency deployment, the Spectrum Manager continuously monitors all backup frequencies. The energy level of 
each frequency within the CFL is checked against the threshold. Frequencies with energy levels exceeding the threshold 
are given a status of Degraded and will not be deployed to receivers. Once a frequency is Degraded, it must measure 
below the threshold for more than 30 seconds before it can be upgraded to Ready status and re-included into the list of 
assignable frequencies within the CFL.
Audio Listen Monitoring
Audio listen monitoring allows you to tune the Spectrum Manager to any frequency and monitor the FM-demodulated au-
dio at the monitor output. While Listen mode is active, you will see a real-time RF signal strength display on the left side of 
the LCD in addition to the selected frequency and antenna.

Frequency scan-
ning and display

Frequency cal-
culation and 
deployment

Backup frequen-
cy monitoring

Audio 
listen 
monitoring

AXT600 Spectrum Manager Design

Note: The audio listen circuit is designed to emulate the Axient receiver Audio Reference Companding expander.
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RF Scanning: Design and Resolution
The design of the Spectrum Manager supports wideband frequency scanning over the UHF band. Eight parallel receivers 
and three selectable detector bandwidth options (1MHz, 200kHz, 25kHz) available in Wireless Workbench enable very 
fast frequency scanning in just a few seconds. If used without Wireless Workbench, the Spectrum Manager selects the 
200kHz bandwidth (RBW) filter to closely emulate the receiver filter response.

Below is an example of a RF plot of the spectrum illustrating the 1MHz, 200kHz, and 25kHz filter bandwidths. The 1MHz 
scan provides faster scan times at a lower resolution, while the 25kHz scan increases resolution by 25 dB allowing you to 
zoom in on a section of frequencies with increased dynamic range.

When performing a frequency plot in Wireless Workbench, the eight independent parallel receivers inside the Spectrum 
Manager divide up the UHF frequency range into eight sections for faster scanning. Multi-band scanning is also available 
from the menu of the Spectrum Manager as described in a later section of this chapter.
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Use the following guidelines to ensure accurate RF coordination and maximize the number of frequencies available.

• Place the antennas in the position where they will be used for the event
• Configure RF connections for all equipment
• Set up the Ethernet network for all components
• Set up and configure the ShowLink™ Network
• Set frequency bands for receivers
• Set Device IDs for networked components
• Turn off or RF mute all transmitters linked to receivers

The following abbreviations identify channel types and transmitter profiles in the Spectrum Manager menu:

AXT: Axient transmitters

AXT/URT: UHF-R transmitters used with an Axient receiver

AXT/MWTx: MW transmitters (Japan and Korea) used with Axient receivers

MW: MW channels (Japan and Korea)

PSM: PSM 1000 channels

UHF-R: UHF-R channels

ULX-D: ULX-D channels

ULX-D/HD: ULX-D/HD channels

Before Starting an RF Coordination

Channel Types and Transmitter Profiles

Important! If using ULX-D receivers configured in High Density mode, set the Spectrum Manager Exclusion Threshold to -90 dB to maximize avail-
able channels.
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Advanced Frequency Management: Custom User Groups and 
Inclusions Groups

Wireless Workbench contains advanced frequency coordination tools in the form of User Groups and Inclusions Groups 
to manage situations requiring the precise allocation of frequencies. Wireless Workbench can be configured to avoid fre-
quency ranges reserved for public safety, government bodies, or other spectrum users.

User Groups
User Groups create subsets of frequencies and frequency 
ranges that define the usable spectrum for all channels and 
backup frequencies. A common application of User Groups 
is to avoid frequencies restricted by regulatory constraints. 
Coordination results calculated with User Groups conform 
to the User Group’s permitted frequencies and can be de-
ployed by Wireless Workbench and the Spectrum Manager 
to networked components.

Wireless Workbench and the Spectrum Manager are pre-
configured with User Groups that correspond to regional 
regulatory constraints. For added flexibility, Custom User 
Groups can be defined in Wireless Workbench containing 
individual frequencies or frequency ranges. Up to 8 Custom 
User Groups can be loaded into the Spectrum Manager.

When a User Group is selected, the Spectrum Manager will 
only use frequencies from that group to calculate the CFL, 
eliminating the risk of interference with frequencies outside 
the specified User Group.

User Groups can contain the following:

• Individual Frequencies
• Frequency Ranges

When to use a User Group:

• Coordinate frequencies for all channels within 
regulatory constraints

• Avoid frequencies reserved for other user or public 
agencies

• Limit subset of frequencies allowed by calculator (in 
WWB or Spectrum Manager)

Inclusions Groups
Inclusions Groups are used to assign specific frequen-
cies or frequency ranges to specific channels and backup 
frequencies. Inclusions Groups can be applied to compo-
nents on a channel-by-channel basis.

A common use for Inclusions Groups is to divide and re-
serve sections of the spectrum for specific types of com-
ponents such as microphones or in-ear monitor systems. 
Inclusions Groups can also be used to set the priority in 
which channels receive frequencies from the calculator.

To manage portions of the spectrum, multiple Inclusions 
Groups containing specific frequencies can be added with-
in an Inclusions List in Wireless Workbench. Selecting and 
applying an Inclusions List allows its Inclusions Groups 
to be available for assigning to channels and for backup 
frequencies.

When an Inclusions Group is assigned to a channel, the 
frequency calculator will only select from frequencies de-
fined within that group for that channel, ensuring control of 
frequency allocation.

Inclusions Groups can contain the following:

• Individual Frequencies
• Frequency Ranges

When to use Inclusions Groups:

• Allocate and prioritize spectrum for use by specific 
channels and backup frequencies

• Separate wireless components spectrally (i.e. 
microphones and in-ear monitor systems)

Tip: See the Wireless Workbench Help for detailed configuration topics for User Groups and Inclusions Groups.

Note: User Groups and Inclusions Groups can be used simultaneously or individually within a system setup. When used simultaneously, configure 
the User Groups first, and then set up the Inclusions Groups.

Caution: Inclusions Groups are not currently supported by the 
Spectrum Manager. In order to resolve RF interference for a chan-
nel assigned to an Inclusions Group, backup frequencies must be 
deployed from Wireless Workbench instead of using automatic deploy-
ment from the Spectrum Manager.

Tip: See the Wireless Workbench Help System for more information 
on Interference Resolution when using Inclusions Groups.
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RF Coordination Wizard
The Spectrum Manager includes a wizard to provide guided device and frequency configuration. Choose one of the fol-
lowing set up task options:

Update Freqs
Refreshes the frequencies for an 
existing wireless system.

• Scans the RF spectrum for 
available frequencies

• Calculates the compatible 
frequency list (CFL) to match 
the needs of the networked 
devices

• Deploys frequencies to the 
managed devices

Update Devices
For adding new devices to an 
existing setup.

• Finds devices on the network 
to manage

• Deploys frequencies from 
the existing compatible 
frequency list (CFL) to the 
managed devices

All New
For initial RF coordination.

• Finds receivers and other 
devices on the network to 
manage

• Scans the RF spectrum for 
available frequencies

• Calculates a compatible 
frequency list (CFL) to match 
the needs of the networked 
devices

• Deploys frequencies to the 
managed devices

All New Wizard Option for System Set up
The following example shows the steps for initial RF coordination using the All New wizard option.

1. From the home menu screen 
choose Wizard and select the 
All New option.

2. The Found Channels screen 
displays the number of chan-
nels per series and frequency 
bands. Press Next.

3. Press the control wheel to 
place a checkmark in the 
box next to the Device ID. 
Use the control wheel to se-
lect other devices or press 
Add All. Press Flash to 
identify a specific device in 
the list. Press Next when 
finished.

4. Mute all transmitters. 
Press Next.

5. Allow the scan to com-
plete. Press Next. 

6. Allow the CFL calcula-
tion to complete.

7. Press Deploy to assign 
frequencies to the net-
work devices.

The RF plot is displayed 
in the data window. 
Press Next.

Choose
Setup
Task

All New

Update Freqs
Update Devices

Power off or RF Mute all
transmitters that will
receive frequencies
from this coordination

Next

Deploy
Pause

Edit
Exit

27 compatible frequencies

Found 27
frequencies

Select devices to control
 [AXT400]   -AXT400

 [AXT400]   -AXT400

 [AXT400]   -AXT400

Next
Clear

Add All
Flash

Found: 6 Channels
AXT J5   (6)

Next
Refresh

ExitAntenna A

Scanning
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Update Freqs Wizard Option
The following example shows the steps for updating frequencies for networked components by using the Update Freqs 
option.

Update Devices Wizard Option
The following example shows the steps for updating devices controlled by the Spectrum Manager by using the 
Update Devices option.

1. From the home menu screen 
choose Wizard and select the 
Update Devices option

2. The Found Channels screen 
displays the number of chan-
nels per series and frequency 
bands. Press Next.

3. Press the control wheel 
to place a checkmark in 
the box next to the device 
ID. Use the control wheel 
to select other devices or 
press Add All. Press Flash 
to identify a specific device 
in the list.

4. Press Deploy to assign 
frequencies to the network 
devices.

1. From the home menu screen 
choose Wizard and select the 
Update Freqs option.

2. Mute all transmitters. Press 
Next.

3. Allow the scan to complete. 
Press Next.

4. Allow the CFL calculation to 
complete.

5. Press Deploy to assign 
frequencies to the network 
devices.

Choose
Setup
Task

All New

Update Freqs
Update Devices

Deploy

Exit

55 frequencies

Devices 

Controlled:

4

AXT-G1: 55

Select devices to control
 [AXT400]   -AXT400

 [AXT400]   -AXT400

 [AXT400]   -AXT400

Next
Clear

Add All
Flash

Found: 6 Channels
AXT J5   (6)

Next
Refresh

Choose
Setup
Task

All New

Update Freqs
Update Devices

Power off or RF Mute all
transmitters that will
receive frequencies
from this coordination

Next

Deploy
Pause

Edit
Exit

27 compatible frequencies

Found 27
frequencies

ExitAntenna A

Scanning
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Entering Exclusions

1. From the Spectrum Manager menu: CFL > New > Exclusions

2. Select the Add option.

3. Use the control wheel to highlight TV, Start, or Stop:

• To exclude a range of frequencies, use the Start and Stop values to define 
the frequency range

• To exclude a single frequency, set the values for the Start frequency and 
the Stop frequency to the same value

• To exclude a TV channel, use the control wheel to set the channel number
4. When finished, press ENTER to save changes.

Most RF environments contain frequencies where it is not desirable to operate wireless equipment, such as those re-
served for local broadcasts, public safety, or other users. Exclusions prevent the Spectrum Manager from including these 
frequencies when calculating a compatible frequency list.

In this example, TV channel 32, the range 
of 599.00 to 604.000 MHz, and 650.000 
MHz will be excluded from the compatible 
frequency calculation.

Create a new compatible frequency using the CFL menu in the Spectrum 
Manager.

From the Spectrum Manager menu: CFL > New

1. Choose one of the following menu options:

• Start = creates a new CFL from current scan data
• Exclusions = enter and edit exclusions. When finished, select Start option 

to create CFL
• Scan First = refreshes scan data. When scan is complete, select Start 

option to create CFL
2. Select Deploy when CFL calculation is complete.

Exclusions 

Creating a New Compatible Frequency List

Exclusions  Format
Add

Clear
Clear All

Exclusions  (TV=6 MHz)
 TV 32 (578.000-584.00 MHz)

 599.000-604.000 MHz

 650.000 MHz

Format
Add

Clear
Clear All

▲

▼

Calculate New
Compatible
Frequency List from
Current Scan Data

Start
Exclusions

Scan First
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Use the Edit menu option to edit the CFL. From the Spectrum Manager menu: CFL > Edit

① Frequency/Total
Displays the currently selected frequency and the total 
number of frequencies in the CFL. Use the control 
wheel to scroll and select a frequency.

② Frequency Value:
Selected frequency value in MHz

③ Channel Type
Corresponds to the type of device using the frequency

④ Frequency Status
Current status of frequency

⑤ Signal Strength
Selected frequency strength in dBm

⑥ CFL Editing Menu
Add, delete, or edit CFL frequencies

• Add: Select to add a frequency to the CFL. Duplicate 
frequencies are not allowed. Added frequencies will 
automatically be analyzed for compatibility.

• Del: Select to remove a frequency from the CFL.
• Listen: Use the control wheel to select a frequency for 

audio monitoring.
• Edit: Edit the value of an existing frequency or edit the 

frequency type.

The Analyze function verifies that all frequencies in the CFL are compatible.

From the Spectrum Manager menu: CFL > More > Analyze

When completed, the display shows the results as compatible or not compatible.

The CFL can be manually deployed to networked components from the Spectrum Manager.

From the Spectrum Manager menu: CFL > Deploy

The frequencies are sent to all controlled devices.

Editing a Compatible Frequency List

Analyzing a Frequency List for Compatibility

Deploying a Compatible Frequency List

Note: An Unable to Analyze message is displayed for non-networked frequencies.

Advanced CFL Editing using WWB6
For advanced CFL editing, WWB6 provides a comprehensive overview of  the CFL from the properties panel of the 
Spectrum Manager. By taking advantage of the computer screen and keyboard input, WWB6 is the best tool for detailed 
editing of  the CFL.

4/55       478.750 MHz
Type: AXT
Sts: Ready  (-102 dBm)

Add
Del

Listen
Edit

1 2

3

4 5

6
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Backup Frequency Monitoring
During operation, the data screen tracks the status of frequencies available 
for Axient channels in the system. The total number of frequencies available 
for each band are displayed, including real-time status of in-use and backup 
frequencies. Backup frequencies which have been degraded by the monitoring 
function are removed from the count of Ready frequencies.

Listen
Use this feature to monitor the FM demodulated signal at a selected frequency.

From the Spectrum Manager menu: Manual > Listen

• Use the control wheel to select the frequency and antenna for monitoring.
• The data display shows the signal strength of the selected frequency.
• The menu display shows the selected frequency and antenna.
• The Listen feature can also be accessed from the CFL > Edit menu, allowing easy 

cueing of frequencies that are in use or backups.

Caution: Use lower volume levels to prevent 
hearing damage.

Spectrum Monitoring
The Spectrum Manager provides tools for examining, tracking, and troubleshooting the RF spectrum. 

In Use
Assigned to a wireless audio channel.
Ready
Ready for deployment to an Axient channel.
Degraded
Does not meet quality requirements for deployment. 
May be upgraded if cleared by frequency monitoring.
Reserved (offline)
Assigned by WWB to an offline device and unavailable 
for assignment to other devices. Reserved frequencies 
can be deployed when the device comes online.

Monitored for WWB
A backup frequency monitored by the Spectrum Manager 
through WWB. The frequency can only be deployed 
manually.
In Use by Non-networked Devices
Frequencies selected in WWB for use by devices that 
are not connected to the network. These frequencies will 
be included in a CFL calculation, but must be manually 
tuned for each device.

Axient Frequency Monitoring

Band
In Use
Ready

More

5       10      5        7
12      4     6      10

G1    H4    J5    L3

Signal Strength
-20 dBM

-40 dBM

-60 dBM

-80 dBM

-100 dBM

-120 dBM

626.350 MHz

Band: J Ant: A
push

clip

on

o�

Monitor

navigate navigate control monitor power

clip

push

on

o�         

push

enter

exit

AXT600
470-952 MHz

Spectrum Manager
AxientTM Wireless
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From the Spectrum Manager menu: Manual > Scan

1. Set the following modes:

• Sweep = Single or Continuous
• Peak Hold = Off or ON
• Exclusion Threshold = The Spectrum Manager excludes scanned frequencies above this 

value from the Compatible Frequency List calculation. The threshold can be viewed during 
edit on the Scan Data display.

Note: Set the Exclusion Threshold to -90 dB when using ULX-D receivers in High Density mode

2. Press Start to begin scanning. Scan progress is displayed while the scan is in-progress. When 
finished, press Store to save the scan. Select Recall to access a stored scan. The recalled 
scan will overwrite the current scan data. Unsaved scan data will be cleared if the Spectrum 
Manager is turned off.

Cursor
Zoom

Peak
Listen

-20

-40

-60

-80

-100

dBm

470.000 Mhz 952.000 Mhz

Cursor
Zoom

Peak
Listen

-20

-40

-60

-80

-100

dBm

470.000 Mhz 952.000 Mhz

Cursor
Zoom

Peak
Listen

-20

-40

-60

-80

-100

dBm

470.000 Mhz 952.000 Mhz

Cursor adds a movable vertical 
dashed line on the RF plot. Use 
the control wheel to position the 
Cursor.

The frequency value and signal 
strength at the cursor are dis-
played on the top of the plot.

Zoom magnifies RF plot at 
the cursor to allow for detailed 
analysis.

Use Zoom to identify individual 
frequencies in crowded RF 
environments.

The cursor to only selects the 
highest peaks of the RF plot.

Peak provides a quick way to 
identify the strongest signals in 
the RF plot.

Cursor Tool Zoom Tool Peak Tool

Sweep: Single
Peak Hold: Off
Exclusion

Threshold

Start

Recall
Store

-85 dB

-20

-40

-60

-80

-100

dBm

470.000 Mhz 952.000 Mhz

The RF plot is shown 
on the Data Display 
screen.

Event Log
The event log records the actions of the Spectrum Manager and other devices it manages, as listed below. The log stores 
up to 150 events. The start of an event record is indicated with an asterisk (*). The most recent events appear at the top of 
the log. Use the control wheel to scroll through the list of events. When the storage limit is reached, the oldest events are 
overwritten. 

Note: A power cycle or firmware update will clear the event log.

Frequencies:

• Backup frequency 
degraded

• Backup frequency 
upgraded

• Frequency served to 
[channel name]

• Scan Stored

Managed Devices:

• [Device ID] goes off-line
• [Device ID] comes on-line
• [Device ID] removed
• [Device ID] added
• Transmitter [Tx] profile 

changed

Compatible Frequency List 
(CFL):

• CFL cleared
• New frequency added
• Frequency deleted
• Frequency value changed
• Frequency type changed
• CFL deployed
• New CFL calculated

Exclusions:

• Exclusion threshold 
changed

• Exclusion added 
(frequency or range)

• Exclusion cleared 
(frequency or range)

Scanning
Performing a spectrum scan creates a plot of RF activity on the data display. Use the Cursor, Zoom, and Peak tools to 
examine a specific area of the plot. The Store option allows for one complete set of scan data to be saved to the memory 
of the Spectrum Manager for reference or for CFL calculation. Scans initiated from the Spectrum Manager menu cover the 
entire tuning range. The Frequency Plot tool in Wireless Workbench can be used to scan a subset of this range and pro-
vides options for step size and resolution bandwidth.
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Chapter 18 ‒ RF and Audio Troubleshooting

The job of a communications system is to transfer a signal, or message, from one location to another. Most communica-
tion systems contain a sender and a receiver, and may have multiple paths, or hops, between the sender and receiver. 
When the signal, or message, doesn’t make it all the way from the sender to the receiver, that typically means some part 
of the communications link is either malfunctioning or not set up correctly. In these cases, we need to troubleshoot where 
and what the problem is and then we can decide how to fix it to get the signal through to the receiver.

A good troubleshooting method is to always start at the end of a communications chain (at the receiver) and work back 
toward the beginning (the sender). This method is useful for all RF, audio, and network communications systems; all of 
which are used in the Axient Wireless Microphone System. Since the problem you’re trying to solve typically is due to the 
message not making it to, or out of, the receiver, the one thing you always know for sure is that what’s supposed to be at 
the receiver isn’t there. So you want to start with that single fact in looking for where the signal is (or is stuck at) and then 
work backward to determine why it’s not there or is stuck somewhere in the middle.

When you’re working with communication systems that have multiple layers to them, and can include multiple technolo-
gies within the layers, you should want to have an understanding of how the layers are structured before trying to trouble-
shoot the suspected problem area. Once you know how they are structured, you can then identify the parts that make up 
the communications link. Then after you have an inventory of all the parts, you can ask ‘what could go wrong with each 
part’, and start to identify where the problem exists.

To eliminate problems caused by configuration errors, make sure you have completed the following set up tasks before 
starting to troubleshoot:

• Place antennas and configure RF connections including antenna distribution systems
• Assign device IDs to all components
• Place AXT610 access points for ShowLink network
• Configure Ethernet connections, ensuring all devices are on the same subnet
• Assign valid IP addresses to all networked components using DHCP or manual addressing
• Configure audio connections
• All components have been updated to the same firmware version (with the exception of the AXT620 Ethernet switch)
• If using WWB6, connect a computer configured to allow WWB6 traffic to the network
• Load transmitters with fully charged batteries
• Create and deploy a compatible frequency list to receivers
• Link transmitters and receivers using IR sync

The Axient Troubleshooting Method

Before Starting to Troubleshoot
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Use this checklist as a first step when troubleshooting the Axient system. If the system fails a test, refer to the related 
troubleshooting section appearing in brackets at the end of the step.

To begin testing, turn on all devices and perform each test in the following order:

☐ Verify transmitters are linked to receivers [ShowLink]
Required for ShowLink remote control

☐ Check all firmware on each device [Upgrading Device Firmware]
Firmware versions of all devices must match for the first two digits (X.Y.z)

☐ Run FIND ALL from the Spectrum Manager (or receiver) [Networking]
Verifies basic network configuration is correct

☐  Verify RF and audio operation including antenna distribution system frequency band and receiver band [RF, 
Audio]
Verifies antennas, frequency band match on transmitter and receiver

☐ Run the ShowLink test from the receiver [ShowLink, Networking]
Verifies the signal strength and coverage area of the ShowLink network

☐ Adjust transmitter from receiver using Tx > Adjust [ShowLink, Networking]
Adjust gain, RF power, RF mute

☐  If the Spectrum Manager has a CFL, change frequency of the transmitter from the receiver using NewFreq 
while monitoring the audio [ShowLink, Networking]
Verifies CFL is in place, backup frequency deployment to the receiver, and frequency update at the transmitter via the 
ShowLink network.

☐ If the Spectrum doesn’t have a CFL, run the wizard and deploy frequencies [see RF Coordination Chapter] 
Verifies Spectrum Manger functions to create and deploy the CFL

☐ Startup WWB and discover devices in inventory [WWB6]
Verifies WWB computer-to-rack connections

☐ Go to monitor view and select all receivers [WWB6]
Verifies real-time RF and audio information to WWB

☐ Select frequency list in toolbar [WWB6]
Verifies WWB is getting the CFL from the Spectrum Manager

Basic Diagnostic Checklist
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Let’s start with an example of an Axient system identifying the RF links and audio links:

① Microphone
② Transmitter (sender)
③ Transmitter antenna
④ Electromagnetic waves (RF and Audio)
⑤ Receiving antenna
⑥ RF cables

⑦ Antenna distribution amplifier
⑧ Receiver 1
⑨ Receiver 2 (receiver)
⑩ Spectrum Manager
⑪ Audio output cables Receiver 1
⑫ Audio output cables Receiver 2

To start troubleshooting why the signal from the transmitter is not making it to the receiver, we’ll use our backwards meth-
od and start at the receiver itself.

In our example, we have two receivers set to two different frequencies and the bottom receiver (2) is the one we’ve identi-
fied as the receiver for the sender of the signal. We’ll assume the system is properly set up and configured for use so we 
won’t cover all the set up steps here, but will check a few critical ones that could cause an RF or Audio problem.

RF and Audio Troubleshooting

RF Link

Audio Link

Transmitter (sender)

Antenna Distribution Amplifier

Spectrum Manager

Receiver 1

Receiver 2
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Step 1 (Receiver 2)
The usual indicator of an RF problem is the RF LEDs on the receiver are not on. If the RF LEDs on the receiver are all on, 
that usually means the RF link is working.

Check that the receiver 2 is plugged in, and the power switch(s) are ON
The Axient products have two power switches, an AC mains switch on the rear of the unit and a standby switch on the 
front.

Check the frequency and band of the receiver against the frequency of the transmitter
Check that the selectable frequency Band setting for the receiver matches the fixed frequency band of the transmitter. If 
the Band settings match, make sure that both the receiver and the transmitter are set to the same exact frequency.

Check the noise squelch and tone key settings of the receiver
The default squelch setting for the receiver is 0 and the default setting for the tonekey is ON; these are good starting 
points for most applications. 

Step 2 (RF Cables)
Check the RF cable connections to the receiver 2
The input cables should be securely plugged into the top BNC input jacks; they should NOT be plugged into either the 
bottom BNC cascade jacks or the AES3 word clock jacks.

Check the RF cable connectors
Unplug the cables from both ends and inspect the connector and center pins to ensure they are not missing or damaged.

Check the RF cable connections to the receiver 1
The cables should be securely plugged into the bottom BNC cascade jacks; they should NOT be plugged into either the 
top BNC input jacks nor the AES3 word clock jacks.

If all of the above steps are completed with no problems found, proceed to Step 3.

Note: If you’re using the transmitter a long distance from the receiver, lower the squelch control to -8 to -10 for extra range.

Check the ‘link’ icon and channel name on the receiver against the transmitter
The link icon will appear next to the channel name on the receiver LCD and the transmitter and receiver display the same 
channel name.

Check the Device IDs in the Receiver 'Linked Devices' List
Select Tx from the receiver menu to view the Devices IDs of linked transmitters.

Check the ‘RF MUTE’ control in the receiver Tx > Adjust menu; should be set to ‘UNMUTE’ if ShowLink is present
The transmitter may be RF MUTED via the ShowLink network; press to UNMUTE the transmitter if it’s MUTED.

If all of the above steps are completed with no problems found, proceed to Step 2.
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Step 3 (Receiver 1)
Check that the receiver 1 is plugged in, and that both power switches are ON
The RF cascade ports will not pass the RF signal if the receiver 1 is off.

Check the frequency band of receiver 1
It should match the frequency band of receiver 2 since you’re using the RF cascade port to feed the receiver 2. 

Step 4 (RF Cables)
Check the RF cable connections to the receiver 1
The input cables should be securely plugged into the top BNC input jacks; they should NOT be plugged into either the 
bottom BNC cascade jacks or the AES3 word clock jacks.

Check the RF cable connectors
Unplug the cables from both ends and inspect the connector and center pins to ensure they are not missing or damaged.

Check the RF cable connections to the antenna distribution amplifier
The cables should be securely plugged into the RF output BNC jacks. Ensure both RF cables are plugged into both chan-
nel A and channel B RF BNC jacks from the antenna distribution amplifier.

If all of the above steps are completed with no problems found, proceed to Step 5.

Step 5 (Antenna Distribution Amplifier)
Check that the antenna distribution amplifier is plugged in, and that both power switches are ON
The Axient products have two power switches, an AC mains switch on the rear of the unit and a standby switch on the 
front. The RF cascade ports will not pass the RF signal if the antenna distribution amplifier is off.

Check the frequency band of the antenna distribution amplifier
The frequency band of the distribution amplifier must either be set to ‘WIDEBAND’ or the frequency band of the micro-
phone receiver.

Check the RF cascade setting (if the receiver is connected to the cascade output)
Make sure that the RF cascade setting is Auto or On.

Check the RF Gain setting
The RF Gain may be set too low. The default setting for the RF gain is 0 dB.

Note: If you’re using the transmitter a long distance from the receiver, adjust the RF Gain control for optimal RF LED levels on the receiver.

If all of the above steps are completed with no problems found, proceed to Step 6.

Note: The linking, channel name, or ShowLink settings of receiver 1 have no effect on the RF cascade output.

If all of the above steps are completed with no problems found, proceed to Step 4.
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Step 7 (Receiver Antenna)
Check the antenna for proper mounting height and location
The receiver antennas should be located at least six feet above ground level, away from reflective objects, and at least six 
feet apart from other antennas.

If all of the above steps are completed with no problems found, proceed to Step 8.

Step 6 (RF Cables)
Check the RF cable connections to the antenna distribution amplifier
The cables should be securely plugged into the top BNC input jacks; they should NOT be plugged into either of the bot-
tom BNC cascade jacks or into the Channel A/B RF outputs.

Check the RF cable connectors
Unplug the cables from both ends and inspect the connector and center pins to ensure they are not missing or damaged.

Check the RF cable connections to the antenna
The cables should be securely plugged into the antenna BNC jacks.

If all of the above steps are completed with no problems found, proceed to Step 7.

Step 8 (Electromagnetic Waves)
Check the path between the transmitter and receiver antenna
Ideally, you should have a visible line-of-sight path between both transmitter and receiver.

It’s also possible there is something else transmitting on the same frequency as your transmitter. Refer to the chapter on 
Interference and Detection for details on the settings for this feature.

If all of the above steps are completed with no problems found, proceed to Step 9.

Step 9 (Transmitter Antenna)
Check the antenna for damage
Inspect the antenna connector to ensure the center pin is not damaged or missing and that the antenna is securely con-
nected to the transmitter antenna jack.

If all of the above steps are completed with no problems found, proceed to Step 10.
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Step 10 (Transmitter)
Check the transmitter power and battery
Ensure the transmitter is powered on and the battery is charged and properly seated in the transmitter.

Check the RF MUTE setting
If the transmitter is RF MUTED, the LCD display will alternately flash ‘RF Muted’ and the set frequency.

Check the frequency of the transmitter against the receiver
The transmitter and receiver frequencies as well as the frequency band must exactly match.

Check the audio gain setting
The transmitter audio gain has up to 50dB of adjustable gain. Adjust the gain level up while monitoring the LCD display 
until it reads ‘Input Overload’ for very loud input signals into the microphone.

If all of the above steps are completed with no problems found, proceed to Step 11.

Step 11 (Microphone)
Inspect the microphone connector to ensure the center pins are not damaged, bent or missing. Inspect the cable to en-
sure there are no slices, tears or frayed shields.

If all of the above steps are completed with no problems found, proceed to Step 12.

Step 12 Receiver Audio cables
The usual indicator of an audio problem is the audio LEDs on the receiver are not on or the audio LEDs on the mixing 
console are not on. If the audio LEDs on the receiver are all on, that usually means the audio and RF link are working.

Check the audio cable connections out of the receiver
The audio cable should either be securely plugged into the XLR or ¼” output for analog and the AES3 for digital audio 
output. 

Caution: The same connector type (XLR) is used for both the XLR analog out and the AES3 digital out. Check to see that the audio cable is con-
nected to the right jack for your application and into the proper receiver channel (A or B).

If all of the above steps are completed with no problems found, proceed to Step 13.
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Check the audio output control and MUTE settings
Examine the audio output and MUTE settings on the LCD display receiver home screen. If the audio output indicates 
‘MUTE’, you can unmute it from the ‘Audio->Output’ menu.

Use the receiver headphone monitor to check the audio signal
You can use the headphone monitor in the receiver to audition the audio signal the receiver. Note, you can select where 
the headphone monitor listens to the audio signal as either pre or post tonekey squelch.

Step 13 Receiver Audio Settings
In addition to checking all the other areas outlined in Step 1 of the RF troubleshooting chapter, you should also check the 
following audio areas.

Check the MIC/LINE switch setting on the rear panel of the receiver
The MIC/LINE switch changes the audio output level of the XLR output by 30 dB. If you have a low audio signal and the 
switch is set to MIC, try switching it to LINE.

Tip: The state of the MIC/LINE switch can be monitored from the front panel LCD display or at the rear panel switch.

At this point in the troubleshooting, if you have not found anything wrong with the setup, it’s possible that either the trans-
mitter or receiver is malfunctioning. You can use the AXT600 Spectrum Manager (or a spectrum analyzer) to help deter-
mine if the problem is with the transmitter or receiver. 

With the Spectrum Manager connected to the RF cascade ports on the antenna distribution amplifier, use the LISTEN 
function on the Spectrum Manager and tune it to the frequency of the transmitter. You should see a real-time signal 
strength indication of the transmitter RF signal. You can also use the headphone monitor to audition the transmitter audio 
signal. If both the RF and audio signals are found to be normal, then it’s possible that the receiver is malfunctioning. If you 
don’t see any RF signal strength or don’t hear any audio using the LISTEN function, then it’s possible the transmitter is 
malfunctioning. 

The final step in troubleshooting RF problems, is to use a spare transmitter and receiver and replace them one at a time 
until the problem component is identified. You can also do the same with known good RF cables and by connecting the 
receiver antenna directly into the receiver to bypass the antenna distribution amplifier.

Further Investigation
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RF Troubleshooting Table
Use the following table as quick reference to troubleshoot common RF problems

Symptom Possible Cause Solution
RF LEDs not lit on receiver AC power switch OFF for rack device 

suppling RF signal
Check Power switches

Transmitter set to RF Mute Unmute RF output
Objects in path between transmitter 
and receiver

Ensure that there is a visible line-of-
sight path between transmitter and 
receiver

Incorrect Squelch setting Adjust Squelch, lower squelch for ex-
tra range

Band Mismatch between transmitter 
and receiver

Verify that receiver band is set to 
match the transmitter band

Frequency mismatch between trans-
mitter and receiver

Verify that transmitter and receiver are 
set to the same exact frequency

RF cable or Connector problem Check RF cables and connectors
If an AXT630 is part of the system
Incorrect band filter setting on AXT630 
Antenna Distribution Amplifier

Band setting must match connected 
equipment or be set to Wideband

Check AXT630 RF cascade setting Set RF cascade to On or Auto
AXT630 RF gain too low Increase RF gain setting on AXT630

Audio Troubleshooting Table
Use the following table as quick reference to troubleshoot common audio problems

Symptom Possible Cause Solution
No Audio Output to mixing console Receiver Output set to Mute Unmute receiver output

Audio cable damaged Check audio cables and connectors
Audio cable plugged into incorrect out-
put jack

Check output connections (XLR, TRS, 
AES3, Receiver 1, Receiver 2) to 
match application

Audio Output from receiver too low Receiver Output level set too low Increase Receiver output level
Line/Mic switch set incorrectly Check switch settings to match 

application
Transmitter gain set too low Increase transmitter gain

No Audio LEDs on receiver Transmitter gain set too low Increase transmitter gain for optimal 
Peak setting

Microphone problem Check mic head for handheld trans-
mitters or mic cable for bodypack 
transmitters, substitute known good 
component
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Chapter 19 ‒ Network and ShowLink Troubleshooting

The most typical network problems are related to one or more devices not being discovered, or ‘seen’, on the network by 
other devices. One indication that this problem exists is the lack of the network icon on the receiver LCD display. It’s im-
portant to note, that when the network icon is displayed, it is simply an indication that two Axient products can ‘see’ each 
other on the network, it does NOT indicate other network problems. There are cases where you can have 10 receivers on 
the network and they all have network icons on the LCD displays, but there are still two or more that could not be ‘seen’ 
by the remaining receivers. 

For example, this case could happen if eight receivers had proper IP addresses from the DHCP server (192.168.1.x ad-
dresses), but the remaining two receivers were connected to each other but not to the rest of the network. In this case, 
the other two receivers will fall back to a private 169.254.x.x address and therefore ‘see’ each other, which will cause their 
network icons to be on. To overcome the limitation of the network icon, we have included a new network tool in the Axient 
products called ‘FIND ALL’. We’ll discuss this tool and its use in more detail in the following steps.

We’ll start with an example network topology that does not have a computer connected but does have a DCHP address 
server on the network. We’ll cover the topologies with a computer connected in the chapter on Wireless Workbench 
troubleshooting.

Ethernet Connection

AXT620 with front panel 
DHCP switch set to ON

AXT610 ShowLink 
Access Point

AXT620 with front panel 
DHCP switch set to OFF

Receivers Receivers
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Step 1 (Receivers)
For this example, we’ll start at the receivers for our troubleshooting method.

Check that the receivers are plugged in, and that both power switches are ON
The Axient products have two power switches, an AC mains switch on the rear of the unit and a standby switch on the 
front.

Check the FIND ALL status at the receiver
The FIND ALL function from the Util > Network > Find All menu will query any other Axient devices on the network 
and ask for their model number and address properties. The FIND ALL function from the receiver will see other receiv-
ers, ShowLink access points, transmitters (via the ShowLink network), antenna distribution amplifiers, P10T receivers, 
and chargers. The FIND ALL function will not see the AXT620 Ethernet switch. UR4 receivers will not appear unless the 
Find All feature is accessed from a networked AXT600 Spectrum Manager. The FIND ALL device count should match the 
number of devices listed above that are connected to the network. If the FIND ALL function returns the correct number of 
devices, it’s likely the network is set up and functioning properly.

Check network address settings
The default network address settings for Axient devices are IP address mode = AUTOMATIC (get address from DHCP 
server). Assuming a DHCP address server is present and operating on the network, these are the proper IP address set-
tings for the receiver. Typically, when using a DHCP server on the network, the receiver address mode should NOT be set 
to MANUAL.

Check the network port LEDs
The LEDs on the network jack should normally be on and one of them blinking if a physical connection exists from the 
receiver to the Ethernet switch 2. If the LEDs are not on, ensure the network cable is securely plugged into the jack. It 
doesn’t matter which network jack the cable is plugged into (upper or lower).

If all of the above steps are completed with no problems found, proceed to Step 2.

Step 2 (Receiver Cables)
Check the network cable
If the LEDs are not on at the network jack, check the cable connector for damage to the pins or broken or frayed connec-
tions on the cable. Ensure the cable is securely plugged into both the receiver and the Ethernet switch 2. Try a replace-
ment cable if you suspect a problem with the cable. 

If all of the above steps are completed with no problems found, proceed to Step 3.

Step 3 (Ethernet switch 2)
Check that the Ethernet switch is plugged in
There is no power switch on the Ethernet switch. When the unit is powered on the LED on the front panel will be on.

Check that the DHCP switch on Ethernet switch 2 is OFF
In this example the Ethernet switch 2 is being used to expand the physical network and not as a DHCP server. If two 
DHCP servers are active on the same physical network, problems will occur with the IP addresses and other functions of 
the receivers.

Note: If the DHCP switch is ON at Ethernet switch 2, switch it to the OFF position, AC power off ALL units on the network and restart the DHCP 
server first, and then the rest of the devices.

If all of the above steps are completed with no problems found, proceed to Step 4.
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Step 4 (Ethernet Switch 2 Cables)
Check the network cable
If the LEDs are not on at the network jack, check the cable connector for damage to the pins or broken or frayed connec-
tions on the cable. Ensure the cable is securely plugged into both the Ethernet switch 2 and Ethernet switch 1. Try a re-
placement cable if you suspect a problem with the cable. 

If all of the above steps are completed with no problems found, proceed to Step 5.

Step 5 (Ethernet switch 1)
Check that the Ethernet switch is plugged in
There is no power switch on the Ethernet switch. When the unit is powered on the LED on the front panel will be on.

Check that the DHCP switch on Ethernet switch 1 is ON
If the DHCP switch is off at Ethernet switch 1, switch it to the ON position, AC power off ALL units on the network and re-
start the DHCP server first, and then the rest of the devices.

Step 6 (ShowLink Network Troubleshooting)
The typical symptom of ShowLink problems is that the Tx > Adjust menu does not appear on the receiver menu that 
you’re trying to adjust the transmitter from. So before we get to the troubleshooting details, let’s review the requirements 
to enable remote control.

Requirements for transmitter remote control over the ShowLink network:

1. Have the following Axient components at a minimum and configured for networked operation: AXT100 or AXT200, 
AXT400, AXT610.

2. The AXT610 Access Point must be on the same Ethernet network as the AXT400 Receiver.

3. The AXT100 or AXT200 must be IR synced (and linked) to the receiver.

4. Have the AXT100 or AXT200 within the range of the AXT610 Access Point

Check the link status on the receiver
The most likely problems with not being able to remote control a transmitter from the receiver is that either they are not 
linked together via an IR sync or the ShowLink access point is not on the network.

When a transmitter is linked to a receiver, the link icon (insert link icon graphic) will appear next to the channel name on 
the receiver. The channel name on the receiver and transmitter will also match. The transmitter MUST be linked to the re-
ceiver via the IR sync in order for remote control of the transmitter to be available.

Note: We're covering this example that does not have a computer connected. It’s possible that if the Ethernet switch DHCP server was configured 
incorrectly prior to deploying, it will not function properly and neither will the receivers. (If a computer is available, you would connect it to the DHCP 
server and log into the DHCP server to verify the settings; we’ll cover this in the Wireless Workbench Troubleshooting chapter). 

If you are unsure about the DHCP server settings, you can do a factory reset (with the DHCP switch ON) by pressing the 
reset switch on the rear panel for more than 5 seconds until all the LEDs light on the switch. You should also power cycle 
all other products after you do this factory reset on the DHCP server. This will reset the DHCP server to a default IP ad-
dress of 192.168.1.1. Once the DHCP server is rebooted as well as the other receivers, you can do a FIND ALL from the 
receiver to verify it sees the proper number of devices.
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Note: It’s possible to have the channel names of the transmitter and receiver match, but not have the two devices linked. If you link a transmitter and 
receiver via the IR sync, they will be linked. If you then turn the transmitter off and link a second transmitter to the receiver over the original link in slot 
1, the receiver will unlink the first transmitter from the ShowLink network, but the channel name of the first transmitter will not change once it’s pow-
ered back on. In this case you’ll have two transmitters with the same channel name but only one will be linked to the receiver (the link icon will indicate 
this on the receiver). Therefore, it’s good practice, when in doubt or when troubleshooting ShowLink problems, to re-link the transmitter and receiver 
via the IR sync function on the receiver.

Check if the receiver can ‘see’ the ShowLink Access Point with FIND ALL
The network cable to the ShowLink access point must be securely plugged into a Power-Over- Ethernet (PoE) jack to 
power the access point (unless an external DC power supply is used). The power and network LEDs on the ShowLink ac-
cess point should be on and the network LED should be blinking. Both the AXT400 receiver and AXT620 Ethernet switch 
provide PoE network jacks to power the access point. Both network jacks on the AXT400 receiver provide PoE, and 
number 5-8 network jacks on the AXT620 Ethernet switch also provide PoE. The AXT600 Spectrum Manager and Axient 
Antenna Distribution Systems also provide PoE network power. The AXT900 Rack Charger does NOT provide PoE net-
work power.

Check the network cable to the ShowLink Access Point
The network cable to the ShowLink access point must be securely plugged into a Power-Over- Ethernet (PoE) jack to 
power the access point (unless an external DC power supply is used). The power and network LEDs on the ShowLink ac-
cess point should be on and the network LED should be blinking. Both the AXT400 receiver and AXT620 Ethernet switch 
provide PoE network jacks to power the access point. Both network jacks on the AXT400 receiver provide PoE, and 
number 5-8 network jacks on the AXT620 Ethernet switch also provide PoE. The AXT600 Spectrum Manager and Axient 
Antenna Distribution Systems also provide PoE network power. The AXT900 Rack Charger does NOT provide PoE net-
work power.

Check the IP address mode of the ShowLink Access Point
If the cable connections to the ShowLink access point are good, but the receiver cannot ‘see’ the access point using the 
FIND ALL function, it’s possible the access point is configured for an IP address that’s not on the same IP subnet as the 
receiver. You can do a factory reset of the ShowLink access point to ensure the IP mode is set to AUTOMATIC that will 
request an IP address from the DHCP server that’s on the same subnet as the receiver. Press and hold the recessed 
Reset button at the bottom of the access point for several seconds until all the LEDs turn on and then let go. The access 
point will return to a factory default setting of IP mode = AUTOMATIC. After the access point reboots, wait a few seconds 
and retry the FIND ALL function from the receiver. If the receiver can now ‘see’ the ShowLink access point, then the trans-
mitter that’s linked to the receiver should now be remote controllable via the ShowLink network.

Check the ShowLink antenna and connection
Ensure that the antenna is securely connected to the SMA jack of the ShowLink access point and that there is a good 
line-of-sight path to the transmitter. Inspect the antenna connector for a damaged or missing center pin.
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Network Troubleshooting Table
Use the following table as a quick reference to troubleshoot common network problems.

Symptom Possible Cause Solution
Device not discovered on network Damaged Ethernet connection or 

missing
Check Ethernet cables and connection, 
LEDs at Ethernet port

Invalid IP address Assign valid IP address using DHCP 
server or manually

Device Subnet setting does not 
match

Verify component is on the same subnet

Incorrect Ethernet switch DHCP 
configuration

Make sure only one Ethernet switch has 
the DHCP switch set to ON

Network Icon does not appear on 
LCD of rack components

Ethernet connection missing between 
other network devices

Check Ethernet connections and cables 
between devices

AXT620 Ethernet Switch does not 
appear on network

Incorrect IP setting or IP setting 
changed from default 

Use packet analysis software to discover 
address or use reset function

ShowLink Network Troubleshooting Table
Use the following table as a quick reference to troubleshoot common ShowLink network problems.

Symptom Possible Cause Solution
Tx Adjust option does not appear 
on receiver LCD or ShowLink icon 
is not displayed

Transmitter not ON Verify transmitter is turned ON
AXT610 ShowLink ac-
cess point not ON

Check power status LEDs and Power connection 
(PoE or external)

Transmitter is beyond 
ShowLink coverage 
range

Make sure there is a good line-of-sight path between 
the transmitter and access point. Reposition access 
point or use additional access points to increase cov-
erage area

Transmitter and receiver 
not linked

Check for link icon and matching channel names, re-
link transmitter and receiver

AXT610 ShowLink 
access point not 
networked

Check network status LED, use Find All to verify net-
work connection

AXT610 antenna dis-
connected or damaged

Make sure antenna connection is secure and center 
pin is not damaged or missing

AXT610 ShowLink Access Point 
not on network

Incorrect IP address or 
subnet setting

Use reset to set IP address mode to Automatic or as-
sign a valid IP address with WWB6
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Discovering the IP Address of an AXT620 Ethernet Switch

 If you cannot connect to the switch at the default IP address (192.168.1.1), it’s likely the switch is set to another IP ad-
dress. You can always use the reset button to restore the default IP address; however, your user-defined settings will be 
lost. As an alternative, it’s recommended to use a downloadable Ethernet packet analyzer program such as Wireshark® 
(www.wireshark.org) to identify the IP address of the switch. Packet analyzer software acts as an interface allowing you to 
view the IP address embedded in the Link-Layer Discovery Protocol (LLDP) messages sent by the switch.

Before running an analysis, do the following:

• Download and install Wireshark on your computer
• Set the AXT620 DHCP switch to ON
• Power on the AXT620
• Connect your computer (configured for DHCP IP addressing) to the AXT620 with a wired Ethernet connection

1

Note: Only test one AXT620 at a time.

Steps

➊ Select the wired Ethernet Interface and Wireshark will begin to capture Ethernet packets
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2

➋ Allow Wireshark to run for at least one minute, and then stop the packet capture
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➌ In the filter box, type “lldp”
➍ Click Apply
➎ Select one of the LLDP packets

4
5

3
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6

7

8

➏ Expand the “Link Layer Discovery Protocol” line
➐ Expand the “Management Address” line
➑ The IP address of the AXT620 is displayed in the “Management Address” line
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Troubleshooting
This chapter on Wireless Workbench connectivity troubleshooting builds on the networking and ShowLink troubleshooting 
sections. We’ll use the example in the network section and add a computer to the setup. The most typical symptom of 
Wireless Workbench connectivity problems is that the devices don’t show up in the Inventory Manager, or they were once 
in the Inventory Manager but are now offline (and grayed-out). This problem is often due to a configuration problem in the 
computer-to-network setup.

Ethernet Connection

AXT620 with front panel 
switch set to ON

AXT610 ShowLink 
Access Point

AXT20 with front 
panel switch set to 
OFF

AXT20 with front 
panel switch set 
to OFF

131Chapter 20 ‒ Wireless Workbench 6 Connectivity Troubleshooting

ON OFF
DHCP

ON OFF
DHCP

ON OFF
DHCP

AXT610
Axient W

ireless
Showlink Acces Point



Step 1. (Wireless Workbench)
Check Wireless Workbench network configuration
The first step in troubleshooting Wireless Workbench connectivity is to check which network connection it’s using. There 
are often several network connections on a computer such as a wired Ethernet, wireless Ethernet (Wi-Fi), VPN, wireless 
3G/4G, and USB-to-Ethernet. Wireless Workbench is designed to only use one network interface at a time. You can check 
which one it’s set up to use by looking at the network connection in the ‘Tools > Preferences > Network’ panel.

Important: If you have configured your computer for both wired and wireless networking, the two IP addresses must be on separate subnets for WWB 
to work properly. The wired and wireless adapters on the computer should not be "bridged".

Example:
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Wireless IP = 172.12.55.14
Subnet = 255.255.255.0

Wired IP = 192.168.1.10
Subnet = 255.255.0.0

Internet Axient Network



Step 2. (Computer)
Check the computer-to-network IP connectivity.
If Wireless Workbench is configured to use the proper network interface, then the next step is to check the connectivity 
from the computer to the network. The simple way to check connectivity from the computer to the network is to use the 
‘PING’ command on the computer. Find an IP address on one of the devices on the Axient network such as an AXT400 
Receiver (192.168.1.10 for example). Open a command window if you’re using a Microsoft Operating System, or a 
terminal window if you’re using a MacOS, and type the command ‘ping 192.168.1.10’. If the ping is successful (no packet 
loss), then that means the computer is connected to the network and can see it.

If the ping is not successful (100% packet loss, or the request times out), then the computer cannot see the network. 
You should then check the IP configuration of the computer by checking the network connection status. You can also 
check the IP address from the command window by typing ‘ipconfig’ on Windows or ‘ifconfig’ on MacOS. The computer 
IP address should be on the same subnet as the Axient network. For example, if the Axient network is addressed from 
192.168.1.20-25, then the computer address must be in the range of 192.168.1.1 to 192.168.1.254 (assuming the subnet 
masks of both the computer and the Axient network are all set to 255.255.255.0). If there is a DHCP server active on the 
network, then the computer should be configured to get an IP address automatically from the server.

Tip: Refer to the Networking chapter for detailed infomation about firewall configuration.

Note: Some DHCP servers can be configured to leave a set of addresses for manual IP assignment. In this case, you can configure the computer to a 
fixed, manual IP address, but only if you’ve verified that address is not in the DHCP server address field of addresses it will hand out to new devices. 
For example, by default, the AXT620 Ethernet switch DHCP server address field is set to 192.168.1.10-192.168.1.254. The address range from 
192.168.1.2-192.168.1.9 can be used for fixed IP addresses (192.168.1.1 is reserved for the DHCP server address).

Check the computer firewall and virus protection settings.
Once the IP settings are verified to be correct, the next areas to check are firewall and virus protection settings. All firewall 
or virus protection programs must be configured to allow communication from the following Wireless Workbench programs 
through to the network:

• wwb6.exe
• slpd.exe
• snetdameon.exe
• shurefirmwareupgrader.exe
• snetconfigexe.exe

Note: The "ping" command can succeed even if the virus or firewall settings aren't configured correctly.
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Step 3. (DHCP server)
If the computer is configured to automatically get an IP address from the DHCP server, you can verify this by checking the 
DHCP client table on the AXT620 Ethernet switch.

Check the DHCP server configuration.
Log into the AXT620 Ethernet switch by opening a web browser and navigating to the DHCP server address by typing 
its IP address (default = 192.168.1.1) into the URL window. Select the ‘System’ from the main menu, then ‘DHCP server’ 
option, and finally the ‘System Configuration’ from the middle menu.

The DHCP server switch should be ON and the IP address fields should be set to the above values (as default). If you do 
not see this configuration and want to restore the factory default, you can select the ‘Factory Default’ option from the main 
menu.

 Note: If you factory reset the DHCP server, you should also power cycle the all other devices on the network after the DHCP server reboots.
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Check the DHCP client table.
Select ‘DHCP server’ from the main menu and then ‘Client Entries’ from the middle menu.

The DHCP client table should include the computer IP address as well as the IP addresses of all the devices on the 
network. If you do not see the IP address of your computer in the client table, check the DHCP server switch on the front 
panel to ensure it is set to ON. 

Note: You may need to power cycle the DHCP server and computer if the switch was set to OFF and you subsequently turned it to ON.

135Chapter 20 ‒ Wireless Workbench 6 Connectivity Troubleshooting



Upgrading Wireless Workbench 6
Software and Axient Firmware  

Chapter 21 ‒ Upgrading Wireless Workbench 6 Software ..............................................................................137

Chapter 22 ‒ Upgrading Axient Component Firmware ....................................................................................138

Part

5



Update the Wireless Workbench Software and Databases

2. If a new version of Wireless Workbench is listed, select it in the list and select Download.

Result: The installer file is downloaded and a download summary is displayed.

3. To install the new version, find the download location (typically found in the Documents/Shure directory) and select the 
Wireless Workbench installer file.

Result: The installer installs a new version of Wireless Workbench, and updates all databases.

Chapter 21 ‒ Upgrading Wireless Workbench 6 Software

In the Internet Updates option, you can check for and download the latest version of the Wireless Workbench® software.

Tip: In the Preferences option, you can set your download preferences to automatically check for new versions.

Steps
1. From the Tools menu, select Internet Updates.

Result: The Internet Update window displays a list of available software and firmware updates in the Internet Update 
window.
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The Internet Updates option will find the latest versions of firmware, and the Firmware Update Manager option will find all 
available versions of firmware. You can download the updates to your computer, and then deploy them to the devices. To 
deploy updates to devices, the devices must be live on the network.

Tip: In the Preferences option, you can set your preferences to automatically check for new firmware versions.

You can download firmware updates for rack devices (Axient™ and PSM®1000) and for portable devices from within the 
Wireless Workbench 6.

Chapter 22 ‒ Upgrading Axient Component Firmware

Device Firmware Updates

Firmware Versioning

As Axient is a set of networkable products, it is important to maintain compatible firmware levels on all products to ensure 
proper operation. The firmware of all Axient devices (with the exception of the AXT620 Ethernet Switch) has the form of 
MAJOR.MINOR.PATCH (e.g., 1.6.2).

Important: At a minimum, all Axient devices on the network (including transmitters), should have the same MAJOR and MINOR version numbers 
(e.g., 1.6.x). You can use the Firmware Update Manager included in Wireless Workbench 6 to update all Axient devices (except AXT620).

Major Minor Patch
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Rack-Hosted Updates for Portable Devices
Updates for portable devices are downloaded are stored on Axient and PSM1000 rack devices. When you download up-
dates to rack devices, you can also select whether to download updates for portable devices.

Portable devices are upgraded by aligning the IR Sync port with the IR Sync Port of the rack device and selecting Tx > 
IR Presets > FW Update > Download. Maintain alignment between the IR Sync ports until the update is complete.

Choose from the Latest Firmware Versions
In the Internet Updates option, you can download firmware updates to your computer, and then deploy them to the 
devices.

Note: To deploy updates to devices, the devices must be live on the network. You must use Wireless Workbench®  5 to update UHF-R® receivers.

Steps:

1. From the Tools menu, select Internet Updates. 

Result: A list of available system and firmware updates is displayed in the Internet Update window.
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2. To download firmware to your computer (but not to devices), select the versions you want and select Download. 

Result: The firmware is downloaded and a summary is displayed.
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3. To download firmware from your computer to devices, select Firmware Manager. 

Result: Available updates are listed by device.
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4. Click on a model to make firmware selections for each device of that model that is live. 

Result: The system displays rack devices, their firmware versions, and the available update versions. For each rack de-
vice, update options are also displayed for the model of portables that are compatible with the rack device.

5. To select which version you want to deploy to each rack device, click in the rack Change to column and select a 
version.

Note: It is possible to revert to an earlier version of firmware.

6. To select which version you want the rack device to host for the portable devices, click in the portable Change to col-
umn and select a version.

7. Only devices with the box checked in the far-left column will be updated.  When you have selected versions for all de-
vices of this model, select Return to Main.
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8. Select versions for other models.

9. When you are ready to perform updates for all models, select Start Update.
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Choose from all Firmware Versions
In the Firmware Update Manager option, you can download firmware updates to your computer, and then deploy them to 
the devices.

Steps:

1. From the Tools menu, select Firmware Update Manager. 

Result: The Firmware Manager window is displayed. A list of supported models is displayed. Models that have devices 
live are click able.

2. To view a list of available firmware updates, select View Firmware. Or, to refresh the list of available updates by check-
ing Shure.com, select Check Now. 

Result: A list of versions available for downloading is displayed. A filled box indicates that the version is already on your 
computer and does not need to be downloaded.

Note: To deploy updates to devices, the devices must be live on the network. You must use Wireless Workbench®  5 to update UHF-R® receivers.

3. To download the versions to your computer (but not to devices), select the versions you want and select Download. 
When the download is complete, select Back.

4. To import a firmware version you have saved to a file, select Import from the View Firmware screen and browse for the 
file.

144 Part 5: Upgrading Wireless Workbench and Axient Firmware



5. Click on a model to make firmware selections for each device of that model that is live. 

Result: The system displays rack devices, their firmware versions, and the available update versions. For each rack de-
vice, update options are also displayed for the model of portables that are compatible with the rack device.

6. To select which version you want to deploy to each rack device, click in the rack Change to... column and select a 
version.

7. To select which version you want the rack device to host for the portable devices, click in the portable Change to... col-
umn and select a version.

8. Only devices with the box checked in the far-left column will be updated. When you have selected versions for all de-
vices of this model, select Return to Main.
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9. Select versions for other models.

10. When you are ready to perform updates for all models, select Start Update.
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Updating Firmware for the AXT620 Ethernet Switch 

2. Enter the user name and password (defaults = root, root) to log in.

3. Select the ‘System’ option and then select ‘TFTP Transaction'.

Note: Before starting a firmware upgrade, unplug or power off all devices connected to the AXT620 except the computer.

Note: The firmware for the AXT620 is not included in the Wireless Workbench 6 databases, but can be downloaded from www.shure.com in the 
DOWNLOAD section of the Shure web site.

Use the embedded web server and a TFTP server to update the firmware of the AXT620 Ethernet Switch.

1. Open the web server by using a web browser (Internet Explorer 6 or later) to the IP address of the AXT620 (default = 
192.168.1.1)
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TFTP Transaction
Enter the following information in the TFTP Transaction window:

1. Enter the IP address of the computer in the TFTP Server IP Address field.

2. Enter the name of the firmware file into the ‘Firmware File Name’ field and click Apply to start the upgrade process.

3. Once the upgrade process is complete, select Factory Default on the left-hand side of the Main Page of the switch.
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Chapter 23 ‒ Care and Maintenance of Lithium-Ion Rechargeable Batteries

Storing Batteries
When batteries are not going to be used for longer periods of time, they should be stored at an ideal voltage of 3.8 volts to 
maintain optimal health. The AXT900 Rackmount Charger has a Storage Mode function that when activated, will charge 
or discharge a battery to 3.8 volts.

To avoid degrading battery health, keep the storage temperature range between 10°C to 25°C (50°F to 77°F).

Transportation
The Axient lithium-ion batteries are designed to be transported in either the chargers or in the transmitters. Avoid shipping 
loose batteries that are not properly packaged. See other instruction in the Lithium-Ion Rechargeable Battery chapter for 
details and requirements for transporting lithium-ion batteries.

Cleaning
If the battery contacts become dirty, you can gently clean them with a small amount of rubbing alcohol and a cotton swab. 
Do not pour any liquids, including alcohol, directly onto the battery contacts. Dip the cotton swab into the alcohol, and then 
clean the contacts. Be sure to wipe away any excess alcohol from the contacts or other material such as cotton that may 
have come loose from the swab.

Inspecting
Periodically inspect each battery for the following:

• cracks
• open seams
• leakage
• damaged, misaligned, or broken contacts

If you see any of these problems while inspecting the battery, do not attempt to charge the battery or use it in a 
transmitter. Remove the battery from service and dispose according to local regulations.
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Chapter 24 ‒ Care and Maintenance of Cables and Connectors

Audio Connectors
Bodypack transmitters and their connectors are often subjected to intense sweat during performances. To maintain top 
performance, periodically clean the audio input connectors (TA4F or LEMO) on the bodypack with an aerosol-based flux 
remover. Most flux remover products come with a spray straw that inserts into the nozzle to apply the spray inside the 
connector. Always wear protective safety glasses while using the flux remover.

To clean the bodypack audio connector, turn the bodypack upside down over a cloth or paper towel, insert the spray straw 
just inside the connector, and gently spray several short bursts of the flux remover. It is important to keep the bodypack 
transmitter held upside down to allow the flux remover to completely drain out of the connector. Use a cotton swab to wipe 
any excess flux remover from the inside of the connector and a towel to clean the bodypack transmitter surface.

SMA Jacks
SMA jacks are used for RF transmission on the AXT100 Bodypack Transmitter, AXT200 Handheld Transmitter, and 
AXT610 ShowLink Access Point. When tightening the male antenna, SMA connectors are designed to have a maximum 
of 5-6 in-lbs of torque applied. Over-tightening can damage the connector and the antenna.

Cables
Damage to network and RF cables affects the performance of the signals they transport. Do not kink network or RF cables 
while coiling them for storage.

Periodically inspect RF and network cables for the following damage:

• kinks
• cuts
• slices
• broken connectors or shields
• bent, broken, missing, or damaged pins
• damaged threads
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Chapter 25 ‒ User Interfaces

AXT100 Bodypack Transmitter 

AXT200 Handheld Transmitter
① Microphone Cartridge 

Interchangeable with a variety of Shure cartridges 

② LCD Display 
View menu screens and settings. Momentarily press power button to activate 
backlight. 

③ Infrared (IR) Port 
Use for automated transmitter programming. Links transmitter to AXT400 
Receiver.

④ Shure Rechargeable Lithium-ion Battery 
Delivers up to 9 hours of runtime from a single charge

⑤ Locking Ring 
Secures the battery and protects the control buttons 

⑥ Dual-Band Antenna 
Covers UHF tuning range and 2.4 GHz ShowLink signal

⑦ Arrow Buttons 
Use to scroll through menu screens and to change parameter values 

⑧ Set Button 
Enables parameter editing. After editing is complete, press to save changes and 
return to the main menu screen.

⑨ Power Button 
Hold for 1 second to turn the transmitter on. To power off, press and hold for 2 
seconds until the display reads Powering Off. When editing parameters, acts as 
an exit button to cancel changes and return to a previous parameter or to the main 
menu screen. 

① Infrared (IR) Port 
Use for automated transmitter programming. Links transmitter to AXT400 
Receiver.

② Power Button 
Hold for 1 second to turn the transmitter on. To power off, press and hold for 2 
seconds until the display reads Powering Off . When editing, acts as an exit button 
to cancel changes and return to a previous parameter or to the main menu screen.

③ Power Indicator LED 
•  Green = power on
•  Red = audio input overload or low battery

④ Microphone Input 
4-pin microphone input jack (LEMO version available)

⑤ Arrow Buttons 
Use to scroll through menu screens and to change parameter values 

⑥ Set Button 
Enables parameter editing. After editing is complete, press to save changes and 
return to the main menu screen.

⑦ Shure Rechargeable Lithium-ion Battery 
Delivers up to 8 hours of runtime from a single charge

⑧ LCD Display 
View menu screens and settings. Momentarily press power button to activate 
backlight.

⑨ Dual-Band Flexible Antenna 
Covers UHF tuning range and 2.4 GHz ShowLink signal
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AXT400 Dual Channel Receiver

Front Panel

Rear Panel

① Sync - Infrared (IR) Port
Infrared (IR) port. For sending parameter presets 
(IR Preset) to a transmitter and linking the 
transmitter and receiver to the same channel. 

② Squelch LEDs
• Blue (On) = transmitter signal detected
• Off = no signal or signal squelched because of 

poor reception or no tonekey

③ RF LEDs
Indicates the RF signal strength from the 
transmitter.
• Amber (1-5) = -90 to -70 dBm in 5 dBm 

increments
• Red = RF overload

④ Audio LEDs
Indicates the audio signal strength from the 
transmitter.
• Green = signal present
• Yellow = normal peak
• Red = overload 
To correct an overload, adjust the transmitter gain.

⑤ LCD display
Each channel has an LCD display for viewing 
settings and parameters.

⑥ Menu navigation buttons
Use to select and navigate through parameter 
menus.

⑦ Enter button
The Enter button flashes when an action or 
parameter change is pending. Press Enter to save 
the value.

⑧ Exit button
Cancels parameter changes or returns to a 
previous menu screen.

⑨ Control wheel
• Push to select menu items for editing
• Turn to edit a parameter value

⑩ Monitor clip LED
Indicates audio overload when illuminated.

⑪ Monitor output LED
Indicates channel selection for monitoring.

⑫ Monitor volume knob
Adjusts monitor volume. Push to monitor channel 
1 or channel 2.

⑬ Monitor jack 
6.5 mm (1/4”) output jack for headphones.

⑭ Power switch 
Power the unit on or off. 

① AC power primary switch
AC main power switch. 

② AC power in
IEC connector 100 - 240 V AC.

③ AC power cascade
Use IEC extension cables to connect up to 5 rack 
components to a single AC power source.

④ Network speed LED (amber)
• Off = 10 Mbps
• On = 100 Mbps

⑤ Ethernet ports: Class 1 PoE enabled (2)
Connect to an Ethernet network to enable remote 
control and monitoring.

⑥ Network status LED (green)
• Off = no network link
• On = network link active
• Flashing = network link active, flash rate 

corresponds to traffic volume

⑦ Word clock input
Connect to resolve the AXT400 AES3 digital 
output to an external word clock source.

⑧ Word clock thru output
Passes word clock signal to additional 
components. 

⑨ Word clock termination switch
Set to thru when passing signal to additional 
components. Set to 75Ω when thru connection is 
not used.

⑩ AES3 digital audio output
24-bit digital audio output for channel 1 and 
channel 2.

⑪ Line/Mic switch
Changes the output level 30 dB (XLR outputs 
only). 

⑫ Transformer balanced XLR audio output
For channel 1 and channel 2. 

⑬ Ground lift switch
Lifts the ground from pin 1 of the XLR connector 
and the sleeve of the ¼” jack. 

⑭ Transformer balanced 1/4" output jack
For channel 1 and channel 2. 

⑮ RF antenna input jacks
For antenna A and antenna B.

⑯ RF input status LED
Indicates the voltage status of the RF input. 
• Green = DC voltage on
• Red flashing = fault condition
• Off = DC voltage off

⑰ RF cascade ports
Passes the RF signal from one receiver to the 
next, allowing up to 5 receivers to share a single 
pair of antennas.

⑱ Temperature activated fan
Ensures top performance in high temperature 
environments. Clean fan screen as needed to 
maintain airflow.
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AXT600 Spectrum Manager

Front Panel

Rear Panel

① AC power primary switch
AC main power switch. 

② AC power in
IEC connector 100 - 240 V AC.

③ AC power cascade
Use IEC extension cables to connect up to 5 rack 
components to a single AC power source.

④ Network speed LED (amber)
• Off = 10 Mbps
• On = 100 Mbps

⑤ Ethernet ports: Class 1 PoE enabled (2)
Connect to an Ethernet network to enable remote 
control and monitoring.

⑥ Network status LED (green)
• Off = no network link
• On = network link active
• Flashing = network link active, flash rate 

corresponds to traffic volume 

⑦ RF antenna input jacks
For antenna A and antenna B.

⑧ RF input status LED
Indicates the voltage status of the RF input. 
• Green = DC voltage on
• Red flashing = fault condition
• Off = DC voltage off

⑨ RF cascade ports
Passes the RF signal to additional components.

⑩ Temperature activated fan
Ensures top performance in high temperature 
environments. Clean fan screen as needed to 
maintain airflow.

① Data display screen
Displays Frequency Monitoring status, RF plots, 
and signal strength.

② Data display navigation buttons
Use to access menu options. 

③ Menu screen display
Displays menus and settings.

④ Menu navigation buttons
Use to select and navigate through menus.

⑤ Enter button
Use to enter and save parameter changes.

⑥ Exit button
Cancels parameter changes or returns to a 
previous menu screen.

⑦ Control wheel
• Push to select menu items for editing
• Turn to edit a parameter value

⑧ Monitor clip LED
Indicates audio overload when illuminated.

⑨ Monitor output LED
Indicates monitor output on or off.

⑩ Monitor volume knob
Adjusts monitor volume.

⑪ Monitor jack 
6.5 mm (1/4”) jack.

⑫ Power switch 
Power the unit on or off. 
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AXT610 ShowLink™  Access Point

AXT620 Ethernet Switch

Front and Rear Panel

① ShowLink 2.4 GHz detachable antenna
For 2.4 GHz signals

② ShowLink Data Status LED (blue)
• ON Steady: Linked, no data transmission
• Flashing: Transmitting data - rate of flashing indicates level of activity

③ Power Status LED (green/amber/red)
• Steady Green: Power ON, power source = PoE
• Steady Amber: Power ON, power source = external power supply
• Red Flashing: Response to remote ID flash command

④ Ethernet Status LED (green)
• ON Steady: Ethernet connected, no traffic
• ON Flashing: Ethernet connected, flashing corresponds to volume of data traffic

⑤ Threaded mounting point
Use to wall mount the access point

⑥ External power supply connector
Connection point for external power supply

⑦ Reset button
Press to restore factory settings

⑧ Ethernet port
For network connection and Class 1 PoE

⑨ Scanning antenna for channel agility
Scans the 2.4 GHz spectrum for the best frequency

① RJ-45 Ports 
One 10/100 N-way auto-sensing for 10Base-T or 
100Base-TX connections. 

② Front Panel LED Indicators 
LINK
• Green: Connected to network 
• Blinking: Networking is active 
• Off: Not connected to network 

100Mb
• Amber: The port is operating at speed of 100 

Mb 
• Off: The port is disconnected or not operating 

at speed of 100 Mb 

PoE
• Amber: The port is supplying power to the 

connected PoE device 
• Off: No powered device attached 

③ DHCP Switch
Turns the DHCP server ON or OFF. (Left side = 
On, Right side = Off) 

④ Power
• Green: Power on 
• Off: No AC power applied 

⑤ Power cord socket 
The switch will work with AC in the voltage range 
of AC 100-240V with frequency of 50-60Hz. 

⑥ RJ-45 Ports 
Eight 10/100 N-way auto-sensing for 10Base-T 
or 100Base-TX connections. Ports 5-8  also can 
supply power over Ethernet to enabled-devices. 

⑦ Reset button 
Reboots the system. If you press the Reset button 
for over five seconds, the system will reset to 
factory defaults.

⑧ System information sticker 
Displays the MAC address. 

⑨ Rear Panel LED Indicators 
LINK (port 1 ~ 8) 
• Green: Connected to network 
• Blinking: Networking is active 
• Off: Not connected to network 

100Mb (port 1 ~ 4) 
• Amber: The port is operating at speed of 100 

Mb 
• Off: The port is disconnected or not operating at 

speed of 100 Mb 

PoE (port 5 ~ 8) 
• Amber: The port is supplying power to the 

connected PoE device 
• Off: No powered device attached 
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AXT630 Antenna Distribution System

Front and Rear Panel

AXT900 Rackmount Charging Station

① LCD Display
Displays menu and settings.

② Navigation Buttons
• Arrows: Scroll menus and change settings
• SET: Enables menu edits and saves changes

③ Power Switch
Powers the unit on or off

④ AC Power Primary Switch
AC Main Power Switch

⑤ AC Power In
IEC Connector, 100-240 V AC

⑥ AC Power Cascade 
Use the IEC extension cables to connect up to 5 
devices to a single AC power source.

⑦ Network Speed LED (amber):
• Off = 10 Mbps
• On = 100 Mbps

⑧ Ethernet Ports (2)
PoE Class 1 enabled. Connect to an Ethernet 
network to enable remote control and monitoring

⑨ Network status LED (green)
• Off = no network link
• On = network link active
• Flashing = network link active, flash rate 

corresponds to traffic volume

⑩ RF Output Connectors, Channel B
Distributes RF signal for Channel B

⑪ RF Output Connectors, Channel A
Distributes RF signal for Channel A

⑫ Antenna IN Ports, Channels A and B
Antenna inputs are DC biased for use with active 
antennas or in-line amplifiers. 

⑬ RF Cascade Ports, Channels A and B 
Passes the wideband RF signal from one device to 
the next, allowing up to 5 devices to share a single 
pair of antennas.

⑭ Antenna Input Status LED 
• Green = DC power on
• Off = DC power off
• Red flashing = Antenna fault or over-current 

condition

Front and Rear Panel

① LCD screen
Displays battery status and menu settings

② Control keys
For navigating the LCD screen. Press and hold 
both arrow keys to enter or exit the utility menu.

③ Charging module
Interchangeable modules for handheld and 
bodypack batteries.

④ Charge Status LED
Indicates battery charge status

⑤ Monitoring Selection LED
This white LED shows which battery is selected in 
the monitoring menu.

⑥ AC power in
Connect to AC mains with supplied power cable.

⑦ AC power cascade
Powers additional units.

⑧ Ethernet ports (2)
Connect to an Ethernet network to enable remote 
control and monitoring.

⑨ Network status LED (green)
Off = No network link
On = Network link active
Flashing = Network link active, flash rate 
corresponds to traffic volume.

⑩ Network speed LED (amber)
Off = 10 Mbps
On = 100 Mbps

⑪ Cooling fan vent
Clean fan screen as needed to maintain airflow.

⑫ Power switch
Powers the unit on and off.
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Chapter 26 - Component Menus and Navigation

AXT100 Bodypack Transmitter Menus and Navigation

Menu Descriptions

Group and Channel
A group is a set of compatible 
frequencies. A single frequency within a 
group is a channel.
Use the SET key to select the group or 
channel.

• G: Change the group
• Ch: Change the channel

Frequency
Manual frequency selection in 25 kHz 
increments.

Gain
Sets the input sensitivity level (gain). 
Gain range is -10 to +40 dB in 1 dB 
steps.

RF Mute
Disables the RF carrier signal, which 
mutes transmission of audio.
• TX On: RF signal enabled
• TX Off: RF signal disabled

Unlink
Ends the Link relationship between 
transmitter and receiver.
• YES: Ends the Link between transmitter 

and receiver.
• NO:  Preserves the Link between 

transmitter and receiver.
Note: When a transmitter is unlinked, the 
channel name reverts to Unlinked.

ShowLink Test
Activates the ShowLink test 5-bar 
display. Measures the remote control 
range of a ShowLink Access Point.
Note: A minimum of one bar must be 
displayed to have ShowLink control.

Firmware
Displays the installed firmware version.

Device ID
Identifies the transmitter on a linked 
receiver or in WWB. Use the SET and 
arrow keys to edit the Device ID.

RF PWR
Sets RF power level. Access 
this menu by pressing and 
holding the SET button and 
then pressing the ▼ button.
Use lower power settings to 
conserve battery life and to 
prevent RF overload at the 
receiver.

Note: A password is required in 
some regions to change the RF 
power level.

Power-on RF mute 
Power-on RF mute prevents 
transmission of audio when 
powering on the transmitter.
With the transmitter turned 
off, press and hold both the ▼ 
button and the SET button, and 
then press and hold the Power 
button.
After power-on, an RF Muted 
message indicates that the 
transmitter is in RF Mute mode.

Note: RF Mute mode persists 
through power cycles of the 
transmitter. 

The following menu descriptions reflect a linked AXT100 transmitter, with ShowLink remote control enabled.

PCB Serial Number
Displays the serial number of 
the printed circuit board (PCB) 
installed in the unit.
1. Enter the RF PWR menu by 

pressing and holding the SET 
button, and then pressing the 
▼ button.

2. Press the ▲ button to access 
the serial number.

3. Momentarily press the power 
button to return to the home 
menu screen.

Locking the Buttons
Lock the buttons of the 
transmitter to prevent 
accidental or unauthorized 
parameter changes.
Press and hold the ▼ and ▲ 
buttons for 2 seconds to lock. 
Repeat to unlock.

Note: For added security, 
the transmitter has a 
secondary lock switch 
located inside the battery 
compartment. If engaged, 
all controls will be locked.
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AXT200 Handheld Transmitter Menus and Navigation
The following menu descriptions reflect a linked AXT200 transmitter, with ShowLink remote control enabled and operated in Frequency 
Diversity mode.

Menu Descriptions

F1 Group and Channel
A group is a set of compatible 
frequencies. A single frequency within a 
group is a channel.
Use the SET key to select the group or 
channel for F1.

• G: Change the group

• Ch: Change the channel

F1 Frequency
 Manual frequency selection in 25 kHz 
increments.

F2 Group and Channel
A group is a set of compatible 
frequencies. A single frequency within a 
group is a channel.
Use the SET key to select the group or 
channel for F2.

Note: F2 can be turned off to operate the 
transmitter in single carrier mode. Use the 
SET key to highlight the ON or OFF option. 
This function is available in the F2 frequency 
menu and the F2 group and channel menu.

• ON: Frequency Diversity mode

• OFF: single carrier mode

F2 Frequency
 Manual frequency selection in 25 kHz 
increments.

Gain
Adjust the gain to set the input sensitivity 
level. Gain range is -10 to +32 dB in 1 dB 
steps.

RF Mute
Disables the RF carrier signal, which 
mutes transmission of audio.
• TX On: RF signal enabled

• TX Off: RF signal disabled

Unlink
Ends the Link relationship between 
transmitter and receiver.
• YES: Ends the Link between transmitter 

and receiver.

• NO:  Preserves the Link between 
transmitter and receiver.

Note: When a transmitter is unlinked, the 
channel name reverts to Unlinked.

ShowLink Test
Activates the ShowLink test 5-bar 
display. Measures the remote control 
range of a ShowLink Access Point.
Note: A minimum of one bar must be dis-
played to have ShowLink control.

Firmware
Displays the installed firmware version.

Device ID
Identifies the transmitter on a linked 
receiver or in WWB. Use the SET and 
arrow keys to edit the Device ID.

Locking the Buttons
Lock the buttons of the trans-
mitter to prevent accidental 
or unauthorized parameter 
changes.
Press and hold the ▼ and ▲ 
buttons for 2 seconds to lock. 
Repeat to unlock.

RF PWR
Sets RF power level. Access 
this menu by pressing and 
holding the SET button and 
then pressing the ▼ button.
Use lower power settings to 
conserve battery life and to 
prevent RF overload at the 
receiver.

Note: A password is required in 
some regions to change the RF 
power level.

Power-on RF mute 
Power-on RF mute prevents 
transmission of audio when 
powering on the transmitter.
With the transmitter turned off, 
press and hold both the ▼ but-
ton and the SET button, and 
then press and hold the Power 
button.
After power-on, an RF Muted 
message indicates that the 
transmitter is in RF Mute mode.

Note: RF Mute mode persists 
through power cycles of the 
transmitter. 

PCB Serial Number
Displays the serial number of 
the printed circuit board (PCB) 
installed in the unit.
1. Enter the RF PWR menu 

by pressing and holding the 
SET button, and then press-
ing the ▼ button.

2. Press the ▲ button to access 
the serial number.

3. Momentarily press the power 
button to return to the home 
menu screen.
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Radio Menu (AXT400 Receiver) 

New Freq
Acquires a new frequency from an online AXT600 Spectrum Manager 
or from WWB6.

Scan

Channel Scan
Scans for the first available frequency within a group.

Find Next
Initiates a channel scan for the next open channel.

Find Best
Initiates a channel scan for the best open channel.

Group Scan
Scans the selected band to find the group with the most open channels.

Deploy
Assigns frequencies to connected equipment after a Group Scan has been 
completed.

Note: The Spectrum Manager parameter will be set to None.

Options

Avoidance
Select Avoidance mode: Prompt, Auto, Detect Only, Off.

Sensitivity
Interference Detection Sensitivity (speed of detection): Less, More, Normal.

Exclusion Threshold
Exclusion Threshold setting from Spectrum Manager or WWB6 (display only)

Custom
Load and edit Custom Groups

Tx Profile
Set to transmitter type (AXT, UHF-R) to be used for frequency coordination.

Diversity
Select Frequency Diversity mode: FD-Handheld, FD-Bodypack, Off.

Calibrate
Use to equalize the audio levels between two bodypack transmitters in Fre-
quency Diversity mode.

Detect Tx
Optional detection feature, alerts when a signal is received from an unex-
pected transmitter.

Squelch

Noise Squelch
Sets the Squelch threshold (-20 to +10, in 1 step increments).

Tonekey Squelch
The following settings are available:

• Off: Disables Tonekey for troubleshooting

• Auto: Receiver will pass signals from AXT and UR transmitters

• AXT Only: Receiver will only pass signal from AXT transmitters

• UR Only: Receiver will only pass signal from UR transmitters

Displays information for Group (G:), Channel (Ch:), 
Frequency, Band, Spectrum Manager, and TV.
Editing Options:

• Group

• Channel

• Frequency

• Band

• Spectrum Manager

New Freq
Scan

Options
Squelch

G:01    Ch:01
470.350 MHz      TV: 14
Band:  G1
         : AXT600Spectrum
Manager

New Freq

Group Scan

Channel Scan
Scan

Options

Squelch

Find Best

Detect Tx

Custom
Tx Profile

Calibrate
Diversity

Find Next

Deploy

Radio Menu
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Output
Use the control wheel to adjust the output level from 0 to -30 dB in 1 
dB increments. The status of the Line/Mic switch is shown next to the 
output level reading. Turning the control wheel beyond -30 dB mutes 
the audio output.

Ground Lift Status
Displays the status of the ground lift switch (Grounded or Lifted).

Digital
Accesses the Digital audio settings menu.

Internal Set
Set the internal AES3 word clock to 48 or 96 kHz.

Rate Status
Displays the rate status (48 or 96 kHz) and word clock source (int or ext).

BNC Status
Displays the status of the word clock switch (Thru or Term. 75 Ohm).

AMC (Audio Mute Concealment)
Masks small gaps in audio that occur during frequency changes. Use 
the control wheel to set to On or Off.

Phones
Use the control wheel to select the monitoring point for the audio sig-
nal (Analog Output or Pre-Tonekey Squelch).

Audio Menu (AXT400 Receiver)

Displays:

• Channel Name

• Audio Overload Hold (Off/On)

Output

AMC

Phones

Channel  Name:

[AXT400 1]

Output
Digital

AMC

Phones

Audio Menu
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Display

Brightness
Use the control wheel to select brightness level (Auto, Low, Medium, High). 
In Auto mode, the level will automatically adjust to match surrounding light 
conditions.

Display Invert
inverts text and background color of the display.

Contrast
Adjusts display contrast from -10 to +10.

Home Info
Enables choosing of parameters displayed on the home menu.

Network

Find All
Lists all Axient devices and P10T receivers found on the network. Access 
Find All from the AXT600 Spectrum Manager to view UR4 receivers on the 
network.  Individual devices can be identified by Device ID.

Show
Accesses the Info option to view device settings for a device selected from the 
Find All list.

Flash All
Flashes the interface LEDs for all devices connected to the network.

Flash
Flashes the interface LEDs for a device selected from the Find All List.

FW Ver
Displays the installed firmware version for the selected device.

Info
Displays Device, Model, IP, and Firmware for a device selected from the 
Find All list.

Back
Returns to the previous menu.

Lock
Access lock options (On, Off) for the controls and for the front panel 
power switch.

More

Antenna DC Power
Turn antenna DC power On or Off.

Fan
Set the cooling fan mode: Automatic (fan activated by temperature sensor) 
Always On (fan continuously active for maximum cooling).

Temp
Displays the internal temperature of the receiver.

S/N (Serial Number)
Displays the serial number. Select the More option to view serial numbers for 
internal printed circuit boards (PCB).

Reset All
Restores receiver settings to factory defaults.

ShowLink Test
Activates ShowLink Test to measure ShowLink coverage. Use the control 
wheel to select a transmitter, and then press Start. Use the Exit button to end 
the ShowLink test.

Util Menu (AXT400 Receiver)

Displays information for Device ID, IP Address Mode, 
IP Address, and Firmware.
Editing Options:

• Device ID

Display

Find All

Home Info

Network

Lock

Flash All
FW Ver

Show
Flash
Info
Back

PCB Serial Numbers

Util Menu

More

ShowLink Test

S/N
More

Reset All

Disp lay

Network

Lock

More

Device :  [AXT400]

Automatic mode

IP:  169.254.51 .231

F irmware :  1 .0 .0
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Adjust
Use the control wheel for real-time editing of transmitter parameters: 
Gain, Power, RF Output, Lock.

Edit ID
Use the control wheel to edit the Device ID.

Flash
Flashes the display of the selected transmitter.

Mute (Unmute)
Disables the RF carrier to mute the audio. Select Unmute to enable the RF 
carrier.

IR Presets
Program initial transmitter settings from the receiver. IR presets auto-
matically configure the transmitter when an IR sync is performed.
Use the control wheel to edit a parameter, select No Change to pre-
serve current setting.

Battery
Set battery type (Alkaline, Lithium, NiMH) when using the AXT913 battery 
sled or AXT921 battery carrier to power the transmitter. Setting the battery 
type ensures accurate metering of battery runtime

FW Update
Downloads a transmitter firmware update stored in the receiver. Align the 
transmitter with the IR Sync port and press Download. Maintain transmitter 
alignment until download is complete. Use the Firmware Update Manager tool 
in WWB6 to download updates.

Unlink
Ends linking relationship to release transmitter from ShowLink control.

Sync
Activates the IR sync function to link a transmitter and receiver. Align 
the IR ports of transmitter and receiver before selecting the Sync op-
tion. Correct alignment is indicated by the illumination of the red LED 
in the receiver IR port.

Tx Menu (AXT400 Receiver)

Displays IDs transmitters linked to the receiver. Up to 2 
Axient transmitters may be linked.
A ShowLink icon and current battery life are displayed 
next to each transmitter.
Use the control wheel to select a transmitter for editing.

Retry

Battery
FW Update

Edit ID
Flash
Mute (Unmute)

IR Presets

Adjust

Unlink

Download

Tx Menu

Sync

Adjust

IR Presets

Unl ink

Sync

L inked Devices :

1 :  [AXT200]        3 :15

2:

Menu acts on h igh l ighted device
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All New
Use this option for initial RF coordination of a wireless audio system.

Next
Advances to the next Wizard step.

Clear
Removes the selected device from Spectrum Manager control.

Add All
Selects all devices on the found channels list for Spectrum Manager control.

Flash
Flashes interface of selected device.

Refresh
Initiates a new network search for devices.

Scan
Wizard initiates scan to find frequencies for the compatible frequency list 
calculation.

Update Freqs
Use this option to update the frequencies for devices connected to 
the network.

Note: This option is available when a device list has been created.

Update Devices
Use this option when adding devices to an existing wireless audio 
system. This option is available when a CFL has been created.

Next
Advances to the next Wizard step.

Deploy
Deploys frequencies to networked devices.

Exit
Returns to main menu screen.

Clear
Removes devices from the control list

Add All
Places all discovered devices on the control list.

Flash
Flashes interface of selected device.

Refresh
Initiates a new network search for devices.

Clear
Removes the selected device from Spectrum Manager control.

Wizard Menu (AXT600 Spectrum Manager)

Displays the Wizard setup options.

Next

Next

Next

Refresh

Refresh

All New

Update Devices

Update Freqs

Flash

Flash

Add All 

Add All 

Clear

Clear

Next

Next

Next

Deploy
Exit

Wizard Menu

Scan

Scan

Choose
Setup
Task

All New

Update Freqs
Update Devices
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Devices
Displays list of networked devices. A checkmark in the box next to a 
device indicates that it is controlled by the Spectrum Manager.
Press the control wheel to add or remove a checkmark from a se-
lected device. “Offline” indicates offline devices.

Ch Info
Displays information for a selected receiver (Device ID, Channel Name, 
Band, Tx Profile, ShowLink status).

Back
Returns to previous menu screen.

Flash
Flashes interface LEDs for selected device. Only available for online de-
vices.

Edit
Allows editing of transmitter profile (AXT, UHF-R), when receiver is online.

Clear
Clears all devices (including offline devices) controlled by the Spectrum 
Manager. All boxes appear unchecked.

Add All
Adds all devices on the network to Spectrum Manager control.

Scan
Access the scan function. Use the control wheel to set Sweep 
(Single/Continuous), Peak Hold (Off/On), and Exclusion 
Threshold (-70 to -110 dB).

Start/Stop
Start activates the scan function. Stop ends the scan function.

Recall
Recalls a stored scan from Spectrum Manager memory. Recalling a scan 
will overwrite current scan data

Store
Stores current scan data in Spectrum Manager memory. Previously stored 
scan data will be overwritten.

Listen
Activates the Listen function for audio monitoring of a selected 
frequency. Use the control wheel to select frequency, band, and 
antenna.
Signal strength for the selected frequency is shown on the data dis-
play window.

Manual Menu (AXT600 Spectrum Manager)

Displays the number of devices controlled by the 
Spectrum Manager.

Ch. Info

Clear
Add All
Flash

Devices

Listen

Back
Flash
Edit

Manual Menu

Scan

Store

Start/Stop
Recall

Devices
Controlled: 12

Devices
Scan

Listen
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Display

Brightness
Use the control wheel to select brightness level (Auto, Low, Medium, 
High). In Auto mode, the level will automatically adjust to match surround-
ing light conditions.

Display Invert
Inverts text and background color of the display

Contrast
Adjusts display contrast from -10 to +10.

Network

Find All
Lists all Axient devices, UR4 receivers, and P10T receivers found on the 
network. Individual devices can be identified by Device ID.

Show
Accesses the Info option to view device settings for a device selected from 
the Find All list.

Flash All
Flashes the interface LEDs for all devices connected to the network.

Flash
Flashes the interface LEDs for a device selected from the Find All List

FW Ver
Displays the installed firmware version for the selected device.

Info
Displays Device, Model, IP, and Firmware for a device selected from the 
Find All list.

Back
Returns display to the Find All list.

Lock
Access lock options (On, Off) for the front panel power switch.

More

Antenna DC Power
Turn antenna DC power On or Off.

Cascade
Set RF cascade mode to Auto or On.

Fan
Select fan mode (Automatic or Always On), view device temperature.

S/N (Serial Number)
Displays the serial number. Select More option to view serial numbers for 
internal printed circuit boards (PCB).

Reset All
Restores settings to factory defaults.

User Group
Select a user group country or load a Custom user group.

Util Menu (AXT600 Spectrum Manager)

Displays information for Device ID, 
IP Address Mode, IP Address, and Firmware.
Editing Options:

• Device ID

Display

Find All
Network

Lock

Flash All
FW Ver

Show
Flash
Info
Back

PCB Serial Numbers

Util Menu

More

User Group

Fan
S/N

More

Reset All

Device ID: [AXT600]
mode:
IP:
Firmware:

Display
Network

Lock
More
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New
Calculates a New CFL for managed devices on the network.

Start
Initiates a new CFL calculation using current scan data.

Exclusions
Accesses the menu for setting exclusions.

Format
Sets the TV format (6, 7, 8 MHz).

Add
Add TV channels, single frequencies, or frequency ranges to exclude from 
the CFL calculation.

Delete
Deletes the selected exclusion.

Del All
Deletes all exclusions.

Scan First
Performs a scan to supply updated scan data before beginning a CFL 
calculation.

Next
Move to the next menu screen.

Re-Scan
Initiates a new scan.

Back
Returns to the previous menu screen.

Edit

Add
Enter frequencies into the CFL menu. Duplicate frequencies cannot be 
added to the CFL.

Del
Deletes a frequency from a CFL.

Listen
Activates the Listen function for a selected frequency.

Edit
Edit frequency value and frequency type.

More

Clear
Removes all frequencies from the current CFL.

Edit
Accesses CFL editing menus.

Analyze
Analyzes current CFL to verify compatibility.

Deploy
Deploys frequencies to networked devices.

CFL Menu (AXT600 Spectrum Manager)

Displays:

• Total number of frequencies in the current CFL

• Number of frequencies deployed to the 
network

• Number and status of backup frequencies

Start

Exclusions

Scan First

Add

Clear

Del

Edit

Listen

Analyze

Edit

New

Edit

More

Deploy

Del All

Back

Delete

Re-Scan

Add

Next

Format

Back

Next

CFL Menu

CFL Calculation

CFL Calculation

Scan

62 Frequencies

Deployed to Network: 6

Ready: 54

Degraded: 2

New
Edit

More
Deploy
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AXT630 Antenna Distribution System Menus and Navigation

IP Mode

Band

Network Status

IP Address

RF Gain

Subnet

Antenna Cascade

MAC

Antenna Power

Brightness

Display Invert

Front Panel Lock

Power Switch Lock

Fan

Firmware

Serial Number

Device ID

Main Menu Description
Use the Main menu to select the band filter, adjust the RF gain, and configure the an-
tenna ports.

Utility Menu Description
Use the Utility menu to configure network settings and adjust device settings.

Band
Selecting an input Band filtering.
• Band: Four selectable input filters are 

available to match the frequency bands 
transmitters and receivers.

• Wideband: Extends frequency support 
across all 4 bands allowing receivers in 
different bands to use the RF outputs.

Antenna Cascade
• Auto: The ports will activate when a 

connected device supplies 12-15 V DC to 
the port.

• On: The ports are continuously active, 
independent of voltage applied by a 
connected device.

RF Gain
Gain adjustments are made in 1 dB 
increments to boost or attenuate the 
antenna signal .

Antenna Power
• On: The antenna ports supply 12-15 V DC to 

power active antennas.
• Off: Turns off DC voltage at the antenna 

ports.

Network Status
• Active: Indicates connectivity with other 

devices on the network.
• Inactive: No connectivity with other devices 

on the network.

Press and hold both 
arrow keys to navi-
gate between the 
Main menu and the 
Utility menu.

IP Mode
• Automatic: Use with a DHCP server which 

automatically assigns an IP address.
• Manual: Use to set a valid IP address and 

subnet when a DHCP server is not available.

IP Address
Displays IP address.

Subnet
Displays subnet setting.

MAC (MAC Address)
Displays the MAC address, which is 
an embedded, uneditable identification 
number used by the network and WWB  
to identify components.

Brightness
Sets the brightness of the LCD to low, 
medium, or high.

Display Invert
Changes the LCD menu from white text 
on dark background to dark text on a light 
background.

Front Panel Lock
Locks or unlocks the navigation buttons 
to prevent accidental or unauthorized 
changes to settings.
• On: Locks the navigation buttons.
• Off: Unlocks the navigation buttons.

Power Switch Lock
Lock the power switch to ensure that 
power is not accidentally turned off.
• On: Locks the power switch.
• Off: Unlocks the power switch.

Fan (Cooling Fan Mode)
• Automatic: The fan is enabled and adjusts 

speed based on the internal temperature of 
the unit.

• Always On: The fan runs continuously 
at maximum speed to provide maximum 
cooling in warm environments.

Firmware
Displays the version of firmware installed 
on this device.

Serial Number
Displays the serial number.

Device ID
Identifies the device on the network. Use 
the SET and arrow keys to edit.

The AXT630 has two separate menus: Main and Utility. Press and hold both arrow keys to navigate between the two menus.

SET

168 Part 7: Reference Chapters



AXT900 Rackmount Charging Station Menus and Navigation

IP Mode

Monitoring

Charge Status

Network Status

IP Address

Time to Full

Subnet

Battery Health

MAC

Cycle Count

Batt. Temp.

Brightness

Display Invert

Storage Mode

Fan

Firmware

Serial Number

Device ID

Monitoring Menu Description
Use the Monitoring menu to check battery status.

Utility Menu Description
Use the Utility menu to configure network settings and adjust device settings.

Time to Full
Displays the time remaining until the 
battery is fully charged.

Charge Status
Displays charge as a percentage of the 
total battery capacity. Also displays charge 
in milliampere-hours (mAh).

Battery Health
This displays the health of a selected 
battery as a percentage of the charge 
capacity of a new battery.

Cycle Count
Displays the total number of times that the 
battery has undergone one full count of 
discharge and charge. 

Batt. Temp. (Battery Temperature)
Displays both the battery temperature (in 
Celsius and Fahrenheit) and the status 
(Cold, Warm, Hot).

Network Status
• Active: Indicates connectivity with other 

devices on the network.
• Inactive: No connectivity with other devices 

on the network.

Press and hold 
both arrow keys to 
navigate between 
the Monitoring menu 
and the Utility menu.

IP Mode
• Automatic: Use with a DHCP server which 

automatically assigns an IP address.
• Manual: Use to set a valid IP address and 

subnet when a DHCP server is not available.

IP Address
Displays IP address.

Subnet
Displays subnet setting.

MAC (MAC Address)
Displays the MAC address, which is 
an embedded, uneditable identification 
number used by the network and WWB  
to identify components.

Brightness
Sets the brightness of the LCD to low, 
medium, or high.

Display Invert
Changes the LCD menu from white text 
on dark background to dark text on a light 
background.

Fan (Cooling Fan Mode)
• Automatic: The fan is enabled and adjusts 

speed based on the internal temperature of 
the unit.

• Always On: The fan runs continuously 
at maximum speed to provide maximum 
cooling in warm environments.

Storage Mode
Charges or discharges all batteries to 
bring them to a 3.8 volts, ideal for long 
term storage.
• Off: Normal charge.
• Store at 3.8 V: Charges or discharges all 

batteries to 3.8 volts.

Firmware
Displays the version of firmware installed 
on this device.

Serial Number
Displays the serial number.

Device ID
Identifies the device on the network. Use 
the SET and arrow keys to edit.

SET

The AXT900 has two separate menus: Monitoring and Utility. Press and hold both arrow keys to navigate between the two menus.
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Chapter 27 ‒ Product Interoperability

Receiver Transmitter
UR1 UR1M UR1H

UR4S/UR4D Tonekey Squelch: Fully compatible
Tx ID: Displays "UR1"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Fully compatible
Tx ID: Displays "UR1M"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Fully compatible
Tx ID: Displays "UR1H"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

MW4D Tonekey Squelch: Fully compatible
Tx ID: Displays "UR1"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Fully compatible
Tx ID: Displays "UR1M"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Fully compatible
Tx ID: Displays "UR1H"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

UR5/MW5 Tonekey Squelch: Fully compatible
Tx ID: N/A
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Fully compatible 
(UR mode only)
Tx ID: N/A
Companding: Fully compatible (UR 
mode)
Sync: Fully compatible (UR mode)
Battery Ind: Status bars (TX and RX)

Tonekey Squelch: Fully compatible 
(UR mode only) 
Tx ID: N/A
Companding: Fully compatible (UR 
mode)
Sync: Fully compatible (UR mode)
Battery Ind: Status bars (TX and RX)

AXT400 Tonekey Squelch: Fully compatible
Tx ID: Displays "UR1"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Note: Audio will squelch if the AXT400 is 
set to FD-Handheld mode.

Tonekey Squelch: Fully compatible
Tx ID: Displays "UR1M"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Fully compatible
Tx ID: Displays "UR1H"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

P9R Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

P10R Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: Status bars for RX only

Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

Axient is designed to be used together with the UHF-R series and the PSM1000 series products. All three product series 
are designed to be operated on the Wireless Workbench 6 network.

The chart below details the compatibility levels between the product components.

UR1/UR1M/UR1H
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Receiver Transmitter
UR2 UR3 MW1

UR4S/UR4D Tonekey Squelch: Fully compatible
Tx ID: Displays "UR2"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Fully compatible
Tx ID: Displays "UR2"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Fully compatible
Tx ID: Displays "MW1"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

MW4D Tonekey Squelch: Fully compatible
Tx ID: Displays "UR2"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Fully compatible
Tx ID: Displays "UR2"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Fully compatible
Tx ID: Displays "MW1"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

UR5/MW5 Tonekey Squelch: Fully compatible 
(UR mode only) 
Tx ID: N/A
Companding: Fully compatible (UR 
mode)
Sync: Fully compatible (UR mode)
Battery Ind: Status bars (TX and RX)

Tonekey Squelch: Fully compatible 
(UR mode only) 
Tx ID: N/A
Companding: Fully compatible (UR 
mode)
Sync: Fully compatible (UR mode)
Battery Ind: Status bars (TX and RX)

Tonekey Squelch: Fully compatible 
(UR mode only) 
Tx ID: N/A
Companding: Fully compatible (UR 
mode)
Sync: Fully compatible (UR mode)
Battery Ind: Status bars (TX and RX)

AXT400 Tonekey Squelch: Fully compatible
Tx ID: Displays "UR2"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Note: Audio will squelch if the AXT400 
is set to FD-Handheld mode.

Tonekey Squelch: Fully compatible
Tx ID: Displays "UR2"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Fully compatible
Tx ID: Displays "MW1"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

P9R Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

P10R Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

UR2/UR3/MW1
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Receiver Transmitter
MW2 MW3 AXT100

UR4S/UR4D Tonekey Squelch: Fully compatible
Tx ID: Displays "MW2"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Fully compatible
Tx ID: Displays "MW2"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Not compatible
Tx ID: NOT compatible
Companding: NOT compatible
Sync: NOT compatible
Battery Ind: NOT compatible

MW4D Tonekey Squelch: Fully compatible
Tx ID: Displays "MW2"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Fully compatible
Tx ID: Displays "MW2"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Not compatible
Tx ID: NOT compatible
Companding: NOT compatible
Sync: NOT compatible
Battery Ind: NOT compatible

UR5/MW5 Tonekey Squelch: Fully compatible 
(UR mode only) 
Tx ID: N/A
Companding: Fully compatible (UR 
mode)
Sync: Fully compatible (UR mode)
Battery Ind: Status bars (TX and RX)

Tonekey Squelch: Fully compatible 
(UR mode only) 
Tx ID: N/A
Companding: Fully compatible (UR 
mode)
Sync: Fully compatible (UR mode)
Battery Ind: Status bars (TX and RX)

Tonekey Squelch: Fully compatible 
(AXT mode only) 
Tx ID: N/A
Companding: Fully compatible (AXT 
mode)
Sync: Fully compatible (AXT mode)
Battery Ind: hours:minutes (TX), status 
bars (RX)

AXT400 Tonekey Squelch: Fully compatible
Tx ID: Displays "MW2"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Fully compatible
Tx ID: Displays "MW2"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: Status bars

Tonekey Squelch: Fully compatible
Tx ID: Displays "AXT100"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: hours:minutes (TX), status 
bars (RX)

P9R Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

P10R Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: N/A

MW2/MW3/AXT100
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Receiver Transmitter
AXT200 P9T P10T

UR4S/UR4D Tonekey Squelch: Not compatible
Tx ID: NOT compatible
Companding: NOT compatible
Sync: NOT compatible
Battery Ind: NOT compatible

Tonekey Squelch: Fully compatible 
(P2P mode only)
Tx ID: Displays "Ready"
Companding: Compatible in P2P mode
Sync: NOT compatible
Battery Ind: N/A

Tonekey Squelch: Fully compatible 
(P2P mode only)
Tx ID: Displays "Ready"
Companding: Compatible in P2P mode
Sync: NOT compatible
Battery Ind: N/A

MW4D Tonekey Squelch: Not compatible
Tx ID: NOT compatible
Companding: NOT compatible
Sync: NOT compatible
Battery Ind: NOT compatible

Tonekey Squelch: Fully compatible 
(P2P mode only)
Tx ID: Displays "Ready"
Companding: Compatible in P2P mode
Sync: NOT compatible
Battery Ind: N/A

Tonekey Squelch: Fully compatible 
(P2P mode only)
Tx ID: Displays "Ready"
Companding: Compatible in P2P mode
Sync: NOT compatible
Battery Ind: N/A

UR5/MW5 Tonekey Squelch: Fully compatible 
(AXT mode only) 
Tx ID: N/A
Companding: Fully compatible (AXT 
mode)
Sync: Fully compatible (AXT mode)
Battery Ind: hours:minutes (TX), status 
bars (RX)

Tonekey Squelch: Fully compatible 
(P2P mode only)
Tx ID: N/A
Companding: Compatible in P2P mode
Sync: N/A
Battery Ind: N/A

Tonekey Squelch: Fully compatible 
(P2P mode only)
Tx ID: N/A
Companding: Compatible in P2P mode
Sync: N/A
Battery Ind: N/A

AXT400 Tonekey Squelch: Fully compatible
Tx ID: Displays "AXT200"
Companding: Fully compatible
Sync: Fully compatible
Battery Ind: hours:minutes

Tonekey Squelch: Fully compatible 
(P2P mode only)
Tx ID: Displays "Ready"
Companding: Compatible in P2P mode
Sync: NOT compatible
Battery Ind: N/A

Tonekey Squelch: Fully compatible 
(P2P mode only)
Tx ID: Displays "Ready"
Companding: Compatible in P2P mode
Sync: NOT compatible
Battery Ind: N/A

P9R Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: Status bars for RX only

Tonekey Squelch: Fully compatible
Tx ID: N/A
Companding: fully compatible
Sync: fully compatible
Battery Ind: Status bars for RX only

Tonekey Squelch: Fully compatible
Tx ID: N/A
Companding: fully compatible
Sync: Sync frequency only, not G:/Ch:
Battery Ind: Status bars for RX only

P10R Tonekey Squelch: Not compatible
Tx ID: N/A
Companding: Not compatible
Sync: Not compatible
Battery Ind: Status bars for RX only

Tonekey Squelch: Fully compatible
Tx ID: N/A
Companding: fully compatible
Sync: Sync frequency only, not G:/Ch:
Battery Ind: Status bars for RX only

Tonekey Squelch: Fully compatible
Tx ID: N/A
Companding: fully compatible
Sync: fully compatible
Battery Ind: Status bars for RX only

AXT200/P9T/P10T
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Chapter 28 ‒ Frequency Bands and Coverage Maps

The Axient wireless system is designed to cover all of the available UHF television frequency ranges. The AXT400 re-
ceiver tunes between 208MHz and 228MHz over three variations. The Axient transmitters tune between 60MHz and 
80MHz over several variations and generally use the same frequency band names as those found in the UHF-R series. 
The PSM1000 system tunes up to 80MHz and uses different frequency band names than the Axient and UHF-R series.

400 500 600 700 800 900 1000

A Range Receiver
B Range Receiver
C Range Receiver
D Range Receiver
J Range Receiver

R16 Range Receiver
G7C

G1, G1E, G19
G12
H12

H4, H4E, H18
J5, J5E, J5HK, J12

K4E
L3, L3E, L20

M8
MA24
MJBX

P8
P9
Q5

R16
Spectrum Manager

AXT630 Antenna Distributor
AXT631 Antenna Distributor
AXT632 Antenna Distributor

A24
G10, G10E

H8Z
J8, J8E

K10E
L8, L8E

L9E
P8

Q21
Q22E

R26, R27
X1

G11
A24
ABJ

G1, G1E, G1HK
H4, H4E

J5, J5E
JBX
K4E

L3, L3E
M5E

P8
P9
Q5

R16
R18

R9
X1

MA24
MABJ
MJBX

X2

470 - 698 (G1, H4, J5, L3)

606 - 814 (K4E, M8, P8, P9, Q10A, Q5, Q5HK, A24, 
MA24, R16, JBX, MJBX)

470 - 530

518 - 578

578 - 638

606 - 666
638 - 698

666 - 730
779-806

806-810

710 - 790
710 - 787

740 - 814

470 - 952

470 - 698

606 - 814

779 - 806

470 - 542

518 - 542
554 - 626

596 - 668

626 - 698

670 - 742
710 - 790

710 - 787
750 - 822

794 - 806
944 - 952

479 - 542
779 - 806

779 - 810

470 - 530
518 - 578

578 - 638

606 - 666

806 - 810

638 - 698

694 - 758

710 - 790

710 - 787

740 - 814

794 - 806
794 - 806

790 - 865

779 - 806

779 - 810

806 - 810

944 - 952

925 - 932

MHz

AX
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N
T
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M

10
00

U
HF

-R

470 - 698 (G1E, G7C, G12, H4E, H12, J5E, J5HK, L3E, L3HK)

470 - 510

479 - 530

518 - 565

794 - 806

470 - 510/638-787
(G7C, L3E, M8, P9)

470 --787 

470 - 687(G19, H18, J12, L20)

794 - 806 (R16)
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Chapter 29 ‒ Axient Accessories

Transmitter Accessories
Bodypack rechargeable lithium-ion battery AXT910

Handheld rechargeable lithium-ion battery AXT920

Handheld rechargeable lithium-ion battery SL AXT920SL

Dual-band flexible antenna for AXT100 Bodypack Transmitter AXT642

Threaded TA4F adapter WA340 

Transmitter carrying case for AXT100 Bodypack Transmitter W610

Transmitter carrying case for AXT200 Handheld Transmitter 95A15475

Zipper bag for AXT100 Bodypack Transmitter 26A13

Zipper bag for AXT200 Handheld Transmitter 26A14

Cloth pouch for bodypack transmitter (black) WA580B

Cloth pouch for bodypack transmitter (white) WA580BW

Belt clip for AXT100 Bodypack Transmitter 44A12547

Y-Cable for bodypack transmitters AXT652

LEMO Y-cable for bodypack transmitters AXT652LEMO3

3-AA Battery Sled for AXT100 bodypack transmitter AXT913

Mute Switch for bodypack transmitter WA661

Mute Switch for two bodypack transmitters WA662

1-AA battery carrier for AXT200 handheld transmitter AXT921

Instrument cable WA302

Instrument cable with right angle 1/4” connector WA304

Microphone stand adaptor WA371

Microphone Cartridges
SM58 (RPW112) SM87A (RPW116)

BETA 87A (RPW120) KSM9 Champagne (RPW180)

SM86 (RPW114) VP68 (RPW124)

BETA 87C (RPW122) KSM9 Black (RPW184)

KSM9HS Champagne (RPW182) KSM9HS Black (RPW186)

Batteries and Chargers
Bodypack rechargeable lithium-ion battery AXT910

Handheld rechargeable lithium-ion battery AXT920

Handheld rechargeable lithium-ion battery SL AXT920SL

8-Pack Handheld rechargeable lithium-ion battery AXT910-8

8-Pack Bodypack rechargeable lithium-ion battery AXT920-8

8-Pack Bodypack rechargeable lithium-ion battery SL AXT920SL-8

Charging module for AXT910 bodypack battery AXT901

Charging module for AXT920 handheld battery AXT902

Power supply for AXT903 and AXT904 Portable Charging Stations PS50

RF Cables
Coaxial Cascade Cable, 1-foot 95N2035

Coaxial Cable, 22-inch 95B9023

Coaxial Cable, 33-inch 95C9023

Coaxial Antenna Cable, 2-foot UA802

Coaxial Cable RG8/X, 25-foot UA825

Coaxial Cable RG8/X, 50-foot UA850

Antenna Extension Cable, 100-foot (30.4 m) UA8100

Ethernet Network Cables
Ethernet jumper cable, 8-inches C8006

Ethernet cable, 3-feet C803

Ethernet cable 10-feet C810

Ethernet cable, ruggedized, 25-feet C825

Ethernet cable, ruggedized, 50-feet C850

Ethernet cable, ruggedized, 
100-feet

C8100

1/2 Wave Antennas
470-530 MHz UA820G

518-578 MHz UA820H4

578-638 MHz UA820J

600-666 MHz UA820K

638-698 MHz UA820L3

694-758 MHz UA820M

740-814 MHz UA820Q

710-790 MHz UA820P8

Antennas
Passive Omnidirectional Antenna 
(470-1100 MHz)

UA860SWB

Passive Directional Antenna (470-
952 MHz)

PA805SWB

PWS Helical Antenna (480-900 
MHz)

HA-8089

Active Directional Antennas
470-698 MHz UA874US

470-790 MHz UA874E

470-900 MHz UA874WB

925-952 MHz UA874X

In-Line RF Amplifiers
470-900 MHz UA830WB

470-698 MHz UA830USTV

2.4 GHz Antennas
Omni-directional 2.4 GHz Antenna AXT643

Directional 2.4 GHz Patch Antenna AXT644
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A
AMC
Audio mute concealment: an AXT400 receiver function that masks the small gaps in audio that may occur during frequency switching.

B
backup frequency
A frequency not currently in use but that the system can deploy to a device in the event of RF interference. If you are using a Spectrum Manager 
(AXT600), the system can continuously monitor backup frequencies maintained in the Compatible Frequency List (CFL) to ensure that a clear and com-
patible frequency is available when needed.

band
A band is a standardized tuning range of frequencies. Transmitters and receivers are always associated with specific bands.

C
CFL
Compatible frequency list: contains all frequencies that are available for use by the system. The system can calculate the CFL using scan data, net-
worked equipment profiles, and exclusions. A Spectrum Manager (AXT600) can monitor and deploy frequencies in the CFL.

channel
Refers to a wireless audio channel formed by a receiver and a transmitter that are on the same frequency.

channel (group and channel)
A predefined set of hardware-specific frequencies that are coordinated to work with one another.

channel (TV channels)
A section of the RF spectrum (6 MHz in the U.S.) allocated to a digital television station. To avoid interference, you should not operate wireless devices 
within the frequency range of a TV channel.

channel name
You can name audio channels to give them a unique identity. When you IR sync a transmitter with the receiver, both components share the channel 
name.

channel strip
On the Monitor tab in Wireless Workbench, you can view a subset of parameters for a channel on a channel strip in a compact, convenient area.

D
device ID
A name for a device visible to other network devices and to Wireless Workbench. For Axient and PSM 1000 devices, the ID defaults to a model name.

device profile
Default tuning and coordination requirements associated with a device in Wireless Workbench.

DHCP
Dynamic Host Configuration Protocol: a network protocol used to automatically assign IP address to networked components. The AXT620 Ethernet 
switch has an internal DHCP server to automate and simplify network set up by assigning IP addresses to DHCP-enabled components.

discovery
Wireless Workbench 6 automatically discovers and adds a device that is on the network. When a device comes online for the first time, Wireless 
Workbench assigns a unique ID that lets the system recognize the device as it goes offline and comes back online.

E
Ethernet
The type of network used to connect networked components.

event log
A feature of the Spectrum Manager (AXT600) that records actions such as adding new equipment, serving a frequency to a receiver, or requesting a 
scan. The event log provides a record of recent events and is useful for troubleshooting.

exclusion
When coordinating frequencies, you can exclude specific frequencies or frequency ranges from the Compatible Frequency List.

exclusion threshold
The system excludes scanned frequencies with a signal strength above this value from the Compatible Frequency List calculation. You can view and ad-
just the threshold while analyzing the scan data display.
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F
firmware
The embedded software in each component. Firmware can be updated to incorporate new features and hardware enhancements.

flash
An identification feature that flashes the LED and backlit buttons on the front panel of a device in a rack.

frequency coordination
A calculation which uses RF scan data, the constraints of the equipment in inventory, known frequencies to avoid, and information about the RF environ-
ment to generate a Compatible Frequency List (CFL).

Frequency Diversity
The transmission of audio from a single source over two independent frequencies. Combines signal from both frequencies to provide optimized audio on 
a single audio channel.

Frequency List
Displays the compatible frequencies for all zones after you deploy frequencies to the inventory.

frequency plot
A graphical representation of the data obtained by a scan of the RF spectrum.

G
group and channel
A predefined set of hardware-specific frequencies that are coordinated to work with one another.

I
interference alert
A message displayed when the AXT400 receiver senses low-level interference. Interference at this level may not be audible or may only cause a slight 
disruption to the audio signal. If Interference Avoidance is set to Auto mode, a frequency change will not occur unless the strength of the interference 
increases to trigger an Interference Detected message. In Wireless Workbench, the Interference Detected window opens.

interference detected
A message displayed when the AXT400 receiver senses interference powerful enough to degrade the audio signal. If Interference Avoidance mode is 
set to Auto, the channel can automatically switch to a clear frequency deployed by a Spectrum Manager (AXT600) when detection occurs. In Wireless 
Workbench, the Interference Detected window opens.

intermodulation products
Unwanted RF signals created within components when two RF carriers are in close physical proximity. Intermodulation products can cause interference 
and increase the amount of occupied bandwidth.

Inventory list
On the Inventory tab of Wireless Workbench, the Inventory list displays the online and offline equipment you have added to the show. It provides a way 
of reviewing and sorting your equipment.

IP address
A number assigned to a device that identifies its location on the network. The IP address ensures that data on the network is sent to the correct device.

IR sync
Uses an infrared signal to automatically tune transmitter frequency and control settings to those of a selected receiver.

L
linking
Linking Axient transmitters and receivers enables synchronized frequency changes and remote control. Linking automatically occurs during the IR sync 
process and remains in place until the components are unlinked by command.

M
merging
A feature of Wireless Workbench that asks you to resolve any conflicts of parameter values between offline and online devices.

N
networking
Networking components over Ethernet allows the devices to communicate and perform advanced features.

O
offline device
A device that is not currently online, but that is included in the Inventory list in Wireless Workbench.
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P
parameter
Any adjustable setting on a device, such as frequency or gain.

peak hold
A plot feature that displays the highest recorded value for each frequency over the duration of the scan.

PoE
Power Over Ethernet: PoE-enabled devices, such as the ShowLink Access Point, use a single Ethernet cable for both power and data, eliminating the 
need for separate power supplies.

pre-tonekey squelch
A headphone-monitoring option useful for troubleshooting. You can monitor audio from each channel prior to tonekey squelch and Frequency Diversity 
processing.

R
RF cascade
The sharing of an RF antenna signal between multiple components. The system takes the RF signal from the RF cascade port of the first component 
and feeds it into the RF antenna input of the next component.

RF history plot
In Wireless Workbench, a graphical representation of the RF signal strength measured over time, obtained from receiver antennas.

RF mute
Disables and enables the RF carrier signal from a transmitter.

S
scan data
Data obtained from a scan of the RF environment. You can view scan data on a frequency plot and save it to a scan file.

scan file
Lets you save scan data to a scan file to share, use later, and compare with other scan data.

show file
Lets you save inventory, venue location, device settings, linking relationships, and coordination to a show file that you can use later or share.

ShowLink™ Access Point (AXT610)
Enables wireless remote control of Axient transmitters.

Spectrum Manager (AXT600)
Monitors, analyzes, and assigns compatible frequencies to wireless components.

squelch
Receiver circuit that mutes the audio output of the receiver in the absence of the desired radio signal, using an adjustable noise threshold or the tonekey 
signal from the transmitter.

subnet mask
Divides a network into smaller subnetworks. Use subnet masks to group and organize components for increased network efficiency.

U
user group
A user group is a country-specific set of frequencies designated for use by broadcasters (this feature is not used in the United States). Selecting a user 
group ensures that only frequencies from this group will be calculated.

W
word clock
Synchronizes the digital audio of multiple components operating together in a system. The AXT400 receiver has an internal word clock, or an external 
word clock may be used.

Z
zone
Allows efficient spectrum usage in high-channel-count applications where groups of transmitters are physically separated by location. You can use 
zones when transmitters will be physically far enough away from each other that intermodulation products are not a concern, but still close enough that 
having the same frequency is a concern.
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